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Limited warranty and disclaimers
A. Limited Warranty on Media. Claris
warrants the disks on which the Software is
recorded to be free from defects in materials
and faulty workmanship under normal use
for a period of ninety (90) days from the
date of delivery as evidenced by a copy of
the sales receipt. Claris will, at its option,
replace or refund the purchase price of the
diskette at no charge to you, provided you
return the faulty diskette With the sales
receipt to Claris or an authorized Clads
Dealer. Clads shall have no responsibility to
replace or refund the purchase price of a
diskette damaged by accident, abuse, or
misapplication. ANY IMPLIED WARRAN
TIES ON THE DISKS, INCLUDING
IMPLIED WARRANTIES OF MER
CHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ARE LIMITED
IN DURATION TO 90 DAYS FROM THE
DATE OF DELIVERY.

B. Disclaimer of Warranty on Software.
THE SOmVARE IS PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY
KIND, AND CLARIS EXPRESSLY
DISCLAIMS ALL IMPLIED WARRAN
TIES, INCLUDING BUT NOT LIMITED
TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.
CLARIS DOES NOT WARRANT,
GUARANTEE, OR MAKE ANY REPRE
SENTATIONS REGARDING THE USE
OR THE RESULTS OF THE USE OF THE
SOmVAREORANY ACCOMPANY
ING WRITTEN MATERIALS IN TERMS
OF THEIR CORRECTNESS, ACCU
RACY, RELIABILITY, CURRENTNESS,
OR OTHERWISE. THE ENTIRE RISK AS
TO THE RESULTS AND PERFORM
ANCEOFTHE SOFTWARE AND
WRITTEN MATERIALS IS ASSUMED
BY YOU. CLARIS DOES NOT WAR
RANT THAT THE SOFTWARE WILL
WORK CORRECTLY IN YOUR MULTI
USER OR NETWORK ENVIRONMENT.
IF THE SOFTWARE IS DEFECTIVE,
YOU, AND NOT CLARIS OR ITS
DEALERS, DISTRIBUTORS, AGENTS,
OR EMPLOYEES, ASSUME THE ENTIRE
COST OF ALL NECESSARY SERVIC
ING, REPAIR, OR CORRECTION. SOME
STATES DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRAN
TIES, SO THE ABOVE EXCLUSION
MAY NOT APPLY TO YOU.

C. Complete Statement of Warranty. THE
LIMITED WARRANTIES PROVIDED IN
PARAGRAPHS A AND BABOVE ARE
THE ONLY WARRANTIES OF ANY
KIND THAT ARE MADE BY CLARIS
ON THIS CLARIS PRODUCT. NO
ORAL OR WRITTEN INFORMATION
OR ADVICE GIVEN BY CLARIS, ITS
DEALERS, DISTRIBUTORS, AGENTS,
OR EMPLOYEES SHALL CREATE A
WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT
RELY ON ANY SUCH INFORMATION
OR ADVICE. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU
MAY HAVE OTHER RIGHTS, WHICH
VARY FROM STATE TO STATE.

D. Limitation of Liability. IN NO EVENT
WILL CLARIS, OR ITS DEVELOPERS,
DIRECTORS, OFFICERS, EMPLOYEES,
OR AFFILIATES BE LIABLE TO YOU
FOR ANY CONSEQUENTIAL, INCI
DENTAL, OR INDIRECT DAMAGES
(INCLUDING DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS
INFORMATION, AND THE LIKE) ARIS
ING OUT OF THE USE OF OR INABIL
ITY TO USE THE SOFTWARE OR AC
COMPANYING WRITTEN MATERIALS
EVEN IF CLARIS OR AN AUTHORIZED
CLARIS REPRESENTATIVE HAS BEEN
ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.
BECAUSE SOME STATES DO NOT
ALLOW THE EXCLUSION OR LIMITA
TION OF LIABILITY FOR CONSEQUEN
TIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATIONS MAY NOT
APPLY TO YOU. Claris'liability to you for
actual damages for any cause whatsoever,
and regardless of the form of rhe action, will
be limited to the greater of $500 or the
money paid for the Software that caused the
damages.

U.S. Government Restricted Provisions.
If this Software is acquired by or on behalf of
a unit or agency of the United States GO\';
ernment this provision applies. This
Software:
(a) Was developed at private expense, and
no part of it was developed with government
funds,
(b) Is a trade secret of Claris for all purposes
of rhe Freedom of Information Act,

(c) Is "commercial computer software"
subject to limited utilization as provided in
the contract between rhe vendor and the
governmental entity, and
(d) In all respects is proprietary data
belonging solely to Claris.
For units of the Department of Defense
(000), this Software is sold only with
"Restricted Rights" as that term is defined in
the 000 Supplement to the Federal
Acquisition Regulations, 52.227;7013 (b)
(3) (ii) and,
Use, duplication or disclosure is subject to
restrictions asset forth in subdivision (b) (3) (ii)
ofthe Rights inTechniC31 Dataand Computer
Software clause at 52.227;7013. Manufac;
turer: Clads Corporation, 440 Clyde Ave.,
Mountain View,California94043.
If this Software was acquired under a GSA
Schedule the U.S. Government has agreed
to refrain from changing or removing any
insignia or lettering from the Software or the
accompanying written materials that are
provided or from producing copies of
manuals or disks (except one copy for
backup purposes) and:
(e) Title to and ownership of this Software
and documentation and any reproductions
thereof shall remain with Clads,
(0 Use of this Software and documentation
shall be limited to the facility for which it is
acquired, and
(g) If use of the Software is discontinued to
the installation specified in the purchasel
delivery order and the U.S. Government
desires to use it at another location, it may
do so by giving prior written notice to Claris,
specifying the type of computer and new
location site. U.S. Governmental personnel
using this Software, other than under a
000 contract or GSA Schedule, are hereby
on notice that use of this Software is subject
to restrictions which arc the same as or
similar to those specified above.
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are registered trademarks of Apple Computer, Inc.

PaintWorks Gold and PaintWorks Plus are trademarks of }.,tediagenic, Inc.
Deluxe Paint II is a trademark of Electronic Arts, Inc. Epson is a registered
trademark of Epson America, Inc.

The Spelling portion of this product is based on Proximit}t Linguistic
Technology. The Proximity/Merriam-Webster Linguibase® © Copyright
1983 All Rights Reserved. Proximity Technology Inc. © Copyright 1983 All
Rights Reserved Merriam-Webster Inc. The Proximity/Merriam-Webster
Thesaurus © Copyright 1984. 1985 All Rights Reserved. Merriam-Webster
Inc. © Copyright 1984. 1985 All Rights Reserved. Proximity Technology
Inc.

Proximity and Linguibasc arc rcgistered tradcmarks of Proximity Technology
Inc.

APPLE COMPUTER, INC., MAKES NO WARRANTIES, EITHER
EXPRESS OR IMPLIED, REGARDING THE ENCLOSED COMPUTER
SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS
FOR ANY PARTICULAR PURPOSE. THE EXCLUSiON OF IMPLIED
WARRANTIES IS NOT PERMITTED IN SOME STATES. THE ABOVE
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About this Manual

This manual provides step~by~step instructions on carrying out basic
tasks with each of the six different applications included in your new
AppleWorks® OS software package. Refer to this manual when you
want a quick summary on how to perform a procedure--ereating a new
document, for example-using AppleWorks OS.

\Vhcn you want an in~depthdiscussion of the commands and concepts
in AppleWorks OS, consult the AppleWorks OS Reference. The Apple
Works OS Reference contains thorough explanations of each Apple
\\forks OS command and includes advanced technical information not
covered in this manual.

This manual is divided into eight chapters:

III Chapter 1, uAppleWorks 05/' provides information on the procc;
dures common to all six AppleWorks OS applications. This includes
procedures for creating and saving documents, for printing, for
editing, and for working with windows.

.. Chapter 2, uWord Processing/' contains descriptions of procedures
in the word processing application such as editing text and working
with word processing documents. The chapter includes information
on the mail merge features of AppleWorks OS.

III Chapter 3, lIDatabase," provides information on procedures for llsing
the database application to enter and report on database informa..
tion.

II Chapter 4, "Spreadsheet," explains the basic procedures for using
the spreadsheet application, including the creation of charts based
on spreadsheet information.

II Chapter 5, j'Graphics," describes the procedures for using the
graphics application tools and commands to create graphics.

xv



About this Manual

III Chapter 6, iCPage Layout," contains information on the procedures
in the page layout application to create documents combining text
and graphics.

II Chapter 7, f1Communications," explains the procedures in the
communications application for using your computer to send and
receive information.

III Chapter 8, "Integration in AppleWorks GS," details the procedures
for sharing information between different AppleWorks GS applica
tions. This chapter also includes a discussion of using AppleWorks
GS with mes created by other programs.

Throughout this manual, any term that may need further explanation
appears in italics the first time that it's used. This indicates that more
information about the term can be found in the Glossary, which follows
chapter 8.

xvi
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AppleWorks OS Commands

Apple Menu

P"1
Rbout Rpp leWorks 6S...
Configure...

The Apple menu is the standard Apple lIas Apple menu..It contains a
command for telling you about the AppleWorks as application (About
AppleWorks aS), a command for configuring your AppleWorks as disk
for startup, and the names of any desk a~cessories you install on your
AppleWorks as system disk.

About AppleWorks 65...

This command displays a dialog box containing copyright and author
ship information about AppleWorks as. Click OK to close the dialog
box.

Configure...

Configure lets you specify which applications are to be automatically
loaded into memory when AppleWorks as is first started up.

To allow AppleWorks as to start up quickly, none of the applications
are pretoaded into memory when you first start the program. As you open
existing or new documents with the Open and New commands, Apple...
Works as loads the application for the document type you specify. This
way you don't have to wait for AppleWorks as to load applications that
you don't intend to use.

If you do use certain applications more frequently than others and wish
to have these applications automatically loaded into memory at startup,
choose Configure. A dialog box appears containing icons that represent
each of the six AppleWorks as applications.

Click the icons representing the applications you wish to have automati...
cally loaded; a frame appears around each selected application. To
remove a selection, click the selected icon again and the frame disap~

pears.

Click OK to confirm your selections.

AppleWorks as Commands 3
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File Menu

New... aN
Open... dO
Close aK
Soue as
Soue As...
Delete File ..
Import File .
Choose Printer...
Page Setup,..
Print... aP
Print Herge...
Quit aQ

The File menu is the same for all six AppleWorks as applications. This
menu contains commands for creating, opening, saving, and printing
documents. The File menu also includes commands for:
III changing printers and page setup before printing

III deleting documents from a disk

III quitting AppleWorks as to return to the Apple lIos Finder

New...

The New command creates a new, empty document window for use with
one of the six AppleWorks as applications.

When you choose the New command, a dialog box appears containing
six icons representing the six AppleWorks as applications.

Select t~pe of new file ...

Tho icons roprosont tho six-----t+~
ApploWorks GS opplicotions

~ ~; II
[I]~"

( Cancel) « New )

4

Click the icon that represents the type of new document that you want
to create, and then click New. You can also create a new document by
double-clicking the icon that represents the new document's application
type. A new document of the appropriate type appears in its own
window.

If you already have one or more documents open, New places the new
document window on top of the other document windows. The new
document is temporarily named Untitled, followed by a number repre
sentlng the order in which that untitled document was created. The new
document name appears on the document's title bar and on the Window
menu followed by a two-letter code in parentheses identifying the type of
application.

Chapter 1
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AppleWorks GS Application Type Codes

Application: Typa coda: Exampla:

Word Processing WP Unritled! (WP)

Database DB Untitled! (DB)

Spreadsheet SS Untitled I (SS)

Page Layout PL Untitled I (PL)

Oraphics OR Untitled I (OR)

Communications CM Untitled I (CM)

For example, if you've already created two documents and you then
create a word processing document with the New command, the new
word processing document will be named "Untitled3."

You can open up to !4 AppleWorks OS documents at once. If you
choose New with 14 documents already open, a dialog box appears,
telling you that only 14 windows can be open at a time. Close one of the
open documents and choose New again.

You can also create a new document with the Open command.

Open...

The Open command reads a document previously saved on a disk and
displays it in a document window on the screen.

In addition to its own document types, AppleWorks OS directly reads
AppleWorks word processing, database, and spreadsheet documents:
ASCII text documents; and MultiScribe OS word processing documents.
The AppleWorks OS graphics application directly reads documents
created with a variety of Apple lIos graphics programs, including
PaintWorks Plus, PaintWorks Oold, Deluxe Paint II, and TopDraw.

When you choose Open, a dialog box appears, containing icons that
represent the different AppleWorks OS applications. The All Apple.
Works OS Files icon is surrounded by a frame, indicating that it's cur·
rently selected. Clicking one of the icons determines which type of
documents are displayed in the list box.

AppleWorks OS Commands 5
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To open a specific document type, dick the appropriate icon:

Click to choose the type of-----fi
document you want to open

Click to choose a document to open--1f-

Open which file '" All App!eWorks OS Files

fiij~ ~! It [I] ~ ... :i;z;;j: til ,••
:'.~ II:

IYeorbook.Filesl lYeorbock.Filesl

I!IIIBu II etin.Boord {I ( Disk )

'i'Club.Logo « Open »
!ftlConcessionsoles ( Clo,. )
~ fight.Song
IiIrrench.Club ( Nell )
'i'rundraim.Art
I:E Newsletter ( Cancel )

Open Command Dialog Box Icons

6

Selecting this icon:

AU AppleWorks OS
Files

Word Processing

Database

Spteadsheet

Oraphics

Page Layout

Communications

Chapter 1

Displays these documant types:

AppleWorks OS, AppleWorks, ASCl1 text,
MultiSctibe OS, and standatd fotmat (APF,
Paint, PICT, Scteen) graphics documents

AppleWorks OS, AppleWorks, ASCl1 text,
and MultiSctibe OS word processing docu
ments

AppleWorks OS and AppleWorks database
documents

AppleWorks OS and AppleWorks sptead
sheet documents

AppleWotks OS and standatd fotmat (Paint,
APF, PICT, SCteen) graphics documents

AppleWorks OS page layout documents

AppleWorks OS communications documents



To open a document, click the name of the document. If necessary,
scroll the list to find the name of the document you want. Click Open to
open the document. (You can also open a document by double-clicking
its name.) When you open a folder, the folder name is appended to the
current pathname and docurl.lents and folders located on that path
appear in the list box.

To close a folder, click Close or click the pathname above the list box.
The names of the documents and folders on the new pathname are
displayed in the list box.

To open a document on another disk, click Disk until the name of the
disk you want is displayed as the current pathname. To cancel the
operation and return to the last active document window, click Cancel.

If you already have one or more documents open, the Open command
places the new document window over the other documents. The
document name appears on the Window menu followed by a two~letter

code in parentheses identifying the type of application.

Apple\Vorks OS lets you open a maximum of 14 documents at one time.
If you choose Open with 14 documents already open, a dialog box
appears, telling you that only 14 windows can be open at a time. Close a
document and choose Open again.

In addition to opening existing documents, you can also create new
documents using the Open dialog box. Click the icon representing the
application type of the document you want to create and click New (or
double~click the icon). A new, untitled document window appears.

Note: You can only open one communications document at one time.

Close

The Close command closes the active document window.

If you've made changes to the document you're closing, AppleWorks OS
displays a dialog box asking if you want to save your changes.

AppleW'or1<s OS Commands 7
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Save Jfk.Reraembered (WP) before closing?

[~~Ye5=s===<]
( Ho ) ( Cancel )

8

When you close a document with two or more documents on the screen,
the document window immediately beneath the closed document
becomes the new active window. If you close the only document window
on the screen, the empry AppleWorks OS desktop appears.

If there are no documents open on the desktop, Close is dimmed on the
File menu.

Choosing Close is the same as clicking the close box of the active
document window.

Save
The Save command puts a copy of the document in the active window
on disk.

If you're saving a new, untitled document, a dialog box appears to let you
name the document and tell AppleWorks OS where to save it. (See
"Save As," following, for an explanation of this dialog box.) When
you've named and saved the document, a copy of the document is
written on the disk and its name appears in the title bar, followed by a
two-letter code in parentheses identifying the application type of the
document.

Once a document has been named and saved, the Save command
automatically saves it without prompting you for information.

If there are no documents open on the desktop, Save is dimmed on the
File menu.

Use the Save command when you've already named and saved a docu
ment and want to save your most recent changes on disk. Use Save As
when you want to save a named document with a different name or on a
different disk.

Cha/Jter 1



Save As...

The Save As command lets you name or rename a document, save it on
a different disk or in a different folder, or save it with a different file
format. The types of file formats you can choose depend on the applica
tion type of the document you're saving.

Use the Save As command when you want to:
III save a changed document with a new name while retaining the old

version of the document

II make a backup or copy of an existing document with a different name

or on a different disk

When you choose Save As, a dialog box appears:

The current pathneme

Click here to save
the document

Click to change disks

Click to create a
new lolder

® I Filesl
ree on the disk ~16 free of SOD K. ( Disk ) ~-

D Budoet 1i ( Hew Folder)
D Bus.ilddl'~ss~s

D Went.~umbm ( Open )
D Cubist.finoles f§1 Close )D Jfl<.Relllembmd (
D ~ewsl~tter "

Save ... « Save »
cument here Ibrochure I( Cancel )

The amount 01 space I

Type a name for the do

If you're saving a new document, the name in the entry box is Untitled,
followed by a number representing the order in which that untitled
document was created. (For example, if the document was created after
two other documents, the document would be named Untitled3.) If
you're saving a document that has already been named and saved on
disk, the entry box contains the current document name.

Applel'l/orks OS Commands 9
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If you give the document a name used by a document previously saved
on the disk, a dialog box appears, asking if you want the document you're
saving to replace the old document of the same name already on the
disk. Clicking Yes saves the document under the specified name,
replacing the old document of the same name. Clicking No returns you
to the Save As dialog box to give the document a different name.

To save the document with a different name, enter a new name in the
entry box. You can enter any name that conforms to the GS/OS guide·
lines for document names. For information on these guidelines, see the
Apple IIos System Disk User's Guide.

To save a document on another disk, click Disk until the name of the
disk you want is displayed as the current pathname. To save a document
in a different folder, click the folder and then click Open (or double·
click the folder). You can create a new folder for the document by typing
a name in the entry box and then clicking New Folder.

Some AppleWorks GS applications let you save documents with non·
AppleWorks GS file formats for use with other software programs. When
you can save a document with one of these formats, an appropriate
setting appears on the Save As dialog box. A list of the applications sup'
porting non.AppleWorks GS file formats is given below:

Non-AppleWorks GS Formats for Saving Files

Application:

Word Processing

Database

Spreadsheet

Graphics

Page Layout

Communications

Non-AppleWorks OS formats supported:

ASCII

ASCII, with Tab and Return delimiters

ASCII, with Tab and Return delimiters

Apple Preferred Format (APF)

None

None

10

When you've named the document and specified where to save it, click
Save. The document is saved with that name, and a new icon for the
document is created in the Finder.

Cilapter 1



Delete File ...

The Delete File command lets you remove a file from a disk without
leaving AppleWorks OS. You can delete any file on a disk, including
AppleWorks OS documents, system files such as fonts and printer
drivers, and even program files. For this reason, you'll want to be very
careful when using Delete File.

When you choose Delete File from the File menu, a dialog box appears:

Open the fil e to de lete ...
® IYeorbook.Filesl

D Bulletin.Boord [ Disk )lrCIiCkto
Click here to choose a document D Civic.Activit change disks
to delete

D Concessionsoles [ Open »_ Click to

D fight.Song ( )
delete the

Close documentD finder.Ooto
D French.Club
D Fundroiser.Art [ Concel )

To delete a file, click the name of the file you wish to delete (if neces
sary, scroll the list or open the appropriate folder to display the file's
name). Then click Open to delete the file (or double-click its name). A
dialog box appears asking you to confirm that you want to delete the file.

Delete the file "Club.logo"?

[ OK ] [ Cancel)

Click OK to complete the file deletion. Clicking Cancel cancels the
operation without deleting the document.

To delete a file on another disk, click Disk until the name of the disk
you want is displayed as the current pathname, and then click the name
of the file to be deleted and click Open. To delete a file in another
folder, click the folder and then click Open (or double-click the folder).
Delete File won't delete a folder, even if the folder is empty.

AppleWorks OS Commands 11
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Import File...
The Import File command inserts the contents of an entite document on
a disk into an open AppleWorks OS document.

When you choose Import File, a dialog box appears:

Import which file ...
® IEssoy.Fi1esl

Cl Budget.Hoy {} ( Disk ) Click to
Cl Bus.Addresses changa disks
Cl Cubist.Angles « Open :. Click toCl Figure.Drowing
Cl Letter ( Close )

importtha
documant

( Cancel )

Click here to choose a document ---U-r'R'ib.;r;;';:t."];i,;;----R)l
to import

To import a document, click the name of the document you wish to
import (if necessary, scroll the list or open the appropriate folder to
display the document name). Then click Open to import the document
(or double-click its name).

To import a document on another disk, click Disk until the name of the
disk you want is displayed as the current pathname (or until the name of
the document you want to import is displayed in the list box).

All the AppleWorks OS applications let you import documents with
non-AppleWorks OS file formats, and some applications import docu
ments of their own file type, as well. For example, the word processing
application allows you to import AppleWorks OS word processing docu
ments as well as AppleWorks, MultiScribe OS, and ASCII text docu
ments.

The following chart lists the AppleWorks OS applications and the dif
ferent file formats they support with the Import File command.
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File Formats Imported by AppleWorks GS Applications

Application:

Word Processing

Database

Spreadsheet

Graphics

Page Layout

Communications

Choose Printer...

File formats supported:

AppleWorks GS word processing, AppleWorks
word processing, MultiScribe GS, ASCil text

Database:

ASCil text-tab and carriage return delimiters
ASCil text-space and carriage return delimiters
ASCil text-earriage return delimiters with

number of fields per record specified

Graphics:

AppleWorks GS graphics, Apple Preferred Format
(APF), Paint (PNT), PICT, Screen (320 and 640)

ASCil text-tab and carriage return delimiters
ASCil text-space and carriage return delimiters
ASCil text-earriage return delimiters with

number of rows specified

AppleWorks GS graphics, Apple Preferred Format
(APF), Paint (PNT), PICT, Screen (320 and 640)

Word Processing:

AppleWorks GS word processing, AppleWorks
word processing, MultiScribe GS, ASCil text

Graphics:

AppleWorks GS graphics, Apple Preferred Format
(APF), Paint (PNT), PICT, Screen (320 and 640)

AppleWorks GS word processing, AppleWorks
word processing, MultiScribe GS, ASCil text

This command tells AppleWorks GS what printer and printer port
you're using. Once you've provided these settings, you won't have to
choose this command again unless you change your printer or the printer
port you're using. The preset printer and printer port are ImageWriter
and Printer.
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......................................

When you choose the Choose Printer command, a dialog box appears on
the screen:

Click here to choose aprinter-----!+

Click to specify AppleTalk or dlrect--C:
cable connection

14

o AppleTalk @DireotConneot

User Home: IJohn Washington

( Canoe I )« qK »

The Choose Printer dialog box contains two lists-a list of printers and a
list of printer pons. Click the name of the printer and printer port you're
using (if necessary, scroll the lists until the appropriate printer and
printer port appear).

When you've made your selection, click OK. Your settings are saved on
the AppleWorks GS program disk.

For more information on setting up your printer for use with Apple..
Works OS, see appendix A, "Special Installation Information/1 in this
manual.

If you're using a LaserWriter, be sure to select AppleTalk as your printer
port and activate AppleTalk in the Control Panel. If you're printing
with the Epson LX/FX printer driver, select as your printer port either
GraphiCard or Grappler (the two parallel printer cards supported by
AppleWorks GS for use with the Epson printer).
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Page Setup...

The Page Setup command lets you specify the size of the paper you'll be
printing on and whether to print vertically or sideways. Settings for
vertical character sizing and document reduction or enlargement are also
provided. Other print options are available, depending on which printer
has been selected with the Choose Printer command.

When you choose Page Setup, a dialog box appears. This dialog box
differs depending on which printer has been chosen with the Choose
Printer command. The ImageWriter and LaserWriter printer drivers are
discussed here. For more information on page setup and printer drivers,
see chapter 1, "AppleWorks OS," in the AppleWorks OS User's Ouide.

ImageWriter
If you're using the ImageWriter printer driver, this dialog box appears:

Click to choose a paper size: ~-~~-
US Lelter-8 '/2 x 11 in. IHAGEWRITER/PRIHTER
US Legal-8 'I' x 14 in. Paper: @US Letter
A4 Lelter--ll'/. x 11'/3 in, 0 US Legal
International Fanfold--ll'/. x 12 in. 0 A4 Letter

Use for printing graphics: 80 dots per 0 International Fanfold
inch (dpi) wide by 36 dpi tali 11 Vertical Sizing: Printer Effects:

--lJ 0 Hormal 050% Reduction
Use lo~ printing text: 80dots~erinch -@CondensedDHoGoPsBetween
(dpl) Wide by 72 dpi tall Orientation: Pages

Click to print vertically ~- '" ( Cancel) leD
Click to print sideways

---Click to print at 50% 01
original size

Click to print continuously,
without skipping over
page breaks

Change the page setup options by clicking the appropriate settings.

The first time you choose Page Setup, the options are preset to the
settings shown above for the word processing, database, and spreadsheet
applications. The page layout and graphics applications also default to
the settings shown above for all options except Vertical Sizing, which is
preset to Normal for those applications.
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Any changes you make to these settings ate saved when you save the
document that was active when you made the changes. Activating
anothet document changes the page setup to the settings saved with the
document (or to the default settings if it's a new document).

When you've chosen the settings you want, click OK. Clicking Cancel
cancels the Page Setup operation and leaves your old settings intact.

LaserWriter
If you're using the LaserWriter printer driver, the following dialog box
appears:

Reduces or enlarges print
by the amount you type in
the entry box

Use for printing graphics: 80
dots per inch (dpi) wide by
36 dpi tall

LomWriter

Substitutes fonts built into the ---../
LaserWriter for regular fonts

Click to choose a paper size:---,
US Letter-ll '/2 x 11 in.
US Legal-8 '/2 x 14 in.
M Letter-8 '{. x 11 '/3 in.
85 Letter-7'{4X 10 '{.in.

Paper: @USletter 0 nq Letter
o US Legal 0 B5Letter

Orientation: Vertical Sizing: Intermediate vertical sizing:
o Hormol 80 dots per inch ldpi) wide
o Intermediote by 54 dpi tall

______+l-;::;=~~=,u @ Condensed --f4-- Use for printing text: 80 dotsClick to print sideways -
Printer Effects: per inch ldpil wide by 72 dpi

Smooths out the rough edges of----#[8] Smoothing? ~~~~~:e~r IiJllillt tall
graphics and non·LaserWriter fonts [8] Font Substitution?

(r.C-on-ce'""I) OD

Click to print vertically--------f+

Change the page setup options by clicking the appropriate settings.

The first time you choose Page Setup, the options are preset to the
settings shown above for the word processing, database, and spreadsheet
applications. The page layout and graphics applications also default to
the settings shown above for all options except Vertical S'izing, which is
preset to Normal.

Any changes you make to these option settings are saved when you save
the document that was active when you made the changes. Activating
another document changes the page setup to the settings saved with the
document (or to the default settings if it's a new document).

When you've chosen the settings you want, click OK. Clicking Cancel
cancels the Page Setup operation and leaves your old settings intact.
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Choosing Font Substitution when you're using a LaserWriter causes the
following font substitutions:
.. New York becomes Times
II Geneva becomes Helvetica

III Monaco becomes Courier

.. Shaston becomes Helvetica

If you're not using LaserWriter fonts and you choose to print without
font substitution} printing time will increase. Bitmapped fonts are
created for all other non-LaserWriter fonts and downloaded to the
LaserWriter, whether you choose font substitution or not. Choosing
Smoothing will speed up printing and make non-LaserWriter fonts look
better.

The Page Setup command is dimmed when no documents are open.

Print...
The Print command prints a copy of the current docum~nt according to
your specifications.

When you choose Print, a dialog box appears. As with Page Setup, this
dialog box differs depending on which printer has been selected with the
Choose Printer command.

The Print dialog box for the ImageWriter is displayed below.

Use for printing text
Use for printing color
graphics

Lowest quality print
setting-prints text only,
without different fonts,
styles, or sizes

Prints tractor-feed paper
fed continuously into the
printer

Prints one sheet of paper
at a time. Prompts you to
feed each sheet into the
printer individually.

~ IMRGEWRITER/PRIHTER

~Qualitu: @Better Text

~I 0 Better Color

~~:>"
ODralt

ant Pose r ~: .
~ @RIl

Des of
OFrom:D To:

Copies: [[J/
Paper Feed:@RutomaticQMonual

(Concel ) (]JI with- DColorPrints in color on an ImageWriter I
a color ribbon

Prints the specified number of copi
a document

Prints the range of pages you spec
Type in the entry boxes the first an
last pages in the page range you w
to print.

Prints all the pages in a document,
from first to last
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The option settings shown for the ImageWriter are the defaults. Change
the print options by clicking the appropriate settings.

The Print dialog box for the LaserWriter is displayed below. The option
settings shown are the defaults. Change the print options by clicking the
appropriate settings.

Specifies automatic feed
from the laserWriter's paper
cassette

Specifies that you'll feed the
paper into the laserWriter by
hand

lASERWR ITER/APPlETAlK
ument, from IfageS: @AIl

o From: D To: D
u specify.

Copies:[[]first and

:/
Paper Source:

@Paper Trag
o Manual Feed

(Cancel) (!)

Prints the range of pages yo
Type in the entry boxes the
last pages in the page range
want to print.

Prints the specified number
of caples of a document

Prints all the pages in a doc
firstto last

Once you've selected the settings you want, click OK.

The Print command is dimmed when no documents are open.

Print Merge...

This command is only functional in the word processor and otherwise
remains dimmed on the File menu. For a complete discussion of the Print
Merge command, see ilPrint Merge" in chapter 2, flWord Processing
Commands."

Quit

The Quit command lets you exit AppleWorks OS and return to the
Finder. If you've made unsaved changes to the documents open on the
AppleWorks OS desktop, a dialog box appears for each document with
unsaved changes to let you save your changes before quitting.
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Edit Menu

Undo elZ

Cut elX

CoPU elC
Poste elV
Clear
Select All elA

On the Edit menu you'll find the standard Apple Hos editing com
mands-Undo, Cut, Copy, and Paste. These commands make use of the
Clipboard, where cut or copied information is stored. (The contents of
the Clipboard can be displayed by choosing Show Clipboard from the
Windows menu.) The Edit menu also contains commands for removing a
selection without saving it to the Clipboard and for selecting the
contents of an entire document.

In addition to these standard commands, each of the AppleWorks as
applications also contains special editing commands that apply specifi
cally to that application. For example, the Edit menu of the word
processor contains a Check Spelling command, the Edit menu of the
database application contains the command Field Definition, and so on.
For information on the Edit menu commands specific to a particular ap~

plication, see C1Edit Menu" in the chapter of this manual that deals with
that application.

Undo

The Undo command lets you undo, or reverse, the most recent changes
you've made to a document. Undo reverses different actions in different
applications, and not all actions in all applications can be undone. If the
effects of an action can't be reversed, the command is dimmed on the
Edit menu.

Cut
The Cut command removes a selection from a document and stores the
selected material on the Clipboard, replacing the Clipboard's previous
contents. The cut material remains on the Clipboard until the next Cut
or Copy operation is performed.

This command may be used only after you've made a selection and.
otherwise remains dimmed on the Edit menu.
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Copy

The Copy command copies a selection to the Clipboard, replacing the
Clipboard's previous contents.

Like the Cut command, this command may be used only after you've
made a selection and otherwise remains dimmed on the Edit menu.

Paste

The Paste command places the contents of the Clipboard in the active
document.

The contents of the Clipboard are saved on the disk and are not re
moved if you choose Quit to exit AppleWorks OS.

If nothing has been cut or copied to the Clipboard, Paste is dimmed on
the Edit menu.

Clear

The Clear command deletes a selection. Unlike the Cut command,
which also removes a selection from a document, Clear does not store
the deleted material on the Clipboard.

If nothing is selected, Clear appears dimmed on the Edit menu.
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Select All

This command selects everything in a document at once.

The following table documents the effects of the Select All command in
each application.

The Select All Command

Application:

Word Processing

Spreadsheet

Database

Page Layout

Graphics

Communications

What gets selected when you choose Select All:

All text in the current document

All cells in the document containing data
(may select empty cells as well-selects a
rectangular area defined by the rightmost and
lowermost cells containing data)

All active records in the current document

If the insertion paint is selected,

All text in the current text stream

If the insertion paint isn't selected,

All objects on the current page

All objects in the current document

All text in the review buffer
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Window Menu

Show Clipboord
Bus.Addresses (DB)
Budget (55)
JFK.Remembered (WP)
Cubist.Angles (GR)
Brochure (PL)
Bulletin.Boord (CM)

22

The Window menu contains the names of all currently open windows,
allowing you to quickly change the active window from the current
document to any other open document. In addition, the Window menu
also features the Show Clipboard command, to let you view the current
contents of the Clipboard.

To make a document the current document, choose the name of that
document from the menu. The name of the document is checked on the
Window menu, and the document window moves to the front of the
screen to become the active window. The menu bar changes to reflect
the application of the chosen document.

Show Clipboard/Hide Clipboard

The Show Clipboard command opens a window displaying the current
contents of the Clipboard. When this command is chosen, the menu bar
contains only the Apple, File, Edit, and Window menus, and the entire
Edit menu is dimmed. Show Clipboard changes to Hide Clipboard on
the Window menu.

The Clipboard window is similar to other windows in most respects.
Although it has no size box, it can be zoomed with the zoom box or
closed using the close box. However, the contents of the Clipboard
window can only be displayed; you can't edit or change its contents.
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Other Common
ApplllWorks GS
Commands

Two of the commands common to more than one application-Edit
Colors alld Choose FOllt-are 011 differellt mellus ill different applica
tions. These commands are discussed in the following section.

Edit Colors...

This command lets you change the text and graphics colors in an Apple
Works OS document. Edit Colors appears on the Color menu of the
word processor and page layout application alld on the Edit menu of the
database and graphics applications.

When you choose Edit Colors, the AppleWorks OS Color Editor
appears:

These scroll bars let you edit the current
color selection by changing the hue (H), and
then varying the intensity (I) and saturation
(S) of the selected hueThe 16-color display palette shows the -------~-~

colors as they will appear in your text or fi"======~~=========:F=~==I="il
graphics

These scroll bars let you edit the -J

current color selection by blending
varying amounts of red (RI, green (G),
and blue (B)

Click to choose between
pure and dithered colors

Click to select the color
you want to edit
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Before you begin editing any of the colors, choose whether to use pure or
dithered colors for text and graphics. AppleWorks OS defaults to
Dithered, with four colors-red, green, blue, and yellow-in the edit
palette. To provide a wide selection of text and graphics color choices,
AppleWorks OS mixes colors in odd and even columns on the screen, a
process called dithering. If you look carefully at the screen when you're
using color text, you'll see that the text alternates colors with every
column, creating the illusion of another color.

• • t I It~

, , ,

On-screen dithered color text end
graphics elternate colors with every
column, creeting the illusion of another
color

When you choose Pure, AppleWorks OS creates a color selection based
on four base colors-black, white, and two other colors (the defaults are
red and green) that appear in the edit palette.

Color Editor with Pure chosen ------u:~~~~=~~~~~~~~~~~~~=~~~~1l

@Pure
o Dithered

24

These four colors are dithered in various ways to create eight different
colors, which, along with pure black and pure white (for a total of ten
colors), appear in the color display palette. Besides black and white,
however, two other colors in the color display palette are pure, which
means that although they're technically dithered, they're formed by
blending a color with itself in even and odd columns.
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On·screen pure color text and graphics
use the same color in every column

The pure colors in the color display palette form a diagonal from the
upper-left (black) to the lower-right (white).

When you choose Dithered, AppleWorks OS creates a color selecrion
based on six base colors-black, whire, and four other colors (the
defaulrs are red, green, blue, and yellow) that appear in the edit palette.

Color Editor with Dithered chosen ---1Li=:"'======================1l

OPu"
@Dithered

These six colors are dithered in different combinations to create 15
colors (gray is the only duplicated color). Since none of the colors are
formed by dithering a color with irself, none of the colors displayed is
pure. You can create pure colors with Dithered selected, however, by
making two of the colors on the same row in the edit palette the same
color; this will cause one of the 15 dithered colors to actually be pure.
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The Color Editor prOVides two different models for editing colors. The
first, known as the RGB model, allows you to mix varying amounts of red,
green, and blue to change the composition of a color. To do this, you'll
use the R (red), G (green), and B (blue) scroll bars on the left side of the
Color Editor. These scroll bars are arranged vertically, with the top of
each scroll bar representing placement of 100% of the scroll bar's color
in the selected color and the bottom of each scroll bar representing 0%
of the scroll bar's color in the selected color.

To change a selected color to red, for example, you'll want to have red
set at maximum and green and blue turned off, so you'll drag the scroll
box to the top of the R scroll bar and the scroll boxes in G and B to the
bottoms of their respective scroll bars.

To obtain pure red, pure green, 
and pure blue, set the RGB scroll
bars to these settings

Pure red Pure green Pure blue

26

When R, G, and B are all set at the maximum, the selected color
changes to white (white light is the combined presence of all three
colors); when R, G, and B are all set at the minimum, the selected color
changes to black (black is the absence of any color.)

The second method for editing colors, known as the HIS model (for hue,
intensity, and satllration), lets you edit a color by varying different
characteristics of that color.

The first of these characteristics, hue, is the color itself. When you scroll
the H scroll bar, the color displayed in the selection box cycles through
the current available colors (the colors available on the Apple lIos at
the current intensity and saturation levels).
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Intensity is a measure of the brightness of a color-how light or dark that
color is. When you move the scroll box toward the top of the I scroll bar,
the selected color in the edit palette becomes lighter (until it becomes
pure white) as more white is added to the color. When you move the
scroll box toward the bottom of the I scroll bar, the selected color
becomes darker (until it becomes pure black).

Setting the Intensity scroll bar to ~·~-IF;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;-;· ;;;~;;;;;~~====:::::;"]
maximum changes a selected color to
pure white

OPu"
@Oithered

The third color characteristic, saturation, is a measure of the richness of
a color-how strong or pastel a color appears. As you move the scroll
box to the top of the S scroll bar, the color in the selection box becomes
stronger, until it is the strongest expression of that hue at the current
intensity level. As you move the scroll box toward the bottom of the S
scroll bar, the color in the selection box becomes lighter, until it
becomes pure gray.

To edit a color using the HIS model, first choose a color or hue by
scrolling the H scroll bar until the desired hue appears in the selection
box, then sCloll the I and S scroll bars to modify the intensity and
saturation of the selected color. As you scroll the H, I, and S scroll bars,
the R, G, and B scroll bars are also adjusted accordingly.
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Click to choose a font ---lfl-

AppleWorks OS Commands

Choose Font. ..

The Choose Font command lets you choose a font fot selected text or for
text to be typed at the insertion point. It also lets you choose the style
and size of the font. (These same choices regarding style and size are also
available under the Size menu and Style menu, but the Choose Font
command provides a convenient way to make these choices all at once.)

In addition to allowing you to change font, size, and style of selected text
all at once, Choose Font lets you access all the fonts in the System folder
of your startup disk, not just those listed on the Font menu. Choose Font
appears on the Font menu of the word processor and page layout applica.
tion, on the Template menu of the database application, and on the
Options menu of the graphics application.

When you choose the Choose Font command, a dialog box appears:

Font:

lIeIvetico
Honoco
Shoston
Times

l1V!!en~i.£ce~ --;,L=±~11- Click the text size you want

~St~l..e,-: ---, Size: Other
Click to specify a style ---H- t2J PI oin 10 lJ Size:o Bold 12 iii[] --I-l--~Type to specify any size

o Ito lie from 4to 48 point
o Underline (Concel)o Outlineo Shodow '--J...:{J."-J« OK ]

When the dialog box appears, the current settings indicate the font,
style, and size of the selected text.

To select a font, click the desired font in the Font list box. If necessaty,
scroll the list to find the name of the font you want.
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To select a style, click the check boxes in the Style box to indicate the
desired style or combination of styles. For example, if you want your text
to appear both boldface and underlined, click the Bold check box and
the Underline check box. The only style on the Choose Font dialog box
that can't be used in combination with other styles is Plain; when you
choose Plain, it removes all other styles from your text.

To select the size of the font to be used, click the desired font size in the
Size list box. If necessary, scroll the list until the size you want appears. If
the font size you want is not listed in the Size list box, type the size in
the Other Size entry box. AppleWorks OS will derive this font size from
one of the font sizes that are available on the disk. A font size created in
this way may have a rougher appearance than a standard font size.

When you've chosen the settings you want, click OK. Click Cancel to
return to your document without making changes to the current font,
size, or style.

Nole: You can add fonts to your system and remove them by dragging

the font files into the Fonts folder of the System folder on your stattup

disk. See "About the Apple lIos System Folder," in appendix A,

ClSpecial Installation Information," in this manual.
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Word Processing Commands

file Menu

Hew... 6H
Open... 60
Close 6K
Save 6S
Save As...
Delete File .
Import File .
Choose Printer...
Page Setup...
Print... 6P
Print Merge...
Quit 6Q

The standard File menu commands-eommon to all the AppleWorks
OS applications-are described in chapter 1, "AppleWorks OS Com
mands." Although common to all the AppleWorks OS applications, the
Save As command supports special formats for saving word processing
documents, so information on these formats is provided here.

Save As ...

The Save As command for the AppleWorks OS word processor works
the same as in the other applications, except that, in addition to the
regular word processing format, documents can also be saved as ASCII
text. \Vhen you save a document as ASCII text, you're saving the text
only, without formatting, (ants, character sizes, styles, or colors.

When you choose Save As in the word processor, a dialog box appears
containing the usual options for saving documents, as well as two
settings for saving a document in AppleWorks OS word processing
format or ASCII text format. The default is word processing format. To
save a document as ASCII text, click As ASCII Text.

® IAwgsJilesl
482 free of 800 K. ( Disk )

['I Bronnu((! it ( Hew folder)
D CIIIl\I)lm~.N~t\jQrk
D Con>o/Ii\;(!,looa ( OPNI )
f) fmliiouee.lllltli

~( (; l <I !i(~ )[j nnd~(,n{lt{l

[:J Ihor~IlU,Ptml'l

Save ... « Save ]
IResume I( Cancel )

OWith formatting @As ASCII text- I- Click to save as ASCII text

For information on the other options provided by the Save As com~
mand, see ('Save As" in chapter C "Apple\Vorks OS Commands."
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Print Merge...

The Print Merge command prints multiple copies of a merge document
created in the word processor, with each copy containing information
from a different record of a database document open on the AppleWorks
OS desktop. This command can be used for a wide vatiety of form
printing applications, from personalized form letters to mailing labels to
employee time sheets.

Print Merge is only functional in the word processor and otherwise
remains dimmed on the File menu. A database document must be open
on the desktop for use with the merge document.

Print Merge is used in conjunction with two AppleWorks OS word
processor commands, Select Merge Database and Add Merge Field, both
on the Edit menu. Select Merge Database lets you choose which data
base document you wish to use with Print Merge. If you choose Priot
Merge without having fitst selected a database, AppleWorks OS auto
matically displays the Select Merge Database dialog box to let you make
your selection. If only one database file is open on the desktop when you
choose Print Merge, that database file is used, and the Select Merge
Database dialog box does not appear.

Add Merge Field lets you specify which fields from the selected database
you want to place in your merge document, and where you want to place
them. As you place each field, its name appeats surrounded by angle
brackets « and» in the specified location in your merge document.
You can also add merge fields to a merge document by directly typing
into the merge document a left angle bracket«), followed by the field
name, followed by a right angle bracket(».

For more information on these commands, see lISelcct Merge Database"
and "Add Merge Field" in this chapter.

Once you've created a merge document and specified which database
fields you wish to print with (and where you Wallt them placed in the
merge document), adjust the page setup settings for the merge document
with the Page Setup command (see IIPage Setup," in this manual for
complete information about these settings) and choose Print Merge. The
Print dialog box appears to let you change the settings used for printing
the merge document (see IIPrint," in chapter 1, llAppleWorks OS
Commands," for more information about printing options).
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AppleWorks OS uses the database file specified with Select Merge
Database to print a different version of the merge document for each
record in the current set of active records of the database file.

As each record is printed, AppleWorks OS displays a dialog box giving
the total number of records to be printed and the record number of the
record being printed.

At each occurrence of a specified field name in the merge document,
AppleWorks OS inserts the information contained in the field of that
name in the current record of the selected database file. Consider the
sample form letter below:

January 1, 1989

<First Name> <Last Name>
<Organization>
<Address»
<City>, <State> <Zip>

Dear <Mr.or.Ms.> <Last Name>:

In this example, the Last Name field appears twice for each record
printed, because it's specified twice. You can specify that a field be used
as many times as necessary for each record in the database file (and
therefore for each merge document you print).

You can lise merge documents created with one database file with
another, different, database file, provided the field names you specify are
common to both database files. If a merge document contains a field
name for which there is no corresponding field in the selected database
file, the name of the field, surrounded by angle brackets-and not the
database information-is printed when the documents are printed.

To cancel printing of a merge document, press the 0 and period (.) keys.
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Edit Menu..,
Undo T~ping (\Z

Cut (\X
Cop~ (\C
Poste (\V
Cleor
Cop~ Ruler Q[

Paste Ruler (\l
Select All (\A
Se lect Paragraph (\y
Select Sentence
Select Herge Datobase...
Add Herge Field...
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The standard Edit menu commands (Undo, Cut, Copy, Paste, Clear, and
Select All) are described in chapter 1, "AppleWorks OS Commands."
The Edit Colors command, on the Color menu of rhe word processor
but on different menus in other applications, is described in HOther
Common AppleWorks OS Commands," also in chapter 1.

In addition to the standard commands, the Edit menu in the word
processor contains commands for copying and pasting rulers l selecting
blocks of text, and creating merge documents.

Copy Ruler

The Copy Ruler command makes a duplicate of the ruler settings for the
paragraph containing the insertion point. Use this command in comhi#
nation with the Paste Ruler command when you want to apply the
formatting of one paragraph in a document to a selected paragraph or
group of paragraphs elsewhere in the document (see IlPaste Ruler" in this
chapter for an explanation of this command). The Copy Ruler command
does not replace the contents of the Clipboard.

Paste Ruler

The Paste Ruler command applies the ruler settings copied with the
Copy Ruler command to the currently selected paragraph(s).

Before the Paste Ruler command can be used, the format settings for a
ruler must be copied to the Clipboard with the Copy Ruler command
(see "Copy Ruler" in this chapter for an explanation of this command).
Then, select the paragraph or group of paragraphs to be formatted (or
select the insertion point anywhere inside the paragraph to be format'
ted) and choose Paste Ruler.

If no ruler settings have been copied to the Clipboard by the Copy Ruler
command, Paste Ruler appears dimmed on the menu.

Select Paragraph

This command selects an entire paragraph. When you choose Select
Paragraph, the paragraph containing the insertion point is selected.
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Select Sentence

The Select Sentence command selects an entire sentence. When you
choose Select Sentence, the sentence containing the insertion point,
including final punctuation, is selected.

What makes it e sentence? For purposes of the Select Sentence com
mand, AppleWorks OS considers a sentence to be any text separated
by any combination of the following: two or more spaceSj a Tab
characteri a carriage return character (thus the start of a paragraph
begins a new sentence and the end of a paragraph ends the current
sentence). The beginning and end of a document also serve to mark
the beginning and ending of sentences. The easiest way to make sure
YOII're creating a complete sentence is to type two spaces after the period.

Select Merge Database...

This command lets you specify which database document you wish to
use:
iii when creating a merge document by specifying merge fields with Add

Merge Field

.. when you want to get data when printing an existing merge document

with Print Merge

When you choose Select Merge Database, a dialog box appears contain
ing a list of database documents open on the AppleWorks OS desktop:

Se Ieot adatabase:

Click to selecl a database document--tI-
Hailing.List
Emplauee.Data
lab.Reoards

( Canoe I )

Click the name of the database document you wish to use (scroll the list
to display the name, if necessary), and click OK.

If no database documents are open on the desktop, Select Merge
Database appears dimmed on the menu.
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Add Merge Field ...

The Add Merge Field command lets you place the name of a field from a
selected database in a word processing document to be printed with Print
Merge. This field name, surrounded by angle brackets «, », reserves
space in your document to be completed with information retrieved from
the field of the same name in the selected database when the document
is printed.

Before using Add Merge Field, select the insertion point at the place in
the word processing document where you want the field to appear. Then,
use Select Merge Database to choose the database document you want to
get information from when you print your merge document. If you
haven't selected a database document when you choose Add Merge
Field, a dialog box appears to allow you to choose one (see "Select Merge
Database" in this chapter for more information about this dialog box).

When you've selected a database document, choose Add Merge Field. A
dialog box appears:

The name of the currently
seiected database

Click to confirm your choice

Select amerge field:
Home Q

.~ e- State
Zip Code
Telephone
Account Humber

~Address
Database: Hailing.List-~ _.

( Cancel) « OK )J

Click to select a merge field -----

The dialog box lists the names of the fields in the selected database.
Click the field you wish to insert in your merge document, then click
OK (or double-click the merge field name). The field name appears in
your document at the insertion point, surrounded by angle brackets. You
can insert as many different field names as you want in a merge docu...
roent, and you can use a single field name as many times as necessary.
You can also add merge fields to a document by simply typing a left angle
bracket, followed by the field name, followed by the right angle bracket.

For more information on selecting database documents and printing
forms, see lfSelect Merge Database" and (IPrint Merge" in this chapter.
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Search Menu

Find/Replace...
Find Again aF
Go To Insertion al
Go To Page
Go To Beginning a1
Go To End a9
Check Spelling... a"
Sunonums...
Edit Dictionoru...

The Search menu contains commands for finding and modifying specific
text and for scrolling to a specific page in a document. In addition, it
includes commands for using the on-line 30,ODO-word spell checker and
thesaurus, and for editing the special user dictionary that lets you
personalize the spell checker.

Find/Replace.. ,

The Find/Replace command searches for all the occurrences of a
specified group of characters in a document from the insertion point to
the end of the document. Once the specified text is found, you're given
the option of replacing it with different text.

When you choose Find/Replace, a dialog box appears:

Type the text you want to --
locale here

Click 10 search on a distlncI-~

word only "'"
Click to start at Ihe beginning
of th~ocumenl

I

I

"Search for: ISam Caeur "- "-

Type the lext you want 10 replace ---- --Replace with: INotre Do.~ "- "
ilwilh here (optional) r--I11------- 0 Ignore case DWholeword(s) ""

« Find next ] (Replace, then find))~ ( Go to beginning)Click to disregard differences in case - _. -.
/ ( Replace ) ( Replace all) ( Dcne )

Click to find the next occurrence ~~_Jl!;;;=~~~=~~;:~~~~;;;;=";;;'~';;=~~==;;dU
of the search text (I.

Click to replace ali occurrences Click to replace the highlighted
Click to replace the highlighted texl- of the specified text with Ihe re- lext with the specified replece-
with the specified replacementlext plecementlext mentlext and continue the search

Enter in the Search For entry box the sentence, phrase, word, or other
text you want to locate. If you want to replace the text you search for
with different text, enter the new text in the Replace With entry box.
To find or replace carriage returns, type Option...Returnj to find or
replace tabs, type Option-Tab. You can enter up to 60 characters in each
entry box.

AppleWorks GS normally looks for text that matches except with regard
to case {the Ignore Case setting is checked by default}. If you deselect
Ignore Case, AppleWorks GS looks for text that matches the specified
text exactly, including uppercase and lowercase letters.
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AppleWorks os normally looks for every occurrence of the specified
text, whether it's a distinct word or part of a larger word or phrase. If you
choose Whole Word(s), AppleWorks os looks for every occurrence of
the specified text as a distinct word or group of distinct words. A distinct
word consists of a group of letters separated from other text by spaces,
punctuation, or other special characters.

\Vhen you've chosen the settings you want, click Find Next, or click
Replace All to replace all occurrences of the specified text with the new
text. Replace All can't be reversed with Undo, so be careful with this
option (none of the FindfReplace options can be undone, but Replace
All can be especially dangerous to a document).

If AppleWorks OS fails to find the specified text-Qr if it's already found
all the occurrences of the text in a document-a dialog box appears to
notify you that no more occurrences of the text werc found from the in~

sertion point to the end of the document. To search from the beginning
of the document, click 00 To Beginning before clicking the Find Next
button.

If AppleWorks os finds matching text, the text is selected and the
Replace and Replace,Then Find buttons become active.

Whenever you want to end the search, click Done. The specified search
and replacement text remains in the dialog box until you enter different
text.

Find Again

Find Again lets you quickly search for the text last specified with the
Find/Replace command without displaying the FindfReplace dialog box.

When you choose the Find Again command, AppleWorks os searches
for the specified text from the insertion point to the end of the docu
ment. If the specified text is found, it's selected. If AppleWorks OS fails
to find the specified text, a dialog box appears to notify you that no
matching text was found.

Go To Insertion

This command scrolls a document to the location of the insertion point.
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Go To Page

The 00 To Page command scrolls to a specified page in a document.

When you choose 00 To Page, a dialog box appears:

Go to poge [I]

(Conoel) [ OK »

Type the number of the page you wish to move to in the entry box.
Then click OK. The insertion point moves to the beginning of the top
line of the specified page, and the new page number appears above the
scroll bar.

If you specify a page number smaller than the number of the first page in
the document, AppleWorks OS scrolls to the beginning of the docu
ment. AppleWorks OS scrolls to the end of a document when you
specify a page number greater than the number of the last page in the
document.

Go To Beginning

Go To Beginning moves the insertion point to the beginning of a
document, scrolling the document to display the top of the first page.

Go To End

This command moves the insertion point to the end of a document,
scrolling the document to display the bottom of the last page.
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Check Spelling .. ,

The Check Spelling command lets you correct the spelling of words
within a word processing document. AppleWorks OS detects possible
misspelled words by reviewing a document aIld checking each word
against the AppleWorks OS dictionary. If a word in a document is not
found in the dictionary, AppleWorks OS selects it as a possible mis
spelled word, suggests possible correct spellings for the word, and lets you
replace the selected word with a suggested word or with a word you type
in.

The first time you choose Check Spelling during a word processing
session, AppleWorks OS looks for the dictionary file. If it can't find the
dictionary-originally on the AppleWorks OS Utilities disk-it displays a
dialog box asking you to open the dictionary.

Once AppleWorks OS locates and loads the dictionary file, the spell
checker starts at the current location of the insertion point and checks
forward to the end of the document. When the spell checker encounters
the first misspelling, it displays a dialog box:

~
Word: strotta
Error: SpeI ling
Replace with: I I

( Add to Dictionaru )

( Ignore ) ( Suggest ) « Replace D ( Concel )

II To replace the word with a different word, type the new spelling and

click Replace.

III To leave a word unchanged and display the next misspelling, click

Ignore.

III To see a list of suggested spellings for the word, click Suggest. A list of

possible spellings appears in the list box.
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, ,

~
Word: strotto

store at [rror: Spelling
striote
stroit Replooe with: 111m I
storted ( Rdd to Diotionoru )

( Ignore ) ( SUGoest ) « Replooe )) ( Cono,l )

If necessary, scroll rhe Iisr until the appropriate spelling appears. Select
the spelling you want by clicking it, and then replace the misspelled
word in the document by clicking Replace (or by double-clicking the
appropriate spelling).

It's possible that the word is not actually misspelled, but is simply not
found in the AppleWorks OS dictionary. When this is the case, Apple
Works OS supplies a user dictionary to let you create your own personal,
ized dictionary of words not found in the AppleWorks OS dictionary. To
add the word to the user dictionary, click Add To Dictionary. Once
added to the user dictionary, the word is no longer flagged as misspelled
by the spell checker.

Synonyms...

This command lets you replace a word in your document with a word of
similar meaning. AppleWorks OS contains a thesaurus that can suggest
possible alternative words for selected words in your text. In addition,
the thesaurus lets you search for synonyms for multiple definitions of the
same word. For example, the three sentences below could all have
different synonyms suggested for the same word ("light"), because each
sentence contains a different meaning of the word:

II Turn off the light. (Noun. Source of illumination.)

11/ I forgot to light the candle. (Verb. To cause something to start

burning.)

II This package is too light. (Adjective. Having little weight.)

To use the thesaurus, select a word (or place the insertion point within
the word) and choose Synonyms. AppleWorks OS looks for the diction
ary file. If it can't find the dictionary-located on the AppleWorks OS
Utilities disk-it displays a dialog box asking you to open the dictionary.
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Once AppleWorks os locates and loads the dictionary file, it begins
searching for the selected word. If AppleWorks os finds the word in the
thesaurus, a dialog box appears listing the first definition of the word and
possible synonyms:

variab Ie: adj alterable ar changing under slight provocotion

Sunonums: j! chongeoble
chongeful
fluid

~:obilemutable
.() protean

(Prt'v. Hemtiny) « Cancel ] ( Rq,iGGe ) (Next Meaning)

III To replace the selected word with one of the suggested synonyms,

click the synonym, and then click Replace (or double-click the syno

nym).

III If the first definition in the dialog box does not match your use of the

word, click Next Meaning until the appropriate definition appears,

along with a new list of synonyms.

III To return to a list of synonyms based on a previous definition, click

Prevo Meaning until the appropriate definition appears.

To cancel the operation without replacing the selected word, click
Cancel.
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Edit Dictionary...

This command lets you review, add, or delete words in the user diction~

ary. A typical use of this command is to delete a misspelled word
accidelltally added to the user dictionary.

When you choose Edit Dictionary, a dialog box appears:

Edit User Oictionaru

clandestine &: Ientourage
metamorphosis
psuchoneurotic [ === »intangible Add Word
resonator ( R~m<l1m t~ol'lf )
rendezvous

( )OK
1) ( Concel )

The dialog box contains a list of the words in the user dictionary.

II To add a word to the user dictionary, type the word in the entry box,

and click Add Word.

III To remove a word from the dictionary, click the word to select it (if

necessary, scroll the list until the word appears), and click Remove

Word.

Jill To save the changes you've made to the user dictionary and return to

the document, click OK.

III To return to the document without making any changes to the

dictionary, click Cancel.
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Document Menl!

Hormol View oW
..View Heoder

View Footer
Show Ruler oR
Poges... oE
Insert Poge Breok 0
Insert Poge n
Insert Dote
Insert Time
Stotistios

Document window with header -
displayed

End-ol·header line ---------"
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The commands on the Document menu define the format of an entire
document. This menu contains commands for creating and modifying
headers and footers and for specifying on which pages you want headers
and footers to appear when you print. It also contains commands for
showing and hiding the ruler. inserting page breaks. and displaying
statistical information about the number of characters, words, lines,
pages, and paragraphs in a document.

Normal View

The Normal View command lets you view an entire document in the
window, including headers and footers. Headers and footers can't be
edited in Normal View. however. Normal View is usually selected on the
menu, unless you choose View Header or View Footer.

View Header

The View Header command opens the header for a document. allowing
you to set the top margin of the document and to place any combination
of text, the current page number, the current time, and the date at the
top of each page of the document. The header information is displayed
along with the rest of the text in a document when you return to the
document with the Normal View command, but you won't be able to
select or edit it as you can when View Header is chosen.

III Fil. Edit Search O......nt Font Size Style Color Window
,0 Untitledl (WPJ 2],

.1.1.1.~~'I.I,I'I,r.,.I~.r.l.I'I,I'I,I~I,I.I.I.I.r'I,1~,r'I.I.,.I.~I~"r'I.I.,.r.I,I~,I,',I.,.I.I,171,I'I'11.1,1,1H

m ~~El www ~~~55 {}
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When you choose View Header, only the information contained in the
header appears in the document window I along with a horizontal line
indicating the end of the header.

You can type past this end·of.header line, but only the text above the
line will appear in the document. The number of lines that fit in the
header area is determined by the size, style, and font of the text you
create.

To create a top margin for each page in a document, create as many
blank lines as you like for the header. You can later change the size of
the margin by adding or deleting lines or by changing the line spacing
and point size of text. The preset value for the top margin is one blank
line.

To create text for the header, type as you would in any other part of a
word processing document. You can change the characteristics of header
text as you would any text in a document-using the Font, Size, Style,
and Color menus.

When you choose View Header, a check mark (...J) appears next to View
Header on the Document menu, and the letter H appears in the page
number box above the scroll bar. In addition, the Insert Page #, Insert
Date, and Insert Time commands become active on the Document
menu, allowing you to place the current page number, date, and time in
the header. For more information on these commands, see HInsert Page
#/' lIInsert Date/' and {(Insert Time," in this chapter.

You can format the header rext by changing the settings on the ruler in
the same way that you format text in the main document window-by
selecting the text to be formatted and then adjusting the ruler settings.

When you've completed the header, you close it by choosing the Normal
View command. The check mark beside View Header is removed from
the Document menu and Normal View is again checked. AppleWorks
OS returns to the active document window.
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View Footer

The View Footer command opens the footer for a document, allowing
you to set the boltom margin of the document and to place any combi·
nation of text, the current page number, the current time, and the date
at the boltom of each page of the document. The footer information is
displayed along with the rest of the text in a document when you return
to the document with the Normal View command, but you won't be able
to select or edit it as you can when View Footer is chosen.

When you choose View Footer, only the information contained in the
footer appears in the document window, along with a horizontal line
indicating the end of the footer.

Document window with footer ---,
displayed

End·of·footer line -----------...
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You can type past this end.of.footer line, but only the text above the
line will appear in the document. The number of lines that fit in the
footer area is determined by the size, style, and follt of the text you type.

To create a bottom margin for each page in a document, create as many
blank lines as you like for the footer. You can later change the size of the
margin by adding or deleting lines or by changing the line spacing and
point size of text. The preset value for the bottom margin is one blank
line.
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To create text for the footer, type as you would in any other part of a
word processing document. You can change the characteristics of footer
text as you would any text in a document-using the Font, Size, Style,
and Color menus.

When you choose View Footer, a check mark (v) appears next to View
Footer on the Document menu, and the letter F appears in the page
number box above the scroll bar. In addition, the Insert Page #, Insert
Date, and Insert Time commands become active on the Document
menu, allowing you to place the current page number, date, and time in
the footer. For more information on these commands, see "Insert Page
#," IlInsert Date/' and llInsert Time/' in this chapter.

You can format the footer text by changing the settings on the ruler in
the same way that you format text in the main document window-by
selecting the text to be formatted and then adjusting the ruler settings.

When you've completed the footer, you can close it by choosing the
Normal View command. The check mark beside View Footer is removed
from the Document menu and Normal View is again checked. Apple
Works OS returns to the active document window.

Show Ruler/Hide Ruler

The Show Ruler command displays the ruler. The margin, tab,
alignment, and spacing settings for the paragraph containing the
insertion point are shown on the ruler. When you choose Show Ruler,
the command changes to Hide Ruler on the Document menu.

Hide Ruler removes the ruler from the screen, allowing you to see more
of a document at once. The current ruler settings remain active, even
though the ruler is no longer visible. When you choose Hide Ruler, the
command changes back to Show Ruler on the menu.
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Pages.. ,

The Pages command lets you set the initial page number of a document
and specify which pages you want to print headers and footers on.

When you choose Pages, a dialog box appears:

Prints footer on even
numbered pages only

Prints footer on odd
numbered pages only

Footer not printed

Doesn't print footer on
page one (for creating
title pages)

Type a new initial page
number here

s: prints ,- -'\ --~

on all pages

r~Headers: ~ Footers: lL
en·numbered

@nll Pages @nll Pages./ L
III0 Even Pages Onl9 0 Even Pages Onl9

r 0 Odd Pages Onl9 0 Odd Pages On19' L
d·numbered pages 0 Hone 0 Hone ill

/
D Skip First Page D Skip First PageT

er on page one---/
First Page Humber: [[]

agesl ( Cancel) (( OK ] ~

Prints header on ev
pages only

Prints header on ad
only

Header not printed

Doesn't print head
(for creating title p

The default setting
header and footer
of the document

Click the appropriate settings to specify on which pages of the document
you want to print the header and footer (the default settings are dis·
played above). If you'd like the page numbering of your document to
start with a number other than one (the preset initial page number), type
the page number in the entry box. The pages in your document will be
renumbered according to the number you type.

Insert Page Break

The Insert Page Break command starts a new page at the insertion point l

making the insertion point and the text following it appear at the top of
a new page. Subsequent pages are renumbered automatically.

After the new page is created, the old page contains blank space at the
bottom of the page. You can add text in this blank space without
affecting the text on the new page following it, until you reach the end
of the old page. You can also delete text in the blank space without
affecting the text on the new page following it,
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Insert Page #

Insert Page # inserts the current page number into a document header or
footer at the insertion point. Insert Page # can only be chosen if you're
displaying the header or footer with either View Header or View Footer
and othenvise remains dimmed on the menu. (For more information on
these commands, see ((View Header" and "View Footer.")

When you choose Insert Page #, the number 1 (representing the page
number) is placed in the header or footer at the insertion point. The
appropriate page number will appear at that location in each page of the
document.

The page number can be placed anywhere in a header or footer. The
page number takes the font, size, style, and color of the text surrounding
it, but you can select it and change it as you would any other text. For
example, you can delete it by selecting it and pressing Delete.

Insert Date

The Insert Date command places the current date at the location of the
insertion point in the header or footer. Insert Date can only be chosen if
you're displaying the header or footer with either View Header or View
Footer and otherwise remains dimmed on the menu. For more informa~

tion on these commands, see IlVicw Headerll and "View Footer,"

The date can be placed anywhere in a header or footer. It tlses the
format, Month, Day, Year, with the name of the month spelled out and
the year displayed in full. For example, the date 01/01/89 would be
displayed as January 1, 1989.

The date assumes the font, size, style, and color of the text surrounding
it, but you can select it and change it as you would any other text.
Although the date is displayed as a group of characters, AppleWorks OS
treats it as one characteri if you select the insertion point after the date
and press Delete, the entire date is deleted.
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AppleWorks GS gets the date from your computer's clock. The date is
updated each time you open the document, and each time you print the
document, as well. If the date isn't accurate, you can adjust it using the
Clock option in the Control Panel of your Apple lIos. For more infor
mation on the Control Panel and the Apple lIos Clock, see appendix A,
"The Control Panel Program," in the Apple lIos Owner's Guide.

Insert Time

The lnsett Time command places the current time at the location of the
insertion point in the header or footer. Insert Time can only be chosen if
you're displaying the header or footer with either View Header or View
Footer and otherwise remains dimmed on the menu. For more informa..
don on these commands, see IIView Header" and "View Footer."

The time can be placed anywhere in a header or footer. It uses the
format HH:MM AM/PM, with no leading zeros before the hour when
the hour is a single digit. For example, eight-thirty in the morning would
be displayed as 8:30 AM.

The time assumes the font, size, style, and color of the text surrounding
it, but you can select it and change it as you would any other text.
Although the time is displayed as a group of characters, AppleWorks GS
treats it as one charactefj if you select the insertion point after the time
and press Delete, the entire group of characters is deleted.

AppleWorks GS gets the current time from your computer's clock. The
time is updated whenever you open the document, and each time you
print the document, as well. If the time isn't accurate, you can adjust it
using the Clock option in the Control Panel of your Apple lIos. For
more information on the Control Panel and the Apple lIos Clock, see
appendix A,''The Control Panel Program," in the Apple lIos Owner's
Guide.
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.........................................
Statistics

The Statistics command provides information about the number of
characters, number of words, number of lines, number of paragraphs, and
number of pages in a document.

When you choose Statistics, a dialog box appears:

DocUllent contents:
1033 chorocter(s)
m word(s)

16 line(s)
2 porogroph(s)
1 poge(s)

( OK ]

Click OK to return to your document.
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Font Menu

Choose Font...
Courier

{Genevo
He lvetioo
Honooo
Shaston
Times
Venioe
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The Font menu lets you choose different fonts, or typefaces, for selected
text or for text to be typed at the insertion point. In addition, the Font
menu includes the Choose Font command (see uChoose Font" in
chapter i, "AppleWorks OS Commands"), which provides access to all
the fOIlts in the System folder of your startup disk and lets you select the
style and size of a font at the same time that the font is chosen. The
preset font is Geneva.

Below the Choose Font command on the Font menu is a list of fonts.
This list shows the first fifteen fonts in the System folder of your startup
diskj to see others, use the Choose Font command.

When you choose a font, a check mark ("j) appears beside that font on
the Font menu. If you move the insertion point to a different font in
your text, the font where the insertion point is positioned is the chosen
font and it appears checked on the Font menu. if selected text is all of
one font, that font is checked on the Font menUj otherwise, no font is
checked.

If you use the mouse or arrow keys to position the insertion point
between text of two different fonts, the chosen font is the font of the
text to the right of the insertion point.

When you cut or copy text, the text retains its font along with its size,
style, and color.
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Size Menu

8Point
9Point
10 Point

(12 Point
14 Point
18 Point
20 Point
24 Point
Lorger 6>
Smoller 6(

The Size menu lets you choose point sizes for selected text or for text to
be typed at the insertion point. The minimum point size is 4 pointsj the
maximum is 48 points. The preset size is 12 points.

If a font for a specific point size is in the System folder of your Apple
\Vorks OS startup disk, that size appears in boldface on the Size menUj
otherwise, that size appears in plain text.

When you change font sizes, AppleWorks OS checks to see if the newly
chosen font size is in the System folder of the startup disk. If it is, there
will be a short pause the first time that font size is loaded into memory. If
AppleWorks OS can't find the point size you specify as a font file, the
point size is derived, or approximated, based on the characteristics of a
different size of the font.

When you choose a font size, a check mark (...J) appears beside that font
size on the Size menu, and selected text or text typed at the insertion
point is changed to the specified point size.

If you move the insertion point to a place in the text with a different
point size, the size where the insertion point is positioned is the chosen
size and is checked on the Size menu. If selected text is all of one size,
that size is checked on the Size menu; otherwise, no size is checked.

If you use the mouse or arrow keys to position the insertion point
between text of two different sizes, the chosen size is the size of the text
to the right of the insertion point.

\Vhen you cut or copy text, the text retains its size along with its font,
style, and color.
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Larger

The Larger command lets you increase the size of selected text in I-point
increments, up to 48 points.

If the new font size you specify is not one of the sizes on the Size menu,
no check mark appears on the menu. To see the font size of selected text
when the size isn't displayed on the menu, choose the Choose Font
command. The size is displayed in the Choose Font dialog box.

If you specify a font size for which there is no font file in the System
folder of the startup disk, AppleWorks OS derives the specified size from
the standard font sizes that are available. The appearance of derived font
sizes may be rougher than standard font sizes.

Smaller

The Smaller command decreases the size of selected text in I-point
increments, down to 4 points.

If the new font size you specify is not one of the sizes on the Size menu,
no check mark appears on the menu. To see the font size of selected text
when the size isn't displayed on the menu, choose the Choose Font
command. The size is displayed in the Choose Font dialog box.

If you specify a font size for which there is no font file in the System
folder of the startup disk, AppleWorks OS derives the specified size from
the standard font sizes that are available. The appearance of derived font
sizes may be rougher than standard font sizes.
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Style Menu

IPlain oT
Bald 6B
Italic <il
Underline OU
Outline
Shadow
Superscript oH
Subscript oL
UPPERCASE
lowercase
Title

The Style menu lets you choose a style or combination of styles for
selected text or for text to be typed at the insertion point. The preset
style is Plain.

When you choose a style, a check mark ('I) appears beside the style on
the menu. You can mix styles in any combination you wish; as each new
style is chosen, it appears checked on the Style menu. For instance, you
can select Bold and Underline from the Style menu, and your text will
appear both boldface and underlined. You deselect a style by choosing
the selected style again. To remove all styles, choose Plain.

Examples of the different styles offered by AppleWorks GS are shown
below:

Plain removes all text styles

The Bold command changes selected text to boldface

Italic changes a selection to italic text
-----;-----=-c----;---c-

Use the Underline command to create I lnderlined text

Outline creates white charactets outlined in black

Shadow creates text with three.dimensional shadows

Use Superscript for superscripted symbols such as footnotes l

Use Subscript to create subscripted text-like formulas (H2S04)

UPPERCASE CHANGES A SELECTION TO ALL UPPERCASE

the lowercase command changes selected text to all lowercase

Title Converts The First Letter Of Every Word In A Selection
To Uppercase

A few styles can't be used in certain combinations:

III Plain can't be used in combination with Bold, Italic, Underline,

Outline, or Shadow, since Plain removes those styles from text.

II Superscript and Subscript can't be be used in combination since

they're mutually exclusive.

II Uppercase, Lowercase, and Title can't be be used in combination

since they're also mutually exclusive. (Also, unlike the other styles,

these commands can only be used for selected text and not for text to

be typed.)
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If you move the insertion point to a different style in your text, the style
where the insertion point is positioned is the chosen style and is checked
on the Style menu. If selected text is all of one style, that style is checked
on the Style menUj otherwise, nothing appears checked on the menu.

If you use the mouse or arrow keys to position the insertion point
between text of two different styles, the chosen style is always the style of
the text to the right of the insertion point.

\Vhen you cut or copy text, the text retains its style along with its font,
size, and color.
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Color Menu The Color menu lets you choose colors for selected text or for text to be
typed at the insertion point. In addition, the Color menu contains the
Edit Colors command, which lets you choose text colors from the 4096
colors of the Apple lIos. The Edit Colors command is common to other
Apple\X1orks OS applications and is therefore covered in detail in
"Common Apple\'Vorks OS Commands on Different Menus," in chapter
1, "AppleWorks OS Commands."

\X1hen you choose a color, the color is surrounded on the menu by a
black frame.

Fifteen text colors arc available; the preset color is black. The colored
text appears on your screen and will appear on your printout if you're
printing with a color ribbon on an Imagc\Vritcr II (or compatible
printer).

If you move the insertion point to a different color in your text, the color
of the text where the insertion point is positioned is the chosen color
and that color appears selected on the Color menu. If a selection
contains more than one text color, no color is selected on the menu.

If yOll lise the mouse or arrow keys to position the insertion point
between text of two different colors, the chosen color is the color of the
text to the right of the insertion point.

\Vhen you cut or copy text, it retains its color along with its font, size,
and style.
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Database Commands

File Menu

Hew... 6H
Open... 60
Close 6K
Sove 6S
Sove Rs...
Delete File .
Import File ..
Choose Printer...
Poge Setup...
Print... 6P
Print Mm·\w ...
Qui t 6Q

The standard File menu commands-common to all the AppleWorks OS
applications-are described in chapter 1. The Print Merge command is
only available in the word processor, so it's dimmed on the File menu.
Although common to all the AppleWorks OS applications, the Save As
command supports a special format for saving database documents, so
additional information on this command is provided here.

Save As

The Save As command for the AppleWorks OS database works the same
as in the other applications, except that, in addition to the regular
database format, database documents can be saved with a special for...
mat-ASCII text with tabs delimiting fields and carriage returns delimit
ing records. This option allows you to save an AppleWorks OS database
document in a format that can be read by other database managers.

When you choose Save As in the database application, the Save As
dialog box appears containing the usual options for saving documents as
well as two settings for saving documents in AppleWorks OS database or
ASCII-delimited format. The default is AppleWorks OS database format.
To save as ASCII-delimited, click As ASCII Text.

® IR.f.Hon.Ch.3.Dbl
569 free of 800 K. ( Disk )
D D.lIJJind,•.X,"u 1£ ( H.w folder )
D Options.Quest

( Op,. 1

~
( Close )

Save .., « Save ))

IbUI.oddrm.~ I( Con,,1 )

@Dotobase formot o As ASCII Text~ f---- Ciick to save as ASCII-teb!
carriage return deiimited

For information on the other options provided by the Save As com
mand, see lfSave As" in chapter 1, IIAppleWorks OS Commands,"
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Edit Menu

Undo Rdd field aZ
Cut aX
Cop~ aC
Paste aV
Clear
Select Rli aR
Edit Colors...
field Definition...
field Format .
field Formula .
Insert Record al

The standard Edit menu commands (Undo, Cut, Copy, Paste, Clear, and
Select All) are described in chapter 1, "AppleWorks OS Commands."
The Edit Colors command, on the Edit menu of the database but on
different menus in other applications, is described in leOther Common
AppleWorks OS Commands," also in chapter 1.

In addition to the standard commands, the Edit menu in the database
application contains commands for defining and formatting fields and for
inserting records.

Field Definition ...

The Field Definition command lets you specify the name of a field and
the type of data that can be entered into the field. You can use the Field
Definition command to modify both data fields and label fields.

To use the Field Definition command, a field must first be selected while
the form definition screen is displayedj otherwise the command appears
dimmed on the menu. When you choose Field Definition, a dialog box
appears to let you specify the name and type of data to be entered into
the field. This is similar to the dialog box that appears when you first
create a field, except that the Label setting is dimmed and the Numeric,
Date, and Time format options are dimmed if the field is a label.

JJOK«

Data Field Definition dialog box '----l~~~7=::=~;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;~~7~~
~select field t~pe: [JLobd

Type a new name for the field here 3[iit0!'~;!!iI!;!$5!"'O!.i _
@ Text 0 Picture 0 Static Text

Click here to specify what type of data 0 H' 0 Date 0 Tt'me
the field is to contain umenc

(""""'C""on-c'""'e1-=""')

Label Field Definition dialog box (notice --+i;;=:==::=:~;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;~=:~~;;;;;;il
that the Label box is checked) Select field t~pe: [J Lobd

I-
@Text
o HlJnlerio

( Cancel

o Picture
()Oote

)

o Static Text
()Hme

« OK »
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If you change the field's data type, any information that has been pre
viously entered in that field in the database will be lost. If you attempt to
change the data type of a data field after data has been entered in the
field, AppleWorks OS displays a dialog box warning you that the oper
ation will cause a permanent loss of data and allowing you to continue or
cancel the operation.

Field Format ...

The Field Format command lets you specify the format for the contents
of a selected data or label field.

To use the Field Format command, a field must fitst be selected while
the form definition screen is displayed; otherwise the command appears
dimmed on the menu. When you choose Field Format, a dialog box
appeats. The dialog box will change to reflect the data type of the
selected field.

Some of the format options are common to all or most of the data types:

III Style-lets you specify special text characteristics of values in fields.

Styles offered may include Bold (boldface display), Italic, Underline,

and Border (to display bordets around fields when the database form is

displayed and printed). The underline style is not displayable with

some fonts (8 point Shaston, for example).

III Alignment-lets you specify how to align values in fields. Choose

ftom left-aligned, centered, and right-aligned text.

.. Color-lets you choose from one of 15 dithered or four pure colots for

field text (for more information on using pure and dithered colors, see

"Edit Colors" in chapter 1, "AppleWorks OS Commands").

III Display-lets you specify format options unique to the data type. For

example, numeric data can be displayed as dollars, percents, and so

on.
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III Auto Fill-specifies that this field in each new record automatically

contains the same data value it contained in the previous record. For

example, if you've entered nine records, a field with Auto Fill selected

in the tenth record will contain the same value as that field contains

in record nine. If you insert a record after record foUf, the Auto Fill

field in that record will have the same value that the field does in

record fouf.

Auto Fill is especially helpful when a field contains identical informa

tion through several records (a common city for address records, for

example). The auto fill value is just a default value for the field; to

change it, just type a different value. The new value is then used as

the default value for the field in the next record.

The sections below describe the different dialog boxes and the format
options they provide for each data type. The default settings are shown.

Text Fields
If the selected field contains text when you choose Field Format, the
Format Text Field dialog box appears:

Glick to specify text alignment

Formot Text Field

Stule Rlign L-_-.
Glick to define the style of the fieid --H-I 0 Bold @Left

o Itolio 0 Center
o Underline 0 Right
[8J Border

Glick here to automatically copy data
into the field from the previous record

Indicates
current text
color

Glick to specify
a colorlor the
field's contents
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..........................................
Numeric Fields
If the selected field contains numeric data, the Format Numeric Field
dialog box appears:

Indicates
current color

Click to specify
a color for the
field's contents

Display negative numbers in red~-~
(with or without minus sign)

Click to automatically copy data into the ~r.;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;>':;;"~=====il
field from the previous record II Format Humeric Field
Click to specify the field's alignment~l AI'

r
ty e Ign

Click to define the field's style .... 0 Bald @Left

no Italic 0 Center
o Under line 0 Right
OBarder

Display large numbers with commas--rn0 Commas Display .....,

Parenthesize negative numbers InO () Hegs. @General 0 Percent
(no minus sign) It:O Red Hegs. 0 Fixed 0 Dollar

Decima Is: lPlJ ~O~s::ci~e~nt~i!.!fi~c--;;;;;;;;;;;;;;;;;;;;;:;~l1- Click to specify
" a display format

( Cancel ) « OK »
'-~- Type the number of decimal places here

You can specify one of five unique number formats for numeric fields (l's
are used as placeholders only):

Numeric Field Display Formats

Format: Displav: With commas: With commas and
two decimal places:

General 1111 1,111 1,111.11
.

Fixed 1111 1,111 1,1l1.11

Scientific 1e+3 1e+3 1.11e+3

Percent 111111% 111,111% 111,1l1.11%

Dollar $1111 $1,111 $1,111.11

General display is the default setting: it shows the number with as much
accuracy as possible given the dimensions of the field's display box, If a
numeric value is too large to be displayed in the field it automatically
appears in scientific notation.
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Fixed displays the numeric value with a given number of digits after the
decimal point. Scientific displays a number field in scientific notation.
Percent displays a numeric value as a percentage (the number multiplied I
by 100, followed by a percent sign). Dollar displays the field as a fixed I-"!
value preceded by a dollar sign.

What the ##?If a numeric field value can't be displayed in its entirety,
it appears as two U#" symbols. Resizing the field box (or columnJ when
the List screen is displayed) may provide room to display the value.

Picture Fields
If the selected field is a picture field, the Format Picture Field dialog box
appears:

Click to display a box around the field
on the form and when printed

Click to clip picture to fit in fieid box

Click to scale picture to fit in field box

Formot Pioture Field

[ St~le~ [DiSPIO~--rr [8JB~ @Clip
OSoale

( Conoel ) « OK »
Picture fields feature two unique display options, Clip and Scale. When
you select Clip, only that part of a picture that fits within the field's box
on the Form screen is displayed (the upper-left comer of the picture
starts at the upper-left of the field box). When you select Scale, a picture
is reduced so that the entire picture appears in the field box.

Clipped graphic field Soaled graphic fieid

68

Is my picture ruined? These options are for the display of picture
fields only. The entire picture is stored in the field regardless of the
display option you select.
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Date Fields
If the selected field is a date field, the Format Date Field dialog box
appears:

Click to automatically copy data into the-----------
field from the previous record 1I;;;;;;;;;;;;;;;;;;;=;;;;;;;;;;;;;======~======il

Click to specify left-aligned, --lJ format Dote fie Id
centered,orright·aligned II rStule "Rlign
~DBoid @left

Click any combination of styles lllD Italic 0 Center
o Under line 0 Right

When chosen, the Border option~D Border
displays a box around the field on ,
the form and when printed DlsploU -------,

@OB/24/63
Click to specify a display format· 0 Rug, 24, 1963

o Rugust 24, 1963

( Cancel ) « OK ]

Click to display weekday ofdate---l!=~~~~~~=r~==~~;;~;;~~JJ
In addition to options for Style, Alignment, Color, and Auto Fill
which are discussed above-this dialog box also contains three different
options for displaying the date, as well as check boxes for Auto·Stamp
and Show Weekday.

Auto·Stamp automatically fills the date field with the current date. This
date is provided by the system clock of your Apple IIos. Auto.Stamp
takes precedence over Auto Fill if Auto Fill is also selected.

If Show Weekday is checked, the weekday of the date will be displayed
before the date, separated from it by a comma.

What's the range for dates? Dates in AppleWorks OS must fall in the
range of January I, 1900 to December 31,2155. If your date falls
outside this range, use a text field rather than a date field to record
the data.

Static Text Field
If the selected field is a static text field, the Format Static Text Field
dialog box appears. The only formatting option for static text fields is a
check box for Border, to display a border around the field.
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Formot Stotic Text Field

[
Stule:=-::l

When chosen, the Border option----Hf- D Bmlerj
displays a box around the field on
the form and when printed

1-1

( Cancel ) « OK

Time Field
If the selected field is a time field, the Format Time Field dialog box
appears:

»OK«( Concel )

Stule Align
DBoid @left
D Italic OCenter
D Underline ORight

tDBorder

Click to automatically fill the time field
with the current time

Click to automatically copy data into the-------------,
field from the previous record Ii

U Format Time Field
Click to specify lell·alignment, II r ~
centering, right-alignment ~

Click any combination of styles-- ~

When chosen, the Border option ---
displays a box around the field on the
form and when printed D Auto-Stomp D 2~ Hour Time --------1

In addition to options for Style, Alignment, Color, and Auto Fill
which are discussed above-this dialog box also contains check boxes for
Auto.Stamp and 24 Hour Time.

Auto.Stamp automatically fills the time field with the current time. The
time is provided by the system clock of your Apple llos. Auto.Stamp
takes precedence over Auto Fill if Auto Fill is also selected.

If 24 Hour Time is selected, all time values contained in the field arc
displayed in 24·hour time (for example, 11 p.m. would be displayed as
23:00).
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Field Formula

The Field Formula command lets you make a field a calwlated field by
specifying a formula to be used to calculate the value displayed in the
field. Any text, numeric, date, or time field can be a calculated field. A
field must be selected while the form definition screen is displayed before
you can use the Field Formula commandi otherwise, it remains dimmed
on the menu.

When you choose Field Formula, AppleWorks OS displays a dialog box:

Click here to select a function

,
I,

Edit formula for "lect'd fi,ld:
Fi'l d,: "cO",D,,,,ra,,,t,,,io,,,n,,,s:,-__=
Zip Cad' i) +
Stat,
T,l,phon, Humber

Click here to add a field to a formula ---HH6rass Sales
International Sales
Hatianal Sales .()

Formulo:

Click here to select an operator

The field formula appears here. ----jt-I,,["'In",t,,,-rn:::a~ti=an~a~1~sa~I'='~I+-"[H"a.:.:ti.:.:on,,a,-1S",a"'''''',-I -;;;;;;~;;;;;;:;;;---
You can editthe formula or type ( Cancel ) « OH :D
new formula information. lL==::;~~~~==========~;;;;;;;;;~==JJ

The dialog box contains scrollable lists of fields, operations, and func
tions-the three elements you can use to create calculated fields. The
Fields list contains the names of all the data fields in the database. The
Operations list contains the operators you can use in formulating expres...
sions. The Functions list contains the various functions available for
creating formulas. For more information on the many different functions
AppleWorks OS offers, see appendix B, iI Functions and Formulas/' in
this manual.

Below the lists is an entry box for the field formula. You can type the
formula directly into this box, or enter elements of the formula from the
list boxes by double-clicking each element you need for the formula.

Remember those brackets! If you're typing in the formula, be sure to
place square brackets ([ and]) around all field names (square brackets
are automatically placed around field names if you double-click from
the Fields list).
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For example, suppose that the current field is a numeric field named
Total$, and your form contains two other numeric fields named Savings
and Checking. You can make Total$ display the sum of Savings and
Checking by •• i

II double-clicking Savings in the Fields scroll list,

II double-clicking the plus sign (+) in the Operations scroll list,

III double-clicking Checking in the Fields scroll list.

You could also rype rhe following:
[Savings]+[Checking]

When the formula is complere, click OK. AppleWorks OS examines the
formula to determine that it doesn't contain any errors-for example, if
you forgot ro include square brackets around a field name. If AppleWorks
OS does detect an error, it displays a dialog box to warn you that the
value won't be accepted.

Y Warning: If you create a field formula for a field in which you've
already entered data, a dialog box appears to warn you thar accepting
the formula will destroy the data.

Insert Record

This command inserts a new record immediately before the current
record (the record containing the active cell) in a database.

Note: The new record is not necessarily empty-any Auto-Stamp or
Auto Fill fields will contain data.
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Case sensitive

« Find »

Organize Menu

Find...
Find Hext OF
Replace...
Hatch Records... aH
Show All Records oR
Hide Se Iected Records Q[
Hide Unselected Records a]
Hark Fields
Unmark Fields
Display Harked Fields
Sort...

Type the characters to be
searched for here

The Organize menu contains commands for searching, sorting, and
manipulating the information in a database file.

Find ...

The Find command searches for and selects the first field in a database
document that contains a specified set of characters. Only the active
records in the database are searched. Text fields are always searchedi if
the specified characters are numbers, or if they're in time or date format,
then fields with those data types are searched as well.

When you choose Find, AppleWorks OS displays a dialog box:

Find Text
r;:-----------Find: IHouseman

[8JWhole word

( Cancel )

Click here to search by
separate word only

Click here to search for data that matches
exactly-including uppercase and lowercase

73

Type in the entry box the characters you want to search for, select the
appropriate settings, and click Find. The first occurrence of the specified
characters in the database is displayed.

If AppleWorks OS fails to find the specified characters, a dialog box
appears to notify you that no matching text was found.

WholoWord
If Whole Word is selected, AppleWorks OS searches for the first field
where the specified characters appear as a separate word. If Whole Word
is not selected, AppleWorks OS searches for the first occurrence of the
characters either as a separate word or as part of a larger word.

Case Sensitive
If Case Sensitive is selected, AppleWorks OS searches for the first field
containing the specified characters exactly as you typed them. If Case
Sensitive is not selected, AppleWorks OS searches for the first field
where the specified characters appear, ignoring differences in case.
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Find Next

Find Next lets you quickly search for the characters last specified with
the Find command without displaying rhe Find dialog box again. Find ICCC-!
Next is dimmed on the menu until a successful search has first been
conducted with the Find command.

When you search for characters with the Find command, only the first
record that contains the specified characters is displayed. With the Find
Next command, you can locate each subsequent occurrence of the
specified characters until there are no further occurrences of the eharac.
ters in the database.

If AppleWorks OS fails to find the specified characters, a dialog box
appears to notify you that no matching text was found.

Replace ...

The Replace command lets you search the active records in a database
for a specified set of characters and replace them with another set of
characters. Text fields are always searchedi if the specified characters are
numbers or are in time or date format, then fields with those data types
are searched as well.

When you choose Replace, a dialog box appears:

Click here to prompt for confirmation
before each replacement

hed
Find &Replace Text

Replace: IChicago I
With: Illlinoisl I
o Case sensitive [2J Confirm changes

ers ( Cancel ) ( Replace »
pper-

Type the characters to be seare
for here

Click here to search for charact
that match exacUy-including u
case and lowercase

Type the characters to replace
them with here
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Type in the upper entry box the characters that you want to search for,
and in the lower entry box type the characters that you want to replace
them with. AppleWotks OS will search for records that contain the
characters in the Replace entry box and then replace those characters
with the characters in the With entry box.

If AppleWorks OS fails to find the specified value, a dialog box appears
to notify you that no matching text was found.

Case Sensitive
If Case Sensitive is selected, AppleWorks OS searches for the first field
containing the specified characters exactly as you typed them. If Case
Sensitive is not selected, AppleWorks OS searches for the first field
where the specified characters appear, ignoring differences in case.

Confirm Changes
If you select the Confirm Changes option, AppleWorks OS allows you
the option of replacing each occurrence of the search characters as it's
found. The field containing the characters is selected and a message
appears in the entry bar asking if you want to replace the selected
characters. Type Y to replace the characters, N to ignore this occurrence
of the search characters and continue the search, or Q to quit the search.

'* file Edit Organize Tomplot. R.port Window
_____~~;D~sl!~ii~E~E~mp~I~OY~..~.o~o~tO~(~OB~)~~~~~~~~~~Confirm Changes message ,f-'I- R. I". cont.nt, Y/HI ?

in the entry bar Hom. Em .Humber O. ort..nt
.~.'.o.m.Rn~t'.~ J~.~.L~.o.!.'.L..................... . .__ Jabo.RrouL_J 6SSiQccauatmQ. __ ~ L ~ ~_____ _

If the Confirm Changes box is not checked, AppleWorks OS will
automatically find all occurrences of the search characters and replace
them with the replacement characters without asking for confirmation.

.., Warning: You can't undo the Replace command. Be careful when
using Replace.
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Match Records ...

The Match Records command selects all active records in a database
that meet a specified set of conditions. For example, you could use I.~c ;
Match Records to find all records in a database in which a field con-
tained a value greater than 500. The Match Records command can only
be used when information has been entered in the databasei othenvise it
remains dimmed.

When you choose Match Records, a dialog box appears:

I t f fcr k hIC ere 0 sa ec a unclOn~

tor
Enter Botch record condition:

FUnCti~Fi.lds: ~ Operotions:
Mom.

~
t ; Rbs(

Rdd"" - Roos(
Citu , Rlort(
Stot. I Rnd(
Zip Cod.

~
, Rsc(

Phon. Mombor ( Rsin( ~
Condition:

r here. I[Ilmount Ouol> 500 I
or type ( Concol ) [ S.hct )

The match conditions appea
You can editthe conditions
new conditions,

Click here to specify a field

Click here to select an opera

The Match Records dialog box is similar to the Field Formula dialog box
(see "Field Formula'! in this chapter), with one major exception-you
enter a logical expression rather than a formula in the entry box. For
example, if you wanted to match all records that contained a value
greater than 500 in an Expense field, you would enter the following
statement:

[Expense] > 500

Other than this one exception, the dialog box is used much like the
Field Formula dialog box. It contains scrollable lists of field names,
conditions, and functions. The Fields list contains the names of all the
data fields in the database. The Operations list contains the operators
you can use for establishing conditions to be met. The Functions list
contains the different functions you can use to create conditions depend ...
ent on calculated values. (For more information on the functions
provided by AppleWorks OS, see appendix B, "Functions and Formulas,"
in this manual.)
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Below the lists is an entry box where you type in the criteria for the
match. You can type the match conditions directly into this box, or you
can enter elements of the match criteria from the scrollable lists above
by double-clicking each element individually.

When you've finished entering the match conditions, click OK. Apple
Works as searches the database and selects all records that match the
specified conditions. If you like, you can choose Hide Unselected
Records from the Organize menu to display only the records selected in
the match.

Show All Records

The Show All Records command returns all records in a database to the
document window, including those "hidden" with Hide Selected Records
or Hide Unselected Records.

Hide Selected Records

The Hide Selected Records command conceals all selected records.
\Vhen you choose this command, all selected records in the active
database are hidden from view and aren't used for searches, sorts, or
reports.

To display all the records in the database again, choose Show All
Records from the Organize menu.

This command is dimmed when no records are selected.

Hide Unselected Records

The Hide Unselected Records command conceals all unselected records
from the current active database. When you choose this command, all
unselected records in the active database are hidden from view and
aren't used for searches, sorts, or reports.

To display all the records in the database again, choose Show All
Records from the Organize menu.

This command is dimmed when there are no unselected records (when
no records exist or when all existing records are selected).
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Mark Fields

This command lets you identify or "mark" selected fields. When a field is
marked, it's hidden from view in the document window. Certain fields in
a database may contain sensitive information, and the Mark Fields
command can be used together with the Display Marked Fields com
mand to hide those fields ftom view.

If the Display Marked Fields command is selected (checked on the
menu) when you choose Mark Fields, marked fields are displayed,
although the fields appear shaded. Otherwise, the marked fields are
concealed from view.

If you wish to unmark fields later, you can do so with the Unmark Fields
command.

For more information about marked fields} see IIDisplay Marked Fields"
and IlUnmark Fields," in this chapter.

Unmark Fields

The Unmark Fields command removes from a selected marked field the
mark used to control the field's visibility in the database.

To unmark a marked field, the field must be visible. Use Display Marked
Fields to show all the fields in the database, and select the fields you wish
to unmark before choosing the Unmark Fields command. Unmark Fields
returns a marked field to its original state; the field and its values will
again be visible in the database at all times.

Display Marked Fields

The Display Marked Fields command controls whether marked fields are
visible in a database. When checked, marked fields are visible, though
shaded to distinguish them from unmarked fields. When you choose the
checked command, the check mark is removed, and marked fields are
concealed from view. Choosing the unchecked command again displays
the marked fields.
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Click field name to select a field

Sort...

The Sort command lets you arrange the active records in a database
document according to the values in specified fields. To use Sort, the
database must contain informatiollj if you haven't entered any records
(or if you've only entered oneL the command is dimmed on the menu.

When you choose Sort, AppleWorks OS displays a dialog box:

Click to specify selected field as esort field

""S.lect fi.ld(s) to b. sorted:~
Fi.lds: Sort on:

~111:~";; : ~ 9..0 R.ount Duo
~R..Z lost Hoo.

Stot. R..ZRdd""
~.(} [±:] R..Z Zip

( Conc~1 ) [ Sort »
Click to deselect sort field Sort order box. click to

change sort order

The Fields list box displays a list of all the fields in the current database.
You can sort on any type of field except picture or static text (fields that
you can't sort on are dimmed). The Sort On list box displays the fields
you select to sort on and their progressive sort order-the primary sort
field is at the top of the list box, the secondary sort field is immediately
beneath it, and so forth. When you first choose Sort for a database, the
Sort On list is empty.

To select a field as a sort field, click the field name in the Fields list box,
then click the right arrow button (or double·click the field or press the
Right Arrow key). The field's name is displayed in the Sort On list box
and dimmed in the Fields box.
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Beside the field name in the Sort On box is a small box displaying the
sort order of the field. This allows you to specify whether you want to
sort on the field using ascending or descending sort order. For text fields,
ascending order means in alphabetical order from A to Z and descending -,,{
order means in reverse alphabetical order from Z to A. For numeric, date,
and time fields, ascending order means 0 to 9 and descending order
means 9 to O. To change the sort order of a field, click the sort order box.

Clicking a field's sort order box
changes the sort order of the field

80

A..Z Lost Home if
A•• Z Address
0•.9 Zip

U9..0 Amount Due
~

After you've specified the first field to be used for the sort, you can add
additional sort fields in the same way. For example, if you specify a
second field to be used as a secondary condition in the sorting process,
that field serves as a tie~breaker when two or more records contain the
same information in the first field~the records are arranged based on
the data stored in the second field.

To remove a field name from the list in the Sort On box, click the field
name in the Sort On box and click the left arrow box (or press the Left
Arrow key or double-click the field name). The field name is removed
from the box and AppleWorks OS won't sort the database on that field.

When you've specified the fields to be used for the sort operation, click
Sort. The active database is sorted according to the conditions you've
specified.

For a table showing the order in which text fields are sorted, see appen
dix C, "Sort Order for Text," in this manual.
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Template MellI!

I· I I •

{Show Definition ill
Show form a)
Shol~ List a(
Open Templote...
Sove Templote...
Orid aU
Orid Size...
Disploy Preferenoes...
Return Key Preferenoes...
Choose font...

The Template menu provides commands that let you define the environ...
ment of a database-what a data entry form looks like, what fields the
database contains, how you view the information in the database, what's
printed on reports. This menu contains commands for creating and
saving templates---documents that include everything in the database
except the actual data.

Aboultemplates... A template is an AppleWorks OS database en
vironment containing the form definition and report format for each
database that you create. A database's template lnaintains certain
formatting information-which fields are marked, which fields are
hidden, the database's form definition, and so forth.

Show Definition

The Show Definition command displays the form definition screen of a
database. \Vhen the form definition screen is displayed, you can make
changes to data fields and labels and modify the form's header and footer
areas.

When you create a database, AppleWorks OS automatically displays the
form definition screen. This is the only way you can create or modify
fields. Once you've created a field, you can choose Show Form or Show
List to display the form or list screens for data entry.

Important! At least one field must exist before you can enter data.
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Show Form

The Show Form command displays a database using the form you created
in the form definition screen (see uShow Definition").

A select box is displayed in the upper-left corner of each record; clicking
the select box selects the entire record for an operation.

GeorgI! Andrews I
094

• file [dil Organize T.mpl,l. R.pm Window

~;:0!jEEDi~~~~==[=m=PI=ou=.=..=OO=I=O(=O=O)========~
Click the select box to select 1.
a record

If no records are selected, the database is displayed starting with the first
record in the database. If one or more records are selected, the database
is displayed starting with the first selected record.

You can scroll to other records in a database using the scroll bar at the
right of the document window.

Show List

Show List displays a database in tabular format similar to the Apple
Works OS spreadsheet. Each record in the database is displayed as a row
in the table; each field appears as a column. The List screen lets you
view, select, and work with multiple records at one time.

A select box is displayed to the left of each record; clicking the select
box lets you select the entire record for an operation.

T.mpl,t. R.porl Window

[mplouee.O,t, (00)
7/ 7

It Fil. [dil Organize
,0

Hom' [m .Humber 0, mmenl

Click the select box to select a record ---oJ~:b~VQ:~~::j::Jnl~;::Jij.\.\ni:::::
.~.'Mu.ij.Q.u .•.\ L. m.L~.~.I.ppi.Q.g ..__ htu. i1Mric_ j 't?'H.rJl~t.rou.t.S1'llliell_ _ ___ _ ~_
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Importantl Picture fields and static text fields aren't shown when
you're using the List display. Instead the message UPicture.. ," appears
in picture fields, and the message "Text.. ,Il appears in static text
fields.

Open Template...

The Open Template command lets you open a previously saved tem
plate.

When you save your database, this template is saved, along with the
actual data values in the database. The Open Template command lets
you open and use a template saved with one database to store new infor~

marion for a different database document.

Open Template works much like the Open command on the File menu.
Select a template from the list, and click Open. (For more information,
see "Open" in chapter 1, llAppleWorks OS Commands,H)

Save Template...

The Save Template command saves the current template without saving
data. This command is useful when you want to save a template quickly
and then continue to work on the database. It's also helpful for saving a
copy of a template with a different name for use with a different set of
data records. You can also use Save Template to save one report format
for a data file and then create another report format for the same data.

Saving the template saves the current form definition, the current report
format, and other special formatting information used by AppleWorks
OS to maintain the environment of that particular database.

The Save Template dialog box is similar to the dialog box used by the
Save As command on the File menu. Type a name for the template, and
click Save. (For more information, see uSave As" in chapter 1, uApple~
Works OS Commands.")
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Grid

The Grid command controls whether the form grid is turned on or off.
The grid is an invisible set of horizontal and vertical lines on a form that
you can use to control the placement of fields. These invisible lines,
which are set apart from each other in regular increments (sec uGrid
Size" for information on changing these increments), can be used to
align objects in a document precisely. When the grid is on, fields that
you're creating, moving, or reshaping will {(snap/' as if magnetically, to
the nearest grid line.

When the Grid command has a check mark (...J) beside it, the grid is on.
(When you create a new database, the Grid command is checked and
the grid is on.) When you choose the checked Grid command, the check
mark is removed and the grid is turned off.

Changing the size of the grid increments with the Grid Size command
won't affect the placement of a field already on the form unless you move
or reshape the field.

Grid Size ...

The Grid Size command lets you control the spacing between grid lines.

When you choose Grid Size from the Template menu, a dialog box
appears:

Adjust Form Grid
Click here to specify vertical spacing ~~~-Vertiool---------------

[ (jHl8" 01/~" 0112" 01"
Click here to specify horizontal spaoing ~~h[HHO~r~iziioJnnittiiolj::=============

@ 1/8" 0 1/~" 0 1/2" 0 1"

( Conoel ) [ OK »
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Click the appropriate buttons to specify the amount of space you want
between vertical and horizontal lines in the grid.
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For example, if you click the 1" button in the Vertical box and the 1/2"
button in the Horizontal box, the resulting grid will consist of vertical
lines spaced one inch apart and horizontal lines spaced one half-inch
apart.

Display Preferences..,

The Display Preferences command provides options for changing rhe
way database information is displayed.

When you choose Display Preferences, a dialog box appears:

Seleot disploij/printing options:
D Hultiple reoords per form poge
D Print line seporoting reoords on form
D Hide oelllines in list mode

( ConoeI ) [1I"-==;o;OK;=="'II]

Multiple records per form page
This check box lets you display as many whole records on a form page as
will fit. (The precise number of records that will fit depends on your form
definition.) If you don't select this option, AppleWorks OS displays
only one record on a form page at a time.

Print line separating records on form
When you click this check box, AppleWorks OS displays a line between
records on the form screen and prints a line separating each record when
a report is printed.

Hide celilines in list mode
This check box controls whether the tabular lines separating records and
fields in List View are displayed or hidden. When this option is selected,
the lines are hidden.
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Return Key Preferences

This command lets you tell AppleWorks OS what action to take when
you press the Return key.

Click to advance the active cell to the, r.;;;;;;;;;;;;;;;;;;;;;;;;;;======;;;;;;;======;;;;;;;;;;;oJ
first field in the next record when you Specifu return keu action preference:
press Return. This is the default setting. '@Nextrecord, first field (default)

Click to advance the active cell to the --HI-O Next record, some field (down arrow)
same field in the next record when you 0 Next fie ld, same record (tab &right arrow)
press Return

( Cance I ) « OK ]

Click to advance the active cell
to the next field in the same
record when you press Return

You can move the active cell to the next field or the previous field in a
record by pressing the Right Arrow key or Left Arrow key, respectively.
\\!hen you reach the end or beginning of a record, the arrow keys won't
move the active cell to the next or previous record (the Tab key will
move the active cell to the next record, however).

You can move the active cell to the same field in the next record or the
previous record by pressing the Down Arrow key or the Up Arrow key,
respectively.

Choose Font

The Choose Font command lets you select the font, character size, and
style for an entire database document. This command appears in several
of the AppleWorks OS applications and is explained in detail in "Other
Common AppleWorks OS Commands," in chapter 1.

By the way... Styles specified with the Choose Font command may
have little impact on the overall style of a database document, as the
style of each field in a database can be modified with the Field Format
command. The field format always takes precedence over font selec
tions made with Choose Font.
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Report Menu The Report menu contains commands for creating, modifying, and
embellishing reports.

Header .
Footer .
Format .
Summoru Onlu
Create Report ...

Header...

The Header command lets you type a line of header information to
appear at the top of each page on a report. Header text can be any
combination of boldface, italicized, and underlined text. AppleWorks
OS also includes options for automatically displaying the current date
and page number in the header.

Header Format
ate in header Oisplou Title

OOote OBoid
umber in header -0 Page Numbers o Italic

/ o Underline

Title Text:

I I

( « »Cancel ) OK

Click to include page n

Click to print current d

Type header text here

Click to specify text style
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Footer...

The Footer command lets you type a line of footer information to appear
at the bottom of each page on a report. Footer text can be any combina...
tion of boldface, italicized, and underlined text. AppleWorks OS in
cludes options for automatically displaying the current date and page
number in the footer.

Footer Formot

footer,__ oisplou Title
- Doote Doold

er in footer -- C- D Poge Numbers D Itolio

/ D Underline

Title rext:
-I / 1

( Conoel ) « OK » ,

Click to include page numb

Click to print current date in

Type footer text here _._..

Click to specify text style .

Format. ..

The Format command lets you specify the names to be used for column
headings in a report as well as subtotalling information for fields in the
report.

When you choose Format, a dialog box appears:

Click to specify when to print subtotals -r.;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;=~=============;:;;;i1

»OK

DHinimum
DStd.Dev.

«

Subtotal Break After:
ITIZip Code

DCount
DSum

( Cancel )

Report Formot

Type column heading for selected field -~I-';:Co:11C:um:::n"H"'eC:aT,di"'n:::g: IAmount Owed

Functions
t2J Average
DHoximum

Click to select a field --.. ------1

Click to select a summary function --_.--til-
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Column Headings
When ApplcWorks OS creates a database report, field values appear in
columns and AppleWorks OS automatically generates column headings
for each field in the report. The default heading is the field name, but
you can give the field any heading you want (up to 40 characters).

To create or edit a column heading, click the name of the field you're
creating the heading for (scroll the list, if necessary). The current
heading for the field appears in the Column Heading entry box. Type a
new heading for the field. The heading you specify will be used as the
column heading for that field in the report.

Subtotals
You can perform calculations on the information contained in the fields
of a database report and display these calculated values, or subtotals, at
specified places in the report. With the Format command, yOll can
specify when you want subtotals to be displayed and the type of calcula
tions to be performed.

Unless you specify otherwise, AppleWorks OS displays these calculated
values only at the end of a report (indicated by the Totals Only setting in
the Subtotal Break After list box). You can, however, create a break in a
report by specifying that you want subtotal information to appear when;
ever the value in a specified field changes.

Important! Breaks can only be made on sorted fields.

To create a subtotal break, scroll down the list of sorted fields in the
Subtotal Break After box until the field you want to break on appears.

As you scroll down the list, the fields you specified as sort fields with the
Sort command are displayed (see llSort/' in this chapter) in order of sort
precedence, primary sort field to last. (If yOll haven't selected any sort
fields, the box will only display the Totals Only setting.) The field name
in the box is the field on which breaks will occur. Subtotal information
will be displayed in the report whenever the value in this field or a sorted
field of higher precedence changes.
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Summary Functions
The Function check boxes let you specify the type of calculations to be
performed on the data in the report.

The subtotal functions are described below:
II Average-ealculates the average of the values in a specified numeric,

date, or time field.

1'1 Maximum-displays the largest value in a specified numeric, date, or

time field.

II Count---ealculates the total number of non..empty values in a sped ..

fied field.

.. Sum--<:alculates the sum of the values in a specified field.

.. Minimum-displays the smallest value in a specified numeric, date, or

time field .

.. Std. Dev.-calculates the standard deviation of the values in a

specified numeric field.

Not all of the functions work with all types of data. Only the Count
function is available for text, picture, and static text fields, and you can't
use Sum and Std. Dev. with time and date fields. When a function can't
be used with a certain data type, the function is dimmed.

Summary Only
The Summary Only command tells AppleWorks OS to produce only a
summary report when you choose the Create Report command. A
summary report doesn't print any of the records in the database, but
rather prints just the column headings and subtotal information specified
with the Format command. Summary reports are useful when you just
want to know the results of calculations you perform on your data and
don't need record.by.record detail.

When you choose Summary Only, a check mark <'I) appears to the left
of the command on the Report menu. To return to printing detailed
reports, choose the Summary Only command again. The check mark is
removed and complete reports (including record as well as summary
information) will again be produced when you choose Create Report.
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Create Report ...

This command creates a report based on the criteria you specify with the
Format, Header, and Footer commands. The report is generated in
memory as an AppleWorks OS word processing document and appears,
completely formatted, in a word processing document window. The
report document can be edited with any of the word processing com~

mands and printed like any other word processing document.

For more information on printing, see lIPrint" in chapter 1, ltApple\Vorks
OS Commands."
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Spreadsheet Commands

FHe MellI!

Hew... 6H
Open... 60
Close 6K
Save 6S
Save As...
Delete file ..
Import file ..
Choose Printer...
Page Setup...
Print... 6P
I'l'int Hm·~e ...
Quit 6Q

The standatd File menu commands--common to all the AppleWotks
OS applications-ate described in chapter 1, "AppleWorks OS Com·
mands." The Print Merge command is only available in the word
processor, so that command is dimmed on the spreadsheet File menu.
Although common to all the AppleWotks OS applications, the Save As
command supports a special format for saving spreadsheet documentsj
infotmation on this fotmat is provided here.

Save As...

The Save As command for the AppleWotks OS spreadsheet wotks the
same as in the other applications, except that spreadsheet documents can
be saved with a special fonnat-ASCII text with tab/carriage return
delimiters-in addition to the regular spreadsheet fotmat. This special
fotmat allows you to save an AppleWotks OS spreadsheet in a fotmat
that can be read by other spreadsheet programs.

When you choose Save As in the spreadsheet application, the Save As
dialog box appears containing the usual options for saving documents, as
well as an additional setting for saving a spreadsheet in the ASCII·
delimited format.

Click to save in AppteWorks GS
spreadsheet format

® /flnon,i.1
7641""r 800 K. ( Disk )

D bunk..." ~ I Helf f.lder )
[) soving5

( OPt'!\ )

f...l CI6se )
{)o

Save '" I: Save ]
IBudg,~ I( C.n,,1 )

o Spr"d,h"l For••1 @A,ASCIITIX\' .__. Click to save as
ASCII·delimited

Fot infotmation on the other options provided by the Save As com·
mand, see lCSave Asll in chapter 1, "AppleWorks OS Commands. ll
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Edit Menu

Undo 6Z
Cut 6X
Copu 6C
Poste 6V
Cleor
Poste Formot Onlu
Poste Volues Onlu
Select All 6A
Insert 61
Delete 60
Hove... 6H
Fill 6F
Tronspose 6T

The standard Edit menu commands (Undo, Cut, Copy, Paste, Clear, and
Select All) are described in chapter 1. "AppleWorks OS Commands."

In addition to the standard commands, the Edit menu contains com~
mands for editing, inserting, and deleting spreadsheet cells.

Paste Format Only

The Paste Format Only command assigns the format (but not the
contents) of a copied cell to a selected cell or range of cells.

Paste Values Only

The Paste Values Only command assigns the value or label of a copied
cell or range of cells to a selection.

Insert

This command inserts a blank cell or range of cells into a spreadsheet.

To use the Insert command, select the cell or cells where you want to
insert a corresponding number of blank cells. \Xlhen you choose Insert,
AppleWorks OS inserts the same number of blank cells you selected.
shifting the remaining cells in the spreadsheet to make room for the new
blank cells. When you insert an entire row (or rows). AppleWorks OS
shifts the remaining cells down; when you insert an entire column (or
columns), the remaining cells are shifted to the right. If you're inserting
a single cell or a selection that is neither entire rows nor entire columns,
a dialog box appears to let you choose how you want the cells shifted:

Insert in which direction?

I]

o Right

( Concel )

@Down

[ OK ))
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Choose the way you want the cells shifted. and click OK. The blank cells
are inserted and the other cells are shifted. The formulas in the shifted
cells are adjusted to accommodate cell dependencies.
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Delete

The Delete command removes a selection of cells from a spreadsheet.

When you delete a selection, AppleWorks OS shifts the remaining cells
in the spreadsheet to fill the space left by the selection. When you delete
an entire row (or rows), AppleWorks OS shifts the remaining cells up;
when you delete an entire column (or columns), the remaining cells are
shifted ro the left. If you're deleting a single cell or a selection that is
neither entire rows nor entire columns, a dialog box appears to let you
choose how you want the cells shifted:

Delete in which direction?

OLeft

( Concel )

@UP

[ OK ]

Choose the way you want the cells shifted, and click OK. The selection
is deleted and the remaining cells are shifted. The formulas in the shifted
cells are adjusted to accommodate cell dependencies. References to

deleted cells produce an error on evaluation.

Pressing the Delete key does not produce the same effect on a selection
as choosing the Delete command. When you press the Delete key, the
selection is removed, but the remaining cells are not shifted to fill in the
empty space. In other words, the Delete key works like the Clear com
mand rather than the Delete command.
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Move ...

The Move command lets you quickly move a selected cell or range of
cells to a new position in the spreadsheet.

Before using Move, select the range of cells you want to move. When
you choose lvlovc, a dialog box appears:

Hove to

( Canoe I ) « OK ]
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Type in the entry box the reference for the cell that you'd like to make
the upper-left cell of the selection in its new location, and click OK. The
selection is moved to the new position.

When you move cells, the formulas in the moved cells are adjusted to ac,
commodate cell dependencies. References to moved cells arc also
adjusted. If you move cells onto cells that are referenced by formulas in
other cells, however, those formulas will evaluate to N/A. This is also
true if you move cells onto either endpoint of a range of cells referenced
by a formula in another cell, but not onto cells elsewhere in the range.
For example, moving cells to the cell Al affects references to the range
A1..B2, but not references to A2..BI (although both ranges include
these cells).

"Point-and-Shoot..." You can also move a selection by holding down
the d key and clicking in a new location in the document. The
selection moves to the new location, with the top,left cell in the
selection occupying the cell you click. See chapter 4, lISpreadsheet,"
in the APIJle\V'orks GS User's Guide for more information on this
llpoint,and,shoot" method for moving cell selections.
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Fill

The Fill command copies the cell or cells in the leftmost column or
uppermost row of a selection into the other cells in the selection. If the
remaining cells in the selection aren't empty, Fill replaces the informa,
tion in those cells.

To fill a row of cells with a value, select the range of cells to be filled,
with the leftmost cell containing the fill value, and choose Fill from the
Edit menu. To fill a column of cells with a value, select the range of cells
to be filled, with the uppermost cell containing the fill value, and choose
Fill.

If you select a range that contains both rows and columns, AppleWorks
OS displays a dialog box:

Fill in which direction?

ORight

( Concel )

@Down

[ OK ]

If you want the selection to be filled to the right-filled with the values
in the leftmost column-click Fill Right. If you want the selection to be
filled down-filled with the values in the uppermost row-click Fill
Down.

If the fill value is a formula, the formula is copied into the remaining
cells in the selection and recalculated for each particular cell. If the
formula in the fill value cell contains relative addresses, the formulas in
the new cells will also contain relative addresses, and the results in each
new cell will reflect those relative addresses. If the formula in the first
cell contains absolute addresses, the copies of the formula in the remain,
ing cells retain those absolute addresses.
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Transpose

The Transpose command exchanges the positions of selected rows and
columns, changing row values into columns and column values into
rows. When you transpose a selection, the formulas in the transposed
cells are adjusted to accommodate cell dependencies. References to
transposed cells are also adjusted.

Selected range bafore Transpose --~~j;;;1
command-in columns

Data Wind..
Untitl.d! (SS)

Ran. ABC D E

~RU~.f.!.~V.'I,~.:.:1.liJ."·+""""""""""I·"""""!"""""""""""1
HH...

Selected range after Transpose ----F=F=
command-transposed into rows 5 iii I i

__! __ :~:::~:~:~:~:~:~:~:~:~L:~:~:~:~:~:~:~:~:~:L~:~:~:~:~:~:~:~:~:C~:~:~:~:~:~:~:~:~:L~:~:~:~:~:~:~:~:~:1~:~:~:~:~:~:~:~:]~
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Format MellI!

Bold 6B
Under line 6U

IRlign Left
Rlign Center
Rlign Right

IGeneral 6U
Fixed 6.
Dollars 6$
Percentage 6%
Scientific Notation 6E
Set Decimol Places...
Commos 6,

IRed negotive U'S 6R
IPorenthesize neg. U's 6(
Set Defoul t Formot...

The Format menu contains commands for changing the style, alignment,
and numeric formatring of a cell or range of cells.

Bold

The Bold command changes the style of a selected cell or range of cells
to boldface.

When you choose Bold, a check mark (v) appears to the left of the com·
mand on the Format menu and the characters or numbers in the selected
cell(s) are changed to boldface. To return a cell or group of cells to non·
boldface, s~lect the cell(s) and choose the Bold command again.

The Bold command can be used with the Underline command to display
values that are both underlined and boldface.

Underline

The Underline command underlines the contents of a selected cell or
range of cells.

When you choose Underline, a check mark (v) appears to the left of the
command on the Format menu and the characters or numbers in the
selected cell(s) are underlined. To return a cell or group of cells to non·
underlined display, select the cell(s) and choose the Underline com·
mand again.

The Underline command can be used with the Bold command to display
values that are both boldface and underlined.

Align Left

The Align Left command aligns the contents of selected cells with the
left edge of each cell.

Note: Only cells containing text values are affected by this command.
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Align Center

The Align Center command centers the contents of a selected cell or
range of cells.

Note: Only cells containing text values are affected by this command.

Align Right

The Align Right command aligns the contents of selected cells with the
right edge of each cell.

Note: Only cells containing text values are affected by this command.

General

The General command displays numeric values in selected cells with the
default numeric format. This general numeric format removes trailing
zeros to the right of the decimal point and doesn't display dollar signs or
percent signs. If a number is too large to fit in a celt the number is
rounded until it fits; if an integer won't fit in a cell, it's displayed in
scientific notation. If a number is too large to fit in a cell in any other
format, the number is replaced with two pound symbols (##).

General format disregards the number of decimal places specified with
the Set Decimal Places command and instead uses as many decimal
places as are necessary (and as many as will fit in the cell) to express the
number. If a decimal value is less than I, the general format includes a
zero before the decimal point. For example, the value 98.60 is displayed
as 98.6, and the value $67.50 is displayed as 67.5. The decimal value .54
is displayed as 0.54.

Fixed

The Fixed command displays numeric values in selected cells with a
fixed number of places to the right of the decimal point. The number of
decimal places is initially two (or the last number you specified with the
Set Default Format command), but you can change it with the Set
Decimal Places command.
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Dollars

The Dollars command displays numeric values in selected cells as dollar
values, with a dollar sign to the left of the value and the number of
decimal places last specified with the Set Decimal Places command.

Percentage

The Percentage command displays numeric values in selected cells as
percentage values. The numeric values in the selected cells are multi~

plied by 100 and displayed with the number of decimal places last
specified with Set Decimal Places. A percent sign is displayed to the
right of the value.

For example, if the number of decimal places is set to two, the value .54
is displayed as 54.00%, and the value 1 is displayed as 100.00%.

Scientific Notation

The Scientific Notation command displays numeric values in selected
cells in scientific notation, with the number of decimal places last
specified with Set Decimal Places. This is especially useful when you're
formatting very large or very small numbers.

Scientific notation displays a numeric value as a decimal value multi...
plied by a power of ten. For example, the value 1530 can be expressed as
1.53 x 10', and the value 0.635 can be expressed as 6.35 x 10-'. This
notation proVides a shorthand which is convenient when working with
very large or very small numbers. For example, the value
256,323,122,332 can be written in scientific notation as 2.56 x 10".

AppleWorks OS displays scientific notation a little differently. Since
every value written in scientific notation contains the characters ltx 10'\
these characters are replaced by the letter lIe ,ll (The letter "e" stands for
exponent.) As a result, the value 1.53 x 10' is displayed in AppleWorks
OS scientific notation as 1.53e+3, and the value 6.35 x 10-' would be
displayed in AppleWorks OS as 6.35e-1.
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Set Decimal Places...

The Set Decimal Places command lets you specify the numbet of decimal
places displayed to the right of decimal values when you choose Fixed,
Dollars, Percentage, or Scientific Notation format.

When you choose Set Decimal Places, a dialog box appears:

fixed decimal places: [ID

( Cancel ) « OK ]
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Type in the entry box the number of decimal places that you want to
display (the default is two, but this can be changed with the Set Default
Format command), and click OK.

Commas

The Commas command tells AppleWorks OS whether or not to display
selected numeric values with commas. Initially, numeric values are
displayed without commas, but you can change this with the Set Default
Format command.

When you choose the Commas command, a check mark (v) appears
beside the command on the menu and the numeric values in the selected
cells are displayed with a comma separating each set of three digits to the
left of the decimal point. To remove commas from the values in a
selection, choose Commas again; the command is unchecked and the
values arc again displayed without commas.
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Red Negative #'s

The Red Negative #'5 command displays the negative numeric values in
a selection in red (or in a distinct pattern if you're using a monochrome
monitor). Initially, Red Negative #'5 is selected on the menu-indicated
by a check mark (,J) to the left of the command-and all negative
numeric values are displayed in red. (This can be changed with the Set
Default Format command.) You can change the negative value display to
black by choosing the checked Red Negative #'s command; the check
mark is removed from the menu and negative numbers appear in black.

The Red Negative #'s and Parenthesize Neg. #'5 commands can be
combined to display negative values in red and surrounded by
parentheses.

Parenthesize Neg. #'s

This command displays selected negative numeric values in parentheses.
(A standard accounting practice shows negative dollar values by SUT'

rounding them with parentheses, rather than using a minus sign before
the value.) For example, the value -76.54 would be shown as (76.54).

Initially, Parenthesize Neg. #'s is selected on the menu-indicated by a
check mark (,J) to the left of the command-and all numeric values are
enclosed in parentheses. (This can be changed with the Set Default
Format command.) You can change the negative value symbol to a
minus sign by choosing the checked Parenthesize Neg. #'s command; the
check mark is removed from the menu and negative numbers appear
with minus signs and no parentheses.

The Parenthesize Neg. #'s and Red Negative #'s commands can be com'
bined to display negative values in red and surrounded by parentheses.
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Set Default Format. ..

The Set Default Format command lets you change the formatting
options that are automatically used when you add new values to a
spreadsheet document. You can use this command to change the defaults
for any command on the Format menu.

When you choose Set Default Format, AppleWorks OS displays a dialog
box:

Click to set default text style-bold,---H
underlined, both, or neither

Click to add default numeric -----tf~~~~~~~~~~;;;;;;;;;~~::~~~~~:~lldisplay options - .-Format Optians - Format Stule ----,o Bold @Generalo Under line 0 Fixedo Commas 0 Dollars
[8J Red negative numbers 0 Percentage
[8J Parenthesize neg."' s 0 Scienti fie notation

fiancel J [ OK ]

Disp lou rnJdecima I pI ace(s)

/
Click to set default alignment-----H--l nlignment ----,

@left
OCentero Right

Type default number of
decimal places here

When you've specified the default settings you want, click OK. The new
defaults will be used for any new values you add to the spreadsheet.

The original defaults on the Format menu are always the same for new
documents. These defaults are displayed in the chart on the facing page.
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Initial Spreadsheet Formatting Defaults

Formauing option:

Bold

Underline

Align Left

Align Center

Align Right

General

Fixed

Dollars

Percentage

Scientific Notation

Number of decimal places

Commas

Red Negative #'s

Parenthesize Neg. #'s

Spreadsheet Commands

Default:

Not chosen

Not chosen

Chosen for text

Not chosen

Not chosen (numbers always aligned right)

Chosen

Not chosen

Not chosen

Not chosen

Not chosen

Two

Not chosen

Chosen for negative numbers

Chosen for negative numbers
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Options Menu

Manual Calculation
Recalculate O·
View Formulas
List Functions... oL
Change DefauIt Width ...
Restore Width to Default
Set Titles...
Hide Ce 11 Lines
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The Options menu provides commands that control spreadsheet recalcu
lation, the viewing of formulas in the spreadsheet, and column width.

Manual Calculation/Aula Calculation
These commands control whether you want to decide when AppleWorks
OS recalculates a spreadsheet or have the spreadsheet recalculated auto
matically.

Normally, AppleWorks OS automatically recalculates those spreadsheet
cells affected when a new value is entered. (Unlike some spreadsheet
programs, AppleWorks OS doesn't update all cells in the spreadsheet
even those unaffected by the change-whenever a change is made.) This
automatic, intelligent recalculation is powerful and convenient, but the
time required for calculation grows as more spreadsheet cells are filled.
The Manual Calculation command tells AppleWorks OS to recalculate
the spreadsheet only when you choose the Recalculate command.

When you choose Manual Calculation, the name of the command
changes to Auto Calculation and any values you enter into the spread
sheet have no immediate visible effect. When you're ready for Apple
Works OS to recalculate the spreadsheet, choose Recalculate. The
spreadsheet is updated to reflect any changes made since you chose
Manual Calculation or the last time you chose Recalculate.

To return to automatic recalculation, choose Auto Calculation. The
name of the command changes back to Manual Calculation.

Recalculate
The Recalculate command lets you manually recalculate a spreadsheet.

This command is used only when you've chosen Manual Calculation;
otherwise, it remains dimmed on the menu (see 'IManual Calculationll in
this chapter for more information on this command). Normally, there's
no need to choose Recalculate, because AppleWorks OS uses automatic
calculation to update the affected cells in a spreadsheet each time a new
value is entered. The time required for calculation grows as more
spreadsheet cells are filled, however, so there may be times when you
want to use manual calculation to speed up entry of new values.
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Like the automatic tecalculation of the AppleWorks OS spreadsheet
application, the spreadsheet's manual recalculation uses intelligent
recalculation, which means that only the cells that have been changed
(or affected by a change in another cell) since the last recalculation are
recalculated. When you choose Recalculate, any cells containing new
values..........-or references to other cells with new values-are updated.

View FormulasNiew Data

These commands control whether AppleWorks OS displays the actual
formulas of cells that contain formulas, rather than the calculated values
of the formulas (which are normally displayed),

When you choose View Formulas, the formulas are displayed and the
command changes to View Data on the Options menu, To display the
calculated values of the formulas again, choose View Data,

The View Formulas and View Data commands affect all cells in the
spreadsheet,

ListFunctions...

The List Functions command displays a list of all the functions offered by
the AppleWorks OS spreadsheet and lets you use this display to add
functions to formulas.

When you choose List Functions, AppleWorks OS displays a dialog box:

Seleot funotion to odd:

Click to select afunction to add-.----+1- noose
to formula nlert(

nnd( 1 Scroll the list to see the
nso( functions
nsin(

Click to close dialog box when you're ~-1:II-;;=-=-=-~(~C~l~OS~e~)~~r-~~n~dd~:O~-~-~-~-==-!J}I-- Click to add selected
finished selecting functions ~ function to formula
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If you want to add a function to a formula, click the function name in
the list (scroll the list, if necessary), then click Add. The function,
followed by an open parenthesis, appears in the active cell. You can also
add a function to a formula by double-clicking the function name in the
list.

You can continue to add as many function names to the formula as you
like. While this dialog box is displayed, you can also enter data into the
active cell by typing on the keyboard. This lets you build an entire
formula quickly and easily, without typing function names and without
exiting the List Functions dialog box.

When you're finished, click Close. The List Functions dialog box
disappears and AppleWorks OS returns ro the document window.

Change Default Width...
The Change Default Width command lets you change the default width
of all columns in the spreadsheet. Initially, the default width is 80 pixels,
approximately one inch.

When you choose Change Default Width, a dialog box appears:

Click In bar Ic "I Dolaull Calumn Widlh

1~!1MW·!.@@Wili.;AWlill¥@!!l@

Drag the vertical bar to increase or ---HI--_J/
decrease the defauit coiumn width ( Cancol) ( OK »
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The entry box graphically displays the current default column width as a
yellow column cell (if you're using a monochrome monitor, the column
cell is displayed as a light pattern). Create a new value for the default
width by dragging the vertical bar on the right side of the yellow bar (as
you would normally drag to manually change the size of a column in the
spreadsheet). Drag the bar to the left to decrease the default column
width; drag to the right to increase the default width. When you've set
the cell to the width you want, click OK. Any columns in the spread
sheet that haven't been manually resized assume the new width.
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Type range lor
horizontal title
area

If you save the spreadsheet after changing the default column width, the
new default width is saved with the document. This command doesn't
change the default column width for any new spreadsheet documents
you create. They still use 80 pixels as the default width.

Use the Restore Width to Default command on the Options menu to set
selected columns (including those that have been resized manually) in
the spreadsheet to the default width.

Restore Width to Default

The Restore Width to Default command sets selected columns in a
spreadsheet to the default column width.

When you begin an AppleWarks OS spreadsheet, the default column
width is 80 pixels (approximately one inch). You can use the Change
Default Width command to change the default width to a new value (see
flChangc Default Width,ll in this chapter for more information).

SetTitles. "

The Set Titles command lets you define areas of a spreadsheet as titles.
Once an area is defined as a title, ies ufrozen" in the document win,
dow-it remains displayed even when you scroll or move to another part
of the document. You can define both rows and columns as title areas.

When you choose Set Titles, AppleWorks OS displays a dialog box:

Set title area:
Click to deline row!s) as title area II D Top titles Rows: [j[] through [I[]

'"'''' ""00 ,",•••,., .. "", .re. -t!1=~~;;L;e:;:;ntc;i:;:e;s;;)~co=l=um=n=s:~f~B~t~h:~:~Ug~h~[];]=dJll ~~:!c~~~~elor

To set aside an area at the top of the document window as a title area,
click Top Titles and type the range of rows for the title area in the Rows
entry boxes. To set aside an area on the left side of the document
window as a title area, click Left Titles and type the range of columns for
the title area in the Columns entry boxes.
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You don't have to choose both top and left title areas and in fact you
may find you do so only rarely; typically you'll find one or the other ap
propriate to rhe task at hand.

Click OK when you've chosen the appropriate settings. The top title
area is defined by a thick horizontal line and the left title area is defined
by a thick vertical line. When you scroll, the title areas remain in the
document window while the rest of the document scrolls by.

Edit fOrBot Option, Doto Wind..

j"t,oore.S, (55)

This v.rticallin. d.fin.s ------I~2E1=:E=+=]A=:c~=I:::I;:::b:I=r=I:::Jr=r::u~
the I.ft titl. ar.a 1

2

This horizontal lin. d.fin.s 1=f:3=l'~--r~--ffim-!ffij:sffimmcir;iLT:w!!!-T!ll!-
the top titl. ar.a

It file Edit foroot Option, Doto Wind..

82 A 8 C 0 £ f G 1J
_____ J.-:-;;I= f.m.g"~.HI'..H.~.1.mB!L L i L .

~I~·~r~~~ ~:: ,?f~~:~~,?i~h~:~~ :~~ I.ft 3 ~Hr SIPmSi'..jomlsj""iiioV'mr"iAY,[RAGr"!U!~!j""iH~~\""""·

won't b. aff.ct.d by scrolling ! iii~r":~: ::::.::::..:::!i:I::::.:::::::.I!::I::::·::::.:::~l:l::::::: ..:..::!:l..I:::::·:::::·t:I.:::::::::::.U:

1:0 ~~fl:~:':~::: ::::::::::::::lll::::::::::::::t!:I:::::::::::U:I::::::::::::::U:I:::::::::::::!::I:::::::::::::U:

!! ~~~~~:~i:i": :·::·:::::·::~:t··I:::::::·::::·~:i::1 .. :::::::::::·I·1··I:·:·····:·:···I:~·I:::::::::::::;::I.::::: ...:.:i:~!:: ~

,0 j"t,oore.S, (55)
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You can change the contents of a title area by selecting and editing the
contents of the cells making up the title.

To remove titles, choose the Set Titles command again and click to
deselect the Top Titles or Left Titles check boxes. When a title check
box is unchecked, that area will not be defined as a title area.

Hide Cell Lines/Show Cell Lines

These commands control whether cell lines are displayed or hidden from
view. Initially, cell Hnes are displayed.

When you choose Hide Cell Lines, all the cell Hnes in a spreadsheet are
hidden and only the contents of the cells are displayed. The command
changes to Show Cell Lines on the Options menu.

Dolo Window

fl9 A 8 C 0 E 0
1 WHEAT TOHHAGE FIRST HALF 1985

Cell lines hidden from document. ---- ~_.

Only values displayed. 3 IDAHO S.OAKOTA H.OAKOTA HISSOURI KAHSAS
4 JAHUARY 75,281 35,145 25,743 30,530 84,210
5 FE8RUARY 70,210 38,254 27,m 55,280 78,520
5 HRRCH 59,371 31,290 23,588 41,250 80,200
7 APRIL 58,597 40,985 25,877 45,980 78,5iD
8 HAY 59,721 51.789 42,551 45,852 75,230
9 JUHE 72,541 53,981 48,359 48,m 84,250

10
II TOTALS 415,721 273,044 194,792 m,m 481,070
12 GRAHO TOTAL FOR SIR HOHTH PERIOD U43,181
13

To restore the cell Hnes to the document, choose Show Cell Lines.

S[Jreadsheet Comman,h 113



Spreadsheet Commands
Data Menu

I, ,

Go to... aG
Sort...
Proteot M
Hew Chort...
Hodifu Chort...

The Data menu contains commands to sort and manipulate the data in a
spreadsheet.

Go To...

The Go To command finds, selects, and displays a specified cell any
where in a spreadsheet.

When you choose Go To from the Data menu, a dialog box appears:

Go to oell

( Conoel ) [ OK ]
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Type the cell number you want to move to, and click OK. AppleWorks
GS scrolls the spreadsheet document to display and select the specified
cell.

Sort...

The Sort command lets you arrange a selection of cells in a spreadsheet
document according to the values in the cells. Text values are sorted
alphabetically, number values in numeric order. If the selection com
bines text and numeric values, the text is sorted alphabetically and
placed at the top of the selection. Numbers are sorted numerically and
placed beneath the text values, followed by cells containing N/A's and
errors (indicated by llError" in recl--or a distinct pattern on a mono~

chrome moniror). Blank cells are displayed at the bottom of the selection.
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When you choose Sort, AppleWorks OS displays a dialog box:

Click to sort in ascending order

Click to sort in descending orde

Sort using which method?
@Ascending @ Rows b~ column

r o Descending o Columns b~ row

Ke~: mc:J--_.- -

( Concel ) [ OK »

Click to sort rows

Click to sort columns

Type a new key cell
value here

AppleWorks OS uses a cell in the selection, called the key cell, as the
basis for the sorting operation. The key cell tells AppleWorks OS which
row or column contains the values that you1n use to sort the selection.
The upper-left cell of a selection is the key cell by default, but you can
type a new key cell value (any cell in the selected range) in the Key Cell
entry box.

Specify whether you want to sort the rows or the columns in the selec...
tion. When you sort the rows in a selection, AppleWorks OS sorts the
values in the column containing the key cell and rearranges the rows in
the selection according to this sorted column.

Rows in a selection before sorting-
the rows will be sorted alphabetically ""-',-
based on the name in column A
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Edil formol Option, 0010 Window

EHPlOYH,SAlARV (SS)

The same rows after sorting-the
rows are now sorted alphabetically---i~9
by name

When you sort the columns in a selection, AppleWorks OS sorts the
values in the row containing the key cell and rearranges the columns in
the selection according to this sorted row.

til fiI. Edil Formol Oplions 0010 Window

;0 EHPlOYH,SAlARV (SS)
HAHE

RonoA Be 0
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Finally, specify whether you want to sort in Ascending or Descending
order. When you click Ascending, text values are sorted in alphabetical
order from A to Z and numeric values are sorted from 0 to 9. If you click
Descending, text values are sorted from Z to A and numeric values are
sorted from 9 to O. For a table showing the order in which text values are
sorted, see appendix C, USort Order for Text/' in this manual.

When you've made the sort settings you want, click OK. The cells in the
selected range are rearranged in the specified order, and all fomulas are
adjusted to accommodate cell dependencies.

Protect

This command controls whether cell protection for a selected group of
cells is turned on or off. When you protect a cell, the contents of the cell
can't be modified or deleted.

When you choose Protect, a check mark (,,) appears beside the com
mand on the menu, indicating that the cells in the current selection are
protected. The contents of the selected cells can't be changed.

To remove cell protection, select the protected cell(s) and choose
Protect again. The check mark is removed and the contents of the cells
can be edited once more.
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New Chart...

The New Chart command generates a chart that graphically represents a
selection of cells. The chart is created as a new AppleWorks OS graphics
document.

Before choosing the New Chart command, select the range of cells you
want to create a chart for. AppleWorks OS generates the chart based on
the column or row selected. If the selection includes both rows and
columns, the chart is based on the uppermost row of cells in the selec
tion. (If you choose more than one row to create the chart, the values in
the extra rows are ignored.)

When you choose New Chart, a dialog box appears:

Pie Chart Bar Chart 3·0imensional line Chart Scatter Chart
Bar Chart

---~-'"

"'() ~ ~ ~ L
[ Range:

CJIFirsteell c:::J Lost Cell
[2J Spaced bars

lues [ Value:

III MaximumIMinimum I ( Cancel )

Chart Nome: ICompon~ IChart 1 I [ OK ]

Type here to change the range
of cells to chart

Click the type of chart--
you want to create

Type minimum and maximum va
for the chart here

Type a name forthe chart here

Click to create spaces
between bars on bar charts

Click the icon that shows the type of chart you want to create.

If you choose the bar chart or 3-dimensional bar chart icons, the Spaced
Bars check box becomes active (otherwise it's dimmed). This check box
controls whether the bars in bar charts are spaced apart or placed
adjacent to one another. It's initially set on.
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For all chart types except pie charts, AppleWorks OS creates the chart
using zero as the minimum value and uses the largest positive value in
the selection as the basis for the maximum value. If you'd like to change
the chart's maximum and minimum values, type the new values in the
Minimum and Maximum entry boxes. Any values less than the new
minimum value will be drawn as if they were negative values (they'll
extend in the opposite direction from the other values in the chart). Any
values greater than the new maximum value will be created in the chart,
but won't be completely visible in the chart's document window. (You
can see values like this if you select and drag them into view.)

Type a name for the new chart in the Chart Name entry box (the default
is "Untitledll

).

When you've made your specifications, click OK. A new graphics
application document window appears on the screen, containing the
specified chart. Since the new window is an AppleWorks OS graphics
document window, you can use the graphics application tools and
commands to modify or enhance the chart and save the document on
the disk as a graphics document.
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Modify Chart...

The Modify Chart command lets you update the contents of a chart to
reflect changes in the original spreadsheet cells. In addition, this
command lets you change the characteristics of a chart-the chart type,
the range, its name, and so on-and delete a chart from a spreadsheet
document.

When you choose Modify Chart, a dialog box appeats:

Click the name of the chart to change -

Click to recalculate chart

CQffiPOny Chort 1

Click to delete chart

[Reoaloulate]

( Delete )

( Change )

( Canoe I )
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Click to change
characteristics of chart

The dialog box contains a list box of the charts associated with the
current spreadsheet document. Scroll, if necessary, to see more names.
Click the name of the chart that you want to change. The Modify Chart
command lets you perform three different operations on the chart:

Recalculate
Click the Recalculate button to update the selected chart with the
current contents of the cell range used to create the chart.

If the graphics document for the chart is still open on the Apple-
Works OS desktop, the chart elements of the document are updated.
Any additional graphics you created in the document after the chart was
generated are left intact.

If the graphics document for the chart has been closed, a new graphics
document is created using the current contents of the chart's cell range.
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Delete
Click the Delete button to delete the selected chart and remove the
spreadsheet's links to the chart's graphics document.

To delete the chart's graphics document from the disk, use the Delete
File command (see "Delete File," in chapter I, "AppleWorks OS Com
mandsll).

Change
Click the Change button ro modify any aspect of the selected chart-the
chart type, the cell range charted, the minimum and maximum values,
and so on.

When you click Change, AppleWorks OS displays the dialog box yOll
used to create the chart. You can make any changes to the chart you
want in the dialog box-you can even rename it. For more information
on the options provided by this dialog box, see C~ew Chart."

Sjmadsheet Commands 121







R
il

n
Ii

II

II

II

I I

II
[I

I I

II

II

U
I]



Gral)hics Commands

File Menu

111m
Hew... 6H
Open... 60
Close 6K
Save 6S
Save As...
Delete file ...
Import file ...
Choose Printer...
POBe Setup...
Print... 6P
PI' ifi ( Hel'~~ ...
Quit 6Q

The File menu in the graphics application lists the same commands as all
other AppieWorks OS applications. See chapter I, "AppleWorks OS
Commands," in this manual for a description of these commands.

Save As ...

The Save As command in the graphics application works the same as in
the other applications, except that the graphics application lets you save
documents with an additional format. In addition to its own format, the
AppleWorks OS graphics application also supports the Apple Preferred
(APF) graphics format.

\Vhen you choose Save As in the graphics application, the Save As
dialog box appears containing the usual options! as well as an additional
setting for saving graphics with the Apple Preferred format. Click this
setting when you want to save a document with the Apple Preferred
graphics format.

® I Hisc.Files I
m free of 800 K. ( Disk )
D llus.nddJ'l~!;sI~1 ~ ( Hew Folder)
D Clien\;.~umbN!;

D CuhisUln(!tl!s I( 011('1\ )
[) G<lml~!;.~(.S~1l

( ctQ!>I! )Lj GQm~s .01\.001lId
D f,h"PI!s D-

]Save ... « Save

IComponu.loBo.l I( Concel )

o Graphics Format @Apple Preferred c-- Click to save with
Apple-preferred format

For information on the other options provided by the Save As com,
mand, see uSave As" in chapter L "Apple\X!orks OS Commands."
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Graphics Commands I~I

Edit Menu

--Undo aZ
Cut aX
Copu aC
Paste aV
Clear
Select All aA
Duplicate aD
Shadow
Begin Hew Paint Object aB
Collapse
Edit Colors...

Objects given drop-shedows -
with the Shadow command
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Several of the Edit menu commands are common to all AppleWorks OS
applications. These include the commands that use the Clipboard
Undo, Cut, Copy, and Paste-as well as Clear and Select All. See
chapter 1, "AppleWorks OS Commands," in this manual for a descrip
tion of the common AppleWorks OS Edit menu commands.

Duplicate

This command makes a copy of a selected object or group of objects,
placing the copy beside the original(s). In effect, Duplicate is a faster and
easier method of copying and pasting within the same graphics docu
ment window.

If no objects are selected, Duplicate is dimmed on the menu.

Shadow
The Shadow command adds a drop shadow to a selected object or group
of objects. The drop shadow is a separate object-a paint object-no
matter how many objects are selected when you choose the Shadow
command or what type of objects they are.

When you choose Shadow, drop shadows appear below and to the right
of each selected object in a document.

If you use the Shadow command with a text object selected, the text
object is given a rectangular drop shadow. You can give drop-shadows to
the individual characters in a text object by choosing the Choose Font
command and clicking Shadow. (See "Choose Font" in this chapter.)

Cha[Jter 5



Begin New Paint Object

The Begin New Paint Object command lets you start a new paint object
while still working with the paint tools.

Ordinarily, all images that you create using the paint tools are defined as
one paint object until you select a drawing or editing tool. Begin New
Paint Object provides a quick method of starting a new paint object
without having to first select one of the drawing or editing tools.

Collapse

The Collapse command combines all the selected objects in a docu
ment-including paint and draw objects-into a single object. Paint
objects are combined into a single paint object, and hidden objects are
removed. Draw objects remain mathematically defined, so they're
printed with their usual high resolution.

Collapsed objects take up much less room in memory than separate or
even grouped objects. For this reason, collapsing objects can lead to
significant memory and speed gains.
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Arrange Mellll The Arrange menu contains commands that allow you to manipulate

objects in special ways. Using these commands you can rearrange, group
or ungroup, flip, and rotate objects in a document.

Bring to Front

Bring to Front is dimmed on the Arrange menu when no objects are
selected.

The Bring To Fronr command moves a selecred object (or group of
objects) in front of all other objects in the document.

If you choose Bring to Front when you've selected several objects that
are stacked on top of one another, the selected objects maintain their
stacked relationship to one another as they're moved in front of the
other objects in the document.

Bring To Front 6+
Send To Bock 6-
Shuff! e Up 6}
Shuffle OO\'ln 6(
Group 6G
Ungroup 6U
Flip Horizontal 6H
Flip Vertical 61
Rotate Left 6L
Rotate Right 6R
Nudge Left 6..
Nudge Right 6..
Nudge Up 61-
Nudge OO\'ln 6~

With the Bring to Front command, you --_/
can move an object to the foreground
from behind another object

Send to Back

The Send to Back command moves a selected object (or group of
objects) behind all other objects in the document.

If you choose Send to Back when you've selected several objects that are
stacked on top of one another, the selected objects maintain their
stacked relationship to one another as they're moved behind the other
objects in the document.

When no objects are selected, Send to Back is dimmed on the menu.
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Shuffle Up

The Shuffle Up command lets you move a selected object (or group of
objects) up one level relative to the other objects in the document.

If you choose Shuffle Up when you've selected several objects that are
stacked on top of one another, the selected objects maintain their
stacked relationship to one another as they're shuffled up in the docu.
ment.

If no objects are selected, Shuffle Up is dimmed on the menu.

Shuffle Down

This command lets you move a selected object (or group of objects)
down one level relative to the other objects in the document.

If you choose Shuffle Down when you've selected several objects that are
stacked on top of one another, the selected objects maintain their
stacked relationship to one another as they're shuffled down in the
document.

When no objects are selected, Shuffle Down is dimmed on the menu.

Group

The Group command lets you group objects together to make a single
object. Use Group when it's more convenient to treat separate objects as
one object.

When you choose Group, all selected objects in a document are grouped
together as a single object, with only one set of object handles. You can
perform any task with the grouped objects that you can perform with a
single object.

Grouped objects can be separated into their component objects with the
Ungroup command.

Group appears dimmed on the Arrange menu if no objects are selected.
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Ungroup

This command separates a group of objects into its component objects.

When you ungroup a group of objects that contains other grouped
objects as components, the component groups remain grouped. To
ungroup these component groups, select each group and choose Ungroup
again.

The Ungroup command remains dimmed when no objects are selected.

Flip Horizontal

The Flip Horizontal command flips a selected object around its vertical
axis. If you choose Flip Horizontal with more than one object selected,
the selected objects are treated as if they were grouped and are flipped
together around their common vertical axis.

An object flipped with the Fiip Horizontal
command. Vou can use this command to
create mirror effects,

This command is dimmed when no objects are selected.
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With the Flip Vertical command, you can
turn objects upside-down

Flip Vertical

The Flip Vertical command flips a selected object (or group of objects)
upside down. If you choose Flip Vertical with more than one object
selected, the selected objects are treated as if they were grouped and are
flipped together around their common horizontal axis.

Flip Vertical is dimmed when no objects arc selected.

Rotate Left

The Rotate Left command rotates a selected object (or group of objects)
90 degrees counterclockwise. You can choose the Rotate Left command
to rotate a selection to the left in 90,degree increments as many times as
necessary to achieve the rotation that you want.

If no objects are selected, this command is dimmed on the menu.

Rotate Right

The Rotate Right command rotates a selected object (or group of
objects) 90 degrees clockwise. You can choose the Rotate Right com·
mand to rotate a selection to the right in 90,degree increments as many
times as necessary to achieve the rotation that you want.

The Rotate Right command is dimmed when no objects arc selected.
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Nudge Left

The Nudge Left command moves a selected object or group of objects
one pixel to the left in a document. You Can choose the Nudge Left
command as many times as necessary to move a selection to a precise
location in a document.

Nudge Left is dimmed on the menu when no objects are selected.

Nudge Right

The Nudge Right command moves a selected object or group of objects
one pixel to the right in a document. You can choose the Nudge Right
command as many times as necessary to move a selection to a precise
location in a document.

Nudge Right is dimmed on the menu when no objects are selected.

Nudge Up

The Nudge Up command moves a selected object or group of objects up
one pixel in a document. You can choose the Nudge Up command as
many times as necessary to move a selection to a precise location in a
document.

Nudge Up is dimmed on the menu when no objects are selected.

Nudge Down

The Nudge Down command moves a selected object or group of objects
down one pixel in a document. You can choose Nudge Down as many
times as necessary to move a selection to a precise location in a docu...
ment.

Nudge Down is dimmed on the menu when no objects are selected.
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Options Menu

Choose Font...
Tools 6T
Potterns 6Y
Grid 68

The Options menu contains commands (or displaying and hiding the
tool and pattern palettes, as well as a command for turning the invisible
alignment grid on and 0((. In addition, the Options menu includes the
Choose Font command for changing the characteristics of text objects.

Choose Font.. ,

The Choose Font command works much the same in the graphics
application as it does in the other AppleWorks OS applications, with
one exception-when you change the font, size, or style of a text object
in the graphics application, all the text in the object is changed. Once
you create a text object, you can't select the text in it. You can, however,
cut it and paste it in a word processing or page layout application
document, edit it, and then copy and paste it back into the graphics
document.

II II

II

Once you complete a text object, you ---
can select it like any other object-and
you can reshape it by dragging its
handies

Before a text object is completed, you
can select the text with the I·beam
pointer

Text Object
"~

For a complete explanation of the options offered by this command, see
uChoose Font" in chapter 1, IIApple\X1orks OS Commands."

Tools

The Tools command controls whether the tool palette is visible in the
document window. When there's a check mark (V) next to the Tools
command, the tool palette is visible. When you choose the checked
Tools command, the check mark is removed and the tool palette dis·
appears from the screen to provide a larger viewing ar~a for the docu...
ment.
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To make the tool palette visible again, choose the Tools command from
the Options menu once more. The tool palette reappears, and Tools is
again checked on the menu.

When you open a new graphics document, Tools is checked and the tool
palette is visible.

Patterns

The Patterns command controls whether the pattern palette is visible in
the document window. When you choose the checked Patterns com'
mand, the check mark (~) is removed and the pattern palette disappears
from the screen to provide a larger viewing area for the document.

To display the pattern palette again, choose Patterns from the Options
menu again. The pattern palette reappears and Patterns is once more
checked on the menu.

When you open a new graphics document) Patterns is checked and the
pattern palette is visible.

Grid

The Grid command controls whether the alignment grid is turned on or
off. The grid is an invisible series of horizontal and vertical lines that you
can use to control the placement of objects. These invisible lines, which
are set apart from each other in 8,pixel increments) can be used to align
objects in a document precisely. When the grid is on, objects that you're
drawing, moving) or reshaping will snap) as if magnetically, to the
nearest grid line.

When checked ("1/), the grid is on. When you choose the checked Grid
command, the check mark is removed and the grid is turned off. To turn
the grid on again, choose Grid from the Options menu again. The grid is
turned on and is once more checked on the menu.

When you open a new graphics document, Grid is off and isn't checked
on the menu.
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The Tool Palette The tool palette contains the tools you use in the graphics application.
To select a toot click the icon for that tool. When you move the pointer
back inside the drawing area of the document window, it assumes a new
shape appropriate to the selected tool.

The graphics application features three sets of tools-editing tools, paint
tools, and drawing tools. The editing tools select, magnify, move, or
erase parts of a graphic. With the paint tools yOli can make paint objects,
graphic objects that contain bitmapped graphics. The drawing tools let
you create draw objects, which are mathematically defined shapes.
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When you click the
paintbrush tool, the
brush shape palette
takes the place of
the line palette
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The tool palette:

The paint tools ~

The drawing tools----

The editing tools---~~

The line palette -~

When using a document window that's
been reduced in size, scroll arrows
appear on the tool palette. Click the

Untitled! (6R)

The shapes you create with the paint tools are comparable to freehand
drawings you might produce with a pen or paintbrush, while the objects
created with the drawing tools are comparable to objects created by
cutting out pieces of paper and combining them to form drawings.
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Paint objects can be more detailed than objects created with the drawing
tools, while draw objects are easier to create and manipulate.

To create a larger drawing area on the screen, remove the tool palette
from the document window by choosing the Tools command from the
Options menu. Choosing Tools from the Options menu makes the tool
palette disappearj to make the palette visible again, choose Tools again.
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The Editing Tools

The editing tools let you perform operations common to both paint and
draw objects-they let you select, move, resize, reshape, magnify, and
erase entire objects as well as portions of objects.

Selection Arrow

Use the selection arrow to select, move, and reshape objects.

Selecting Objects
To select an object, click anywhere on the object with the selection
arrow. Handles appear around the selected object.

You can select multiple objects by holding down the Shift key and
clicking the objects you want to select. If you click a selected object
while the Shift key is held down, the object is deselected.

In addition to this Shift-clicking method, you can also select multiple
objects by clicking in a place in the document window not occupied by
an object and dragging. As you drag, the gray outline of a rectangle
forms. This is called a selection rectangle. To select multiple objects, drag
the selection rectangle over the objects you want to select and release
the mouse button. All objects completely enclosed by the selection
rectangle are selected when you release the mouse button.

If you hold down the Option key while dragging to create a selection
rectangle, any objects even partially enclosed by the selection rectangle
are selected when you release the mouse button.
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If you have a document that contains a lot of objects, you may find
yourself clicking an object in the place where you want to start a select~

ion rectangle, and when you drag, the object is moved and no selection
rectangle is drawn. If you hold down the d key when you start a selec
tion rectangle, AppleWorks OS prevents objects from being selected
when you click them, but still allows you to select objects by drawing a
selection rectangle around them.

Moving Objects
To move an object, click the object with the selection arrow to select it
and, holding down the mouse button, drag the pointer. As you drag, an
outline of the selected object moves with the pointer. \Vhen you've
moved the pointer to the location in the document where you want to
place the object, release the mouse button.

ReshapingJResizing Objects
To reshape or resize an object, click the object with the selection arrow
to select it. Position the pointer on one of the object's handles, and drag
until the object assumes the size or shape you want. Then, release the
mouse button.

In addition to clicking the selection arrow on the tool palette, you can
choose the selection arrow by pressing the space bar. Pressing the space
bar when the selection arrow is selected chooses the previously selected
tool.

Marquee

Use the marquee to make a rectangular selection. The rectangular area
enclosed by the marquee becomes selected and can be moved and
reshaped with the arrow tool. You can also use the Edit menu commands
to cut, copy, paste, and clear a marquee selection, and the Arrange menu
commands to flip, rotate, and nudge a marquee selection.

When you select the marquee, the pointer becomes a crossbar. To make
a selection, move the crossbar to one corner of the rectangular area that
you want to select. Drag the crossbar diagonally across the area you want
to select until a marquee (a dotted rectangle) completely surrounds that
area. Release the mouse button.
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-- ------ ------- - - --I•

Drag the crossbar diagonally
/ across the area you want to select

------------------ +

The marquee remains around the area you've selected and the pointer
changes to the selection arrow whenever you move it into the marquee
selection. This allows you to drag the selection to a new location in the
document. To move a marquee selection, position the selection arrow in
the marquee selection, and drag the marquee selection to the place in
the document where you want to move it, and release the mouse
button. The marquee remains around the selection (indicating that it can
still be dragged, if you wish to move it again). Click anywhere in the
document window outside the selection to end the marquee selection.
The marquee disappears.

If you place the marquee selection on top of another object, any portions
of objects in the selection become separate objects and any white
background enclosed by the selection also becomes a separate object.
Any whole objects enclosed in the selection are simply moved to the
new location.

When you place a marquee selection -~

on top of another object, any white
background enclosed by the selection
becomes a separate object

---------------------,,,,. :

____________________ J

·t·

138 CI"'IJter 5



If you place the marquee selection on a part of the document that
contains no other objects, any white background portions of the selec~

tion disappear. Any portions of objects in the selection become separate
objects and whole objects enclosed in the selection are simply moved.

Holding down the Option key as you drag a marquee selection leaves a
copy of the area enclosed by the marquee behind as you drag.
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Magnifying Glass

Use the magnifying glass to magnify a part of your document to make
smalt precise changes in it.

When you choose the magnifying glass, the pointer change shape to look
like a magnifying glass. Move the magnifying glass to the area of your
document that you want to inspect at higher magnification, and click.
The area you select is magnified 400 percent. Each of the individual dots
making up the graphics in rhe selected area is visible, and can be edited
with any of the other tools. The scroll bars are not active when you're
viewing a magnified document, but you can still scroH a document using
the grabber.

To return to the normal document view scale, select the magnifying glass
again and click inside the document window.

In addition to clicking it, you can also select the magnifying glass by
pressing the Esc key. Pressing Esc when the magnifying glass is selected
chooses the previously selected tool.
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Lasso

Use the lasso to select an irregularly~shapedarea within your document.
Once selected, the irregular area can be moved to another part of a
document. You can also use the Edit menu commands to cut, copy, clear,
and paste a lasso selection and the Arrange menu commands to flip,
rotate, and nudge a lasso selection.

To make a selection with the lasso, choose it from the tools palette.
Position the pointer (which assumes the shape of a lasso) at one corner
of the area containing the graphic(s) you want to select and drag the
lasso in a loop around the graphic(s). As you drag, a dotted loop appears.
When the graphics you want to select are surrounded by the lasso,
release the mouse button. (If you don't close the loop, AppleWorks OS
completes the operation by drawing a straight line between the point
where you release the mouse button and the starting point.)

When you release the mouse button, any objects completely enclosed in
the loop are selected whole, while selected portions of objects become
separate objects. Any white space completely surrounded by an object of
another color is treated as part of the object that surrounds it.

If you place the lasso selection on top of another object, any white
background enclosed by the selection also becomes a separate object. If
you place the lasso selection on a part of the document that contains no
other objects, any white background portions of the selection disappear.

Holding down the Option key as you drag a lasso selection leaves a copy
of the area enclosed by the lasso behind as you drag.
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[I Grabber

Use the grabber to adjust the viewing area of a document. With the
grabber you can scroll horizontally, vertically, and diagonally at once,
whereas the scroll bars only let you scroll in one direction (horizontally
or vertically) at one time.

When you choose the grabber, the pointer changes to a small hand.
Move the grabber to the area you want to move in the document
window, and drag in the direction you want to scroll. The document
scrolls in whichever direction you move the grabber, like a piece of paper
being moved around on a desktop by a real hand.

In addition to clicking it, you can also select the grabber by pressing the
Tab key. Pressing Tab when the hand is selected chooses the previously
selected tool.

Eraser

Use the eraser to erase portions of a graphics document. The eraser can
erase both paint and draw objects, and can be used to remove unwanted
portions of objects. (To delete entire objects, it's usually easier to select
the object and press Delete.)

\Vhcn you choose the craser, the pointer becomes a small, white block.
Drag the eraser over the area you wish to erase. As you drag the eraser, it
erases portions of any graphics in the document that it passes over.

As you drag the eraser over agraphic,--
it erases that portion of the graphic
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The Paint Tools

With the paint tools you create paint objects--detailed freehand
drawings, sketches, and even Ilspray painted" objects. Unlike the drawing
tools, which let yOll create precise individual geometric shapes, the paint
tools are designed for free ...form illustration. As you use the paint tools,
what you paint becomes part of the existing illustration, just as what you
add to a calwas by sketching and applying paint becomes part of a
painting.

When you choose a paint tool and begin to create an illustration with it,
you create a new paint object. Unlike a draw object, which is completed
when you release the mouse button, a paint object continues as long as
you're using paint tools (or until you choose the Begin New Paint Object
command-see flBegin New Paint Object/' in this chapter). For ex...
ample, you might sketch a freehand shape with the pencil, then paint
over it with the paintbrush, shade it with the spray paint can, and
perhaps fill in parts of it with the paint bucket. Unless you choose a
drawing or editing tool, everything you draw with the paint tools will be
a single paint object. That's why it's helpful to think of the document
window as a canvas when you're using the paint tools-when you're
working on a paint object, the document window seems just like an
electronic canvas!

Paintbrush

The paintbrush lets you paint on the graphics area with broad strokes,
like a paintbrush on a canvas.

When you choose the paintbrush, the area beneath the tool palette
changes from a line palette to a brush shape palette (sec IlLinc Palette"
and "Brush Shape Palette," in this chapter). Select the shape of the
brush you want to use by clicking the desired shape in the brush shape
palette. The pointer assumes the brush shape you select.

If the brush shape you want to use isn't visible on the shape palette, click
the right or left arrow at the bottom of the palette to see other available
brush shapes. You can also display alternate brush shape selections by
clicking in the brush shape palette and dragging the pointer out into the
document window; the palette will scroll until you release the mouse
button.
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Aftet choosing a brush shape, click the colot ot pattern that you want to
use in the pattern palette at the bottom of the document window (see
lIPattern Palette," in this chapter). If you want to use a pattern that isn't
visible on the cutrent palette, click the left or right scroll arrows on
either side of the patterns to see other pattern selections.

To paint with the brush, drag it in the document window as you would a
paintbrush on a canvas or sheet of drawing paper. As you draw, graphic
ustrokes" appear on the screen with the brush shape and pattern that you
selected. Each new shape you draw becomes part of a single paint object
until you select a drawing or editing tool or choose Begin New Paint
Object from the Edit menu.

To stop painting with the paintbrush, release the mouse button.
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Pencil

Use the pencil to create thin freehand lines and to edit precisely the
small dots ot pixels that make up a graphic.

When you select the pencil, the pointer changes to look like a pencil. If
you wish, choose a new pattern from the pattern palette. Sketch with the
pencil by dragging it in the document window as you would a pencil or
pen on a sheet of drawing paper. As you drag the pencil, it creates a thin
line (finer than any of the paintbrush shapes) using the color pattern
that you selected. To stop drawing the line, release the mouse button.
Repeat this procedute to draw whatever freehand shapes and lines you
like.

Each new image you sketch with the pencil becomes part of a single
paint object until you select a drawing ot editing tool ot choose Begin
New Paint Object from the Edit menu.

In addition to creating thin freehand lines, the pencil is useful for fine
editing of graphics, especially when a graphic has been magnified with
the magnifying glass. You'll want to keep in mind, however, that
whenever you're drawing with the pencil you're working on a new object
(unless you've selected the object yOll want to modify first), not modify
ing an old one. For this reason, pencilling in white is not usually the
same as using a very fine eraser, as it is on some graphics programs for the
Apple lias; instead, you're creating a new white object.
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To touch up an object with the pencil, first select the object. Any paint
objects you create will then be automatically grouped to that object,
making touch...up work easier.

Paint Bucket

The paint bucket lets you fill any bounded area (any area enclosed by
pixels) in the document window with a pattern. If you're working on a
paint object, the filled-in area becomes part of your painting. If you were
previously working with a drawing or editing tool, or just chose Begin
New Paint Object, the filled-in area becomes its own paint object.

If you're working on a paint object and don't choose Begin New Paint
Object before using the paint bucket, what you add with the paint
bucket is added to the paint object. If an object is selected when you use
the paint bucket, the new paint object is automatically grouped with the
object.

Use the paint bucket to fill bounded areas in a document that are not
themselves objects-the intersection of two circles, for example. Because
the filled-in area becomes its own object, the paint bucket isn't generally
used to fill shapes that are already objects (rectangles, ovals, polygons,
closed freehand paint objects, and so on). To change the fill pattern of
an object, select the object and click the appropriate color or pattern on
the pattern palette.

When you choose the paint bucket, the pointer changes to a paint
bucket. Choose the fill pattern you wish to use from the pattern palette.
Position the tip of the paint bucket (the paint spilling out of the bucket)
inside the area you want to fill, and click the mouse button. The selected
pattern fills the shape.

t\----.. Position the tip of the paint bucket
inside the area you want to fill and
click the mouse button
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If the area that you fill is not completely enclosed-if it has any opening,
even one the size of a pixel-the pattern will spill outside the shape into
surrounding areas. This will not occur if you're filling areas completely
bounded by objects drawn with the drawing tools---<lraw objects are
always completely enclosed. On the other hand, you can create shapes
with the paint tools that appear to be enclosed but which are in fact not
completely enclosed.

To avoid spilling paint outside the shape, examine an area painted with
the pencil or paintbrush before using the paint bucket on it. Use the
magnifying glass for a dose.. up examination, if necessary. If you see any
open spaces or breaks in the border of the area, use the pencil or paint~

brush to fill in the breaks before using the paint bucket.

If you do spill paint in the wrong area, choose Undo Paint from the Edit
menu.
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Spray Can

The spray can lets you spray dots of the current pattern in a document.

When you select the spray can, the pointer changes to a group of dots.
Choose the pattern you wish to use from the pattern palette. Position the
pointer at the place in the document where you want to begin spraying
and hold down the mouse button. A random stream of dots appears in
the general area covered by the pointer. The pattern produced by the
spray can gets darker the slower you drag the spray can-simulating the
effect of a real can of spray paint.

To stop spraying, release the mouse button.
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The Drawing Tools

The drawing tools are used for creating lines, text, and regular geometric
shapes-ovals, recrangles, polygons, and rounded rectangles. Unlike the
paint tools, which are designed for freehand drawing, the drawing tools
let you draw exact and regular shapes, as well as shapes that inlcude a
number of straight lines and angles.

When you create a paint object, any additional use of a paint tool adds
to that paint object, until you choose an editing or drawing tool or
choose the Begin New Paint Object command. When you create a dtaw
object, on the other hand, the object is complete and sepatate from
other objects as soon as you release the mouse button. (You can attach
objects together with the Group command, howeverj see lIGroup/' in
this chapter.)

TextTool
Use the text tool to add text to a graphics document.

When you choose the text tool, the pointer becomes shaped like an 1
beam. Position the I-beam where you'd like to place text and click. A
blinking vertical bar called the insertion point appears. When you type
text, it appears at this point.

When you're creating a text object, you can only type one line of text,
but you can edit the text as you would in any of the other applications
text can be selected, replaced, cut, copied, and deleted.

Text may wrap down when -~

you resize a graphic •

•

•
Complete a text object by pressing Return, by selecting another tool, or
by clicking outside the text object. Once a text object has been com
pleted, it can no longer be edited as text. Instead, the text is treated as
an object, and you can edit it as you would any dtaw object-it can be
selected, moved, reshaped, and changed with commands from the
menus. Text may Wtap when you reshape a text object.
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HorizontalNertical Line Tool

Use the horizontal/vertical line tool to draw straight horizontal and
vertical lines (lines parallel to the edges of the document window). You
can draw vertical or horizontal lines with any of the line widths in the
line palette (except the broken line) and with any of the patterns in the
pattern palette (see UUnc Palette" and "Pattern Palette»,' in this chapter
for information on line widths and patterns).

When you choose the horizontal/vertical line tool, the pointer changes
to a crossbar. Click the line width you want to use from the line palette
and the pattern you want from the pattern palette. Position the crossbar
at the place in the document where you want to begin the line, and drag
the crossbar to draw the line. You'll see a line stretch between the
starting point and the horizontal or vertical position of the crossbar as
you draw. (Because the line will be either horizontal or vertical, the
pointer may be disconnected from the actual endpoint of the line as you
draw.) Release the mouse button to complete the line.

Line Tool

Use the line tool to draw straight lines in a document. The line tool lets
you draw vertical, horizontal, or diagonal lines with any of the line
widths in the line palette (except the broken line) and with any of the
patterns in the pattern palette (see {jUne Palette" and "Pattern Palette"
in this chapter for information on line widths and patterns).

When you choose the line tool the pointer changes to a crossbar. Click
the line width you want to use from the line palette and the pattern you
want from the pattern palette. Position the crossbar at the place in the
document where you want to start the line. Drag the crossbar until you
reach the place where you want to end the line. A line appears between
the starting point and the position of the crossbar as you draw. When
you've positioned the crossbar on the spot where you want the line to
end, release the mouse button to complete the line.

You can constrain a line to either a 45.degree angle or 90·degree angle
by holding down the Shift key as you draw it.
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Rectangle Tool

Use the rectangle tool to draw rectangles and squares.

When you choose the rectangle tool, the pointer becomes a crossbar.
Click the appropriate line width in the line palette to use for the borders
of the rectangle. Choose a fill pattern for the interior of the rectangle
and a line pattern for the border of the rectangle from the pattern
palette. To create a hollow rectangle, click None as the fill pattern. To
make a rectangle with no border, click the broken line in the line
palette.

Position the crossbar at the place in the document where you want to
start the rectangle and drag diagonally to the place where you want the
opposite corner. As you drag, the outline of a rectangle appears. Release
the mouse button to complete the rectangle.

If a pattern other than None is selected, the rectangle is filled with the
pattern when you release the mouse button.

To create a square, hold down the Shift key as you draw.

Rounded Rectangle Tool

Use the rounded rectangle tool to draw rectangles and squares with
rounded comers.

When you choose the rounded rectangle tool, the pointer becomes a
crossbar. Click the appropriate line size in the line palette to use for the
borders of the rounded rectangle. Choose a fill pattern for the interior of
the rounded rectangle and a line pattern for the border of the rounded
rectangle from the pattern palette. To create a hollow rounded rectangle,
click None as the fill pattern. To make a rounded rectangle with no
border, click the broken line in the line palette.

Position the crossbar at the place in the document where you want to
start a corner of the rounded rectangle and drag diagonally to the place
where you want the opposite comer. As you drag, a rounded rectangle
appears. Release the mouse button to complete the rounded rectangle.
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If a pattern other than None is selected, the rounded rectangle is filled
with the pattern when you release the mouse button.

To create a rounded square, hold down the Shift key as you draw.
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Oval Tool
Use the oval tool to draw ovals and circles.

When you choose the oval tool, the pointer becomes a crossbar. Click
the appropriate line width in the line palette for the oval's border.
Choose a fill pattern for the interior of the oval and a line pattern for the
border of the oval from the pattern palette. To create a hollow oval,
click None as the fill pattern. To create a borderless oval, click the
broken line in the line palette.

Position the crossbar at the place in the document where you want to
start the oval and drag dIagonally to the place where you want the
opposite side. As you drag, the outline of an oval appears. Release the
mouse button to complete the oval.

When youlve created the oval you want, release the mouse button to
complete the object. The oval is drawn with the selected line width and
filled with the selected pattern.

To create a circle, hold down the Shift key as you draw.
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Arc Tool

Use the arc tool to draw 90-degree arcs (which may be thought of as
quarter-ovals).

When you choose the arc tool, the pointer becomes a crossbar. Click the
appropriate line width in the line palette to use for the arc's border.
Choose a fill pattern for the arc and a line pattern for the border of the
arc from the pattern palette. To create a hollow arc, click None as the
fill pattern. To create a bordedess arc, click the broken line in the line
palette.

Position the crossbar at the place in the document where you want to
start the arc and drag diagonally to the place where you want to end the
arc. As you drag, the outline of the arc appears.

When you've positioned the crossbar on the spot where you want the arc
to end, release the mouse button to complete the arc. The arc is drawn
with the selected line width and the area defined by the arc is filled with
the selected pattern. The direction the arc faces is determined by the
direction in which you drag to create it.

To create a quarter-circle, hold down the Shift key as you draw with the
afC tool.
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Click to begin the polygon -------
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Polygon Tool
Use the polygon tool to draw polygons of any shape and with any
numbet of angles.

When you choose the polygon tool, the pointet becomes a ctossbat.
Click the apptoptiate line width in the line palette to use fot the
polygon's botdets. Choose a fill pattern for the polygon and a line
pattern for the border of the polygon ftom the pattern palette. To create
a hollow polygon, click None as the fill pattern. To make a polygon with
no botder, click the btoken line in the line palette.

Position the ctossbar at the place in the document where you want to
start the polygon and click. Without holding down the mouse button,
move the mouse to draw a line. When the ctossbar reaches the place
where you want the line to end, click again to complete the line. As you
move the crossbar again, a line stretches from the endpoint of the first
line to the current location of the crossbar, forming the first angle of the
polygon.

Each time you click. you
specify a new vertex and
start a new line

When the ctossbar reaches the place where you want the second line to
end, click again. Continue clicking the mouse at any point where you'd
like to create a vertex until you've drawn the polygon you want.

To complete the polygon, click the starting point, double.click any
point, ot click outside the document window. The polygon is drawn
using the selected line width and filled with the selected pattern.

To constrain the lines of the polygon to 45.degree or 90·degree angles,
hold down the Shift key as you draw.
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The Line Palette
The line palette lets you choose lines from a predefined set of line
widths. These line widths determine the thickness of lines you'll draw
with the line tools as well as the width of the borders of draw objects.

You can choose line widths from the line palette when you're working
with any of the tools except the paintbrush. (The line palette changes to
the brush shape palette when you choose the paintbrush.) However, the
line widths only apply when you're using one of the drawing tools.

To choose a line width, click the desired line width in the palette. The
new line width, which is checked on the line palette, replaces the
current line width for any currently selected lines and draw objects. The
box on the left side of the pattern palette changes to reflect the new line
width.

To create objects without borders, select the broken line at the top of
the line palette. When you click the btoken line-for zero line width
the line tool and the horizontalfverticalline tool are deactivated.
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The Brush Shape Palette
When you choose the paintbrush tool, the brush shape palette replaces
the line palette in the lower-left corner of the document window. The
brush shape palette lets you choose the shape of your paintbrush from a
predefined set of shapes. When you select one of the brush shapes, you
determine the size and shape of the pointer used when you paint in the
document with the paintbrush.

To choose a brush shape, click the desired shape in the palette. The new
brush shape, which is checked on the line palette, replaces the current
shape.
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rji1IIID The Pattern Palette
~

The pattern palette provides the different line and fill colors and
patterns used for creating and editing paint and draw objects.

The pattern palette is divided into two portions. The le(t side of the
palette contains sixteen solid colors and the empty (None) pattern,
which are always available. These solid colors include black, white, the
empty pattern and 14 other colors. If you select one o( these colors as
your (ill pattern, your objects will be filled with that color. If you select
IfNone ll as the pattern used to fill an object, the object becomes transpar~

cot, and any object underneath it can be seen.

To choose a fill pattern, click the desired pattern. To choose a line
pattern, hold down the Option key as you click the pattern you want to
use. When the selection arrow is active, choosing a new line or fill
pattern changes the line or fill patterns o( any objects that happen to be
selected.

The current fill and line patterns- ---- lEill ",

Click here to choose a color,--_/
black or white, or None (no
color or pattern)

-- Click here to choose a
pattern for borders or fill

When you select the paintbrush, pencit or spray can, the fill pattern is
used as the pattern with which lines are drawn. When yOll use the paint
bucket or any of the drawing tools, the fill pattern is used to fill the
inside part of an object, while the line pattern is used for draw object
borders and (or lines drawn with the line tools. The pattern does not
appear until the object is completed.

The line pattern is used (or lines created with the line tool and (or the
borders o( shapes created with the other drawing tools (with the excep
tion of text, which is always a solid color with any pattern as back,
ground).

A note about None ..• Choosing None as a line pattern produces the
same effect as clicking the broken line in the line palette. When you
choose None, the line tool and horizontal/vertical line tools are dis
abled, and any draw objects you create are borderless.
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Page Layout Commands

File Menu

Hew... 6H
Open... 60
Close 6K
Sove 6S
Sove Rs...
Delete File .
Import File .
Choose Printer...
Poge Setup...
Print... 6P
Pl'lnt Hel'g~ ...
Quit 6Q

The standard File menu commands----<:ommon to all the AppleWorks
OS applications-are described in chapter 1, "AppleWorks OS Com
mands." The Print Merge command is only available in the word
processor, so that command is dimmed on the File menu. The Import
File command works a bit differently in the page layout application than
in the other applications, so additional information on that command is
provided here.

Import File...

In the other AppleWorks OS applications, Import File lets you insert the
contents of a document on the disk into another document that's already
open on the AppleWorks OS desktop. For example, in the word proces
soc, Import File inserts text from another document into the current
word processing document at the insertion point. In the graphics
application, on the other hand, Import File places the graphics from
another document in the center of the current graphics document
window. Because page layout lets you manipulate both text and graphics,
the Import File command in page layout lets you import the contents of
documents in a variety of ways.

When you choose Import File in the page layout application, the usual
Import File dialog box appears, containing a list of documents on the
current disk. Because page layout involves combining graphics and text,
however, the dialog box contains the names of both graphics and word
processing documents. You can import AppleWorks OS, AppleWorks,
ASCII text, and MultiScribe OS word processing documents into the
page layout application. You can also import all Apple IIos standard
format (APF, PNT, PICT) graphics documents into the page layout
application. This includes documents from the AppleWorks OS graphics
application, PaintWorks Plus, PaintWorks Oold, and Deluxe Paint n.

Click the name of the document you wish to open from the list, and
then click Open (or double-click the name in the list). To open a
document on a different disk, click Disk.
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Page Layout Commands
Unless the insertion point is selected in a text object, the pointer
changes shape to indicate the type of document you've imported (the
pointer changes back to an arrow when you move it out of the page
layout area). This lets you place rhe contenrs of the imported document
anywhere on any page of the document by just pointing and clicking.

Pointer shapes used for importing

[-1

Document type:

Text

Oraphics

Pointer:

r::E"
I:··~':.'

Formats can include:

AppleWorks OS word processing,
AppleWorks word processing,
MultiScribe OS, ASCII text

AppleWorks OS graphics, Apple
Preferred Format (APF), Paint
(PNT), PICT, Screen (320 and 640)
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Importing Text
If you're importing text, you're given the option of placing the contents
of the imported document into a document in one of two ways. If you've
selected text or the insertion point in a text object using the text tool,
the text is inserted directly into that text object, as if you had pasted the
text into the object from the Clipboard (or imported a word processing
document into the document window in the word processor).

If you haven't selected the insertion point in a text object, the pointer
changes shape when you click Open to indicate that you've imported a
text document, but haven't yet placed it. To place the document,
position the pointer at the location on the page where you want the
contents of the document to appear and click. A new text object appears
within the margin and column guides on the page. (You can also drag
the pointer to create a text object of any shape and size, overriding the
margin and column guides.)

Importing Graphics
When you import a graphic into the page layout application, the pointer
changes shape when you click Open to indicate that you've imported a
graphic, but haven't yet placed it. To place the graphic, position the
pointer at th~ location on the page where you want the graphic to appear
and click (you can also drag, but this distorts the graphic). The graphic
appears at the place you click. Four handles appear on the graphic, indi
cating that it's selected.
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Edit Menu

Undo 6Z
Cut 6X
Copu 6C
Poste 6V
Cleor
Be lect R11 6R
Duplicote 6D
Insert Poge(s) .
Delete Page(s) .

The standard Edit menu commands (Undo, Cut, Copy, Paste, Clear) are
described in chapter 1, "AppleWorks OS Commands." The Edit Colors
command, on the Color menu of the page layout application but on
different menus in other applications, is described in {(Other Common
AppleWorks OS Commands ," also in chapter 1.

While the Select All command is a command common to the other
applications and therefore covered in chapter 1, it works differently in
different situations in the page layout application, depending on whether
you're editing text with the text tool or working with objects, so addi...
tional information is provided here.

Select All

The Select All command selects all the text in the current text stream or
all the objects on a page.

If you're using the text tool to edit a text stream when you choose Select
All, the entire stream is selected, regardless of whether all the text is on
one page or continued over several pages.

If you're using any of the other tools, all the objects on the current page
are selected, including text objects.

Duplicate

This command makes a copy of a selected object or group of objects,
placing the copy beside the original(s).

If no objects are selected, Duplicate is dimmed on the menu.
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Insert Pages...

This command lets you insert a specified number of new pages into a
document at the beginning or end of the document, or after the current
page.

\Vhen you choose Insert Pages, a dialog box appears:

Click to specify where to insert ------ifl--i
the new pages

Type the number of new pagesto insert --li;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;~,;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;i1
Insert~ page(s)

- 0 at the beginning.
@after the current page.

__ 0 at the end.

(Cancel) [ OK ]

When you click OK, the new pages are added to the document. The new
pages are numbered according to the page number of the page immedi,
ately preceding them, and all pages following the new pages are appropri
ately renumbered.

When you add an odd number of pages to a page layout document using
facing pages, right-hand pages become left-hand pages, and vice versa.
Keep this in mind when planning your documents.

If you've added items to the master pages, AppleWorks OS applies those
master items to the new pages. New icons are added to the page icons at
the bottom of the document window (as are scroll arrows, if the addi
tional new pages cause the total number of pages in the document to
exceed five). The page icon of the first new page is selected, indicating
that the first of the new pages is the new current page.

The maximum number of pages in one document is 99.
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(Cancel)

Delete Pages ...

The Delete Pages command deletes a specified range of pages-and
everything on those pages-from a document.

When you choose Delete Pages, a dialog box appears:

Delete pages

Type the page number of the first page -+I-----[[] through [J----I+-- Type the page number of the
to delete last page to delete

[ OK ]

Use the entry boxes to type in the page numbers for the range of pages
you want to delete. (To delete a single page, type the page number of
that page in both boxes.) When you click OK, all the pages in the
specified range are deleted from the document. All pages following the
last deleted page are renumbered, and any text on pages before and after
the deleted pages is automatically relinked.

When you delete an odd number of pages from a page layout document
using facing pages, right-hand pages become left-hand pages, and vice
versa. Keep this in mind when planning your documents.

If you'd like to delete the contents of the pages but not the actual pages,
select the contents of each page with Select All, and press Delete or
choose Clear from the Edit menu.

After the specified pages are deleted, the numbered page icons at the
bottom of the screen change to reflect the current number of pages in
your document.

.., Warning: You can't undo page deletions. Be careful when you use this

command.
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Options Mellu

Fit in Window oW
Hide Tools
Hide Rulers
Hide Guides
Set Guides ...
lock Guides
Hagnetic Guides
Go to page ... oG
Set First Page ...
Ignore Hoster Page
left/Right Hoster Pages
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The Options menu contains a variety of commands for viewing docu~

ments and formatting pages.

Fit in Window/Actual Size

These commands control the relative size of a page in a page layout
document. The Fit in Window command reduces the current page in size
so that an entire page can be viewed at once. The Actual Size command
returns the reduced view of the page to its actual size-the size of the
page when printed. When you create a new document, the document is
actual size and Fit in Window appears on the menu.

When you choose Fit in Window, the current page is reduced in size
until it fits inside the document window and the command changes to
Actual Size on the Options menu. If you resize the document window
while Fit in Window is selected, the page is teduced or enlarged to
always fit within the dimensions of the resized window. The scales on the
rulers arc also adjusted to reflect the reduced page size, and you can use
any of the drawing tools (see "The Tool Palette," in this chapter). You
can also create, resize, and reshape text objects, but you can't edit text.

To return to the original full-size view of the page, choose Actual Size
ftom the Options menu. The page and rulers are again displayed at actual
size, and the Actual Size command is replaced on the Options menu by
the Fit in Window command.

Hide Tools/Show Tools

The Hide Tools command removes the tool palette from the document
window to provide a larger working area for the document. The Show
Tools command returns the tool palette to the screen.

When you choose Hide Tools, the tool palette is no longer visible on the
left side of the document window, and the Show Tools command
replaces Hide Tools on the Options menu. The current page is moved to
the left on the window, and a larger working area is visible.

To return the tool palette to the screen, choose Show Tools from the
Options menu. The tool palette reappears, the working area is reduced in
size, and the Show Tools command is again replaced by Hide Tools on
the Options menu.
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Hide Rulers/Show Rulers

These two commands control whether or not rulers are displayed in the
document window. The Hide Rulers command removes the rulers from
the window to provide a larger working area for the document. The
Show Rulers command returns the fulers to the screen.

When you choose Hide Rulers, the rulers are removed from the top and
left side of the document window, and a larger working area is visible.
The current page is moved up and to the left of the document window,
and the Show Rulers command replaces Hide Rulers on the Options
menu.

To return the rulers to the screen, choose Show Rulers from the Options
menu. The rulers reappear, the working area is reduced in size, and the
Show Rulers command is again replaced by Hide Rulers on the Options
menu.

Hide Guides/Show Guides

These two commands control whether or not the dotted lines that
represent guides are displayed in the document window. The Hide
Guides command removes guides from the document window. (Hide
Guides also removes the effects of magnetic guides if you have Magnetic
Guides chosen.) Since the dotted guide lines are not printed when you
print a document, you can use this command to see your document on
the screen as it will appear when printed. Show Guides returns the
guides to the document window.

When you choose Hide Guides, the Show Guides command replaces
Hide Guides on the Options menu. Choose Show Guides to return the
guide lines to the screen. The dotted lines reappear, and Show Guides
again changes to Hide Guides on the Options menu.
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Set Guides

The Set Guides command lets you add column guides to a page, specify
the space between columns, and create guides for the left, right, top, and
bottom margins of a page. Set Guides provides a quick, easy, and
accurate method for setting up uniform margins and columns.

If the current page is a master page, the column and margin guides you
specify appear on every page in the document. Otherwise, your settings
are used for the current page only. (For morc information on using
master pages, see ltLeft/Right Masters/Single Master Page" and liThe Page
Icons" in this chapter.)

When you choose Set Guides, a dialog box appears:

Left I Right Hargins
@0.25inch
00.5 inch
o I!I!J Iinch

Top I Bottom Hargins
@0.25inch
00.5 inchOm inch

( Cancel)

Columns
@i
02Om

Column Spacing
@0.25inch
00.5 inchOm inch

[ OK ]
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Left/Right Margins
This option lets you specify where left and right margin guides are placed
on the current page. Click to select one of the predefined settings, or
type your own custom setting in the entry box.

Top/BoUom Margins
This option lets you specify where top and bottom margin guides are
placed on the current page. Click to select one of the predefined settings,
or type your own custom setting in the entry box.
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Columns
The Columns option lets you specify the number of columns you want
on the current page. Click to choose one of the predefined column
settings, or type your own custom setting (up to nine columns) in the
entry box.

Column Spacing
This option lets you set the amount of space between columns on the
current page. You can create spaces between columns that vary in size
from a fraction of an inch to the entire page width (depending on the
number of columns on the page). Click to select one of the predefined
column spacing settings, or type your own custom settings in the entry
box.

Lock Guides/Unlock Guides

These commands control whether or not guides are locked in place at
theif current positions in a document.

When you choose Lock Guides, all column, margin, and ruler guides in
the document are locked in place and the command changes to Unlock
Guides on the menu. Use this command to prevent accidental reposi...
tioning of guides in a document.

To unlock locked column and ruler guides, choose Unlock Guides. The
Unlock Guides command is replaced by Lock Guides on the Options
menu.

Nole: The Set Guides command lets you change margin and column

guides even if they are locked.

Page Lo.)'out Commands 167



Page Layout Commands
Magnetic Guides

The Magnetic Guides command makes the column, rulef, and margin
guides in a document attract text and graphic objects.\Vhenevcr you
move a text or graphics object within range of a magnetic guide (within
four vertical pixels or eight horizontal pixels), the object is drawn to and
aligned with the guide. Objects are also attracted to magnetic guides
when you're first creating them or when you're resizing them (existing
objects arc not affected unless they're moved or resized).

Use the Magnetic Guides command when you want to place objects
quickly and precisely. When the Magnetic Guides command is chosen,
you can align any edge of an object with any guide in a document.

When you choose Magnetic Guides, the command is checked on the
Options Menu. When you want to align objects without the assistance of
magnetic guides, choose Magnetic Guides again and the check mark is
removed.

Go To Page...

The Go To Page command displays a specified page in your document.

When you choose the Go To Page command, a dialog box appears:

Go to poge [[]

(Conoel ) [ OK »
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Use the entry box to type in the number of the page you want to display,
and click OK. The page you specify is displayed as the current page, atld
its icon is selected at the bottom of the screen.

If you specify a page number smaller than the number of the first page in
the document, AppleWorks GS displays the first page in the document.
AppleWorks GS displays the last page in a document when you specify a
page number greater than the number of the last page.
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Set First Page...

The Set First Page command lets you specify the page number for the
first page in a document. You can specify any number from zero to 999 as
the first pagci however, the page icons only display two digit characters,
so the leftmost digit of any number greater than 99 is not displayed
(when you specify 99, for example, subsequent pages are displayed as
1'01/' H02," etc., in the page icons and numbered ulOl," 11102/' and so
on). Use this command when you're creating a document that's a part of
a larger work and requires an initial page number other than one.

When you choose the Set First Page command, a dialog box appears:

First page number: [[]

(Canoel) [ OK ]

Type the new first page number in the entry box and click OK. The page
number that you specified is used for the first page, and all subsequent
pages are automatically renumbered. The page icons at the bottom of the
document window change to reflect the new page numbering.

Ignore Master Page/Use Master Page

These commands control whether master page items are used to format
the current page. Ignore Master Page removes all master page text,
graphics, and guides from the current page. The Use Master Page
command returns to the current page all items on the Master Page.
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Left/Right Master Pages/Single Master Page

These commands control whether a document uses left and right master
pages or a single master page. The master pages contain text, graphics,
and guides that you want automatically repeated on every page in a
document.

The Left/Right Master Pages comrnand lets you create two master pages,
one for the left-hand pages in the document and one for the right-hand
pages. The Single Master Page command creates one master page that
applies to all pages in the document.

Usc left and right master pages when you want to add master page items
that should appear in different places on facing pages when the docu
ment is printed-binding margins and outside page numbers, for ex~

ample.

\Vhen you create a new page layout document, a single master page is
available, indicated by the page icon labeled M in the lower-left corner
of the document window.

Master page icon -- _ ..~---_. Page icons

When you click the M page icon, the master page appears in the
document window. Any text, graphics, or guides you place on this page
automatically appear on all other pages in the document. (You can
remove master page items from a page with the Ignore Master Page com...
rnandj see llIgnore Master Page.")

When you choose the Left/Right Master Pages command, two master
page icons appear in the lower... left comer of the document window (and
the command changes to Single Master Page on the menu). One page
icon is labeled L, and its upper-left comer is turned down. The other
page icon is labeled R, and its upper-right corner is turned down.

Left/right master page icons -_..-.
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When you click the L page icon, the left master page appears in the
document window. Any text, graphics, or guides you place on this page
automatically appear on all left-hand pages in the document. When you
click the R page icon, the right master page appears in the document
window and all text, graphics, or guides you place on this page automati,
cally appear on every right-hand page in the document.

If you've previously created a single master page for a document and then
choose Left/Right Master Pages, the master page items for the single
master page are automatically transferred to the right master page, and
the left master page is blank.

If you've already created a left master page and then choose Single
Master Page, all items on the left master page arc deleted.
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Page Layout Commands
Arrange Menu

Bring to Front (\+

Send to Bock (\
Flip Horizontol
Flip Verticol
Rotate left
Rotote Right

The Arrange menu contains commands that allow you to manipulate the
elements of a page layout document in special ways. Using these com
mands you can rearrange, flip, and rotate objects in a document.

Note: Text objects can be flipped and rotated, but the text in the text

object is unaffected by the operation.

Bring to Front

The Bring to Front command moves a selected object (or group of
objects) in front of all other objects in the document.

If you choose Bring to Front when you've selected several objects that
are stacked on top of one another, the selected objects maintain their
stacked relationship to one another as they're moved in front of the
other objects in the document.

/ • •
The Bring to Front command lets you ~.... _.__._....~.•••.
move one object in front of another. An opple 0 doy keeps the doctor owoy,

~ b~t 0 burger 0 doy ~~~DS hU~~ boy.
- .0~:,~:.>, ,.-.

•

Bring to Front is dimmed on the Arrange menu when no objects are
selected.
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Send to Back

The Send to Back command moves a selected object (or group of
objects) behind all other objects in the document.

If you choose Send to Back when you've selected several objects that are
stacked on top of one another, the selected objects maintain their
stacked relationship to one another as they're moved behind the other
objects in the document,

When no objects are selected, Send to Back is dimmed on the menu.

Flip Horizontal

The Flip Horizontal command flips a selected object (or group of
objects) around its vertical axis. If you choose Flip Horizontal with more
than one object selected, the selected objects are treated as if they were
grouped and are flipped together around their common vertical axis.

Use the Flip Horizontal command--
to create mirror images of objects

This command is dimmed when no objects are selected.
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Flip Vertical

The Flip Vertical command flips a selected object (or group of objects)
upside down. If you choose Flip Vertical with more than one object
selected, the selected objects are treated as if they were grouped and are
flipped together around their common horizontal axis.

Use the Flip Vertical command to turn
an object upside-down
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Flip Vertical is dimmed when no objects are selected.

Rotate Left

The Rotate Left command rotates a selected object (or group of objects)
90 degrees counterclockwise. You can choose the Rotate Left command
to rotate a selection to the left in 90,degree increments as many times as
necessary to achieve the rotation that you want.

If no objects are selected, this command is dimmed on the menu.

Rotate Right

The Rotate Right command rotates a selected object (or group of
objects) 90 degrees clockwise. You can choose the Rotate Right com·
mand to rotate a selection to the right in 90,degree increments as many
times as necessary to achieve the rotation that you want.

The Rotate Right command is dimmed when no objects are selected.
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Text Menl!

{Left
Center
Right
full

{Single Space
1-1/2 Space
Double Space
Set Spacing '..

Left-aligned text --

Centered text

Right-aligned teX! ---

Justified text

The Text menu contains commands for changing the alignment and line
spacing of text. These commands apply to the paragraph containing the
insertion point or to all the paragraphs in a selection.

The first four commands on the menu control text alignment for the
selected paragraph(s) or for the paragraph you're currently editing,

There are four alignment commands:

III Left aligns selected text at the left margin

III Center centers selected text between the left and right margins

III Right aligns selected text at the right margin

.. Full justifies selected text

]~~iill~~!~d;~!~~~1~liW~J
"'''''''Ori'e''';I'l's'lt'''i'o''i'fi'e''oi'iiTsfo'j)'(j''o"f'''H'o'w'oH'Ts"e'j)'o'u"ii'fi"i'o'"''''''''

convince anuone that this was probabl!! the biblical
"",~,~"r.,~,~,~",~,L~~,~,~,:"~,~,~.r.,~,~,~~,r!,~,~,~,,,~,M",~"I.,~,£~",~"~,~,~,M",~,~,~,£,~,~,~,r.",,,

"'"''''''''O'j)'e'lii'sTi''to'''iJ,e'''OTg'''j'sTond'of'''H'aw'oiTis'''en'o'u'gfi'''to'
convince anuone that this was probablu the biblical

Garden of Eden, Choracterized bU black sandu beaches,
"'"''''''''','''''''''''''',''''''''''','',,'''''',,'''''''''''''''''''''''''''""m,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,"''''''''''''''''''''''''''''''''"""""'''n,,,mn,,,,,,,,,n,,,,,''

"O'j)e"'vi'si't''''to''the''''OTg'''TsTa'j)'d"'o'f''''Haw'iiH''TS'''''e'j)'o"lj'ii'h''''to'
convince anuone that this was probablu the biblical
Garden of Eden, Characterized bU black sandu beaches,

The next set of commands on the Text menu controls the amount of
space between lines for the selected paragraph(s) or for the next text you
type at the insertion point. Choosing one of the first three commands
selects a predefined line spacing setting:

.. Single Space sets the line spacing of selected text to single spacing

.. 1-1/2 Space sets the line spacing of selected text to a line-and-a-half

of spacing

.. Double Space sets the line spacing of selected text to double spacing
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Single-spaced lext - ~---~

oii'e"vI'sl"i'''i'i1'''ih'e''jjI'g'''j''slil'n'd'''i1'fHli'i:j"i1II'Ts'''e'ii'i1'ii'g'h'iil""""''''''''''''''
convince onuone that this was probablu the biblical
Garden of Eden. Characterized bu black sandu beaches,
live volcanoes, and wild bougainvillea, this tropical

1-1/2-spaced lext

Doubie-spaced lext
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One visit to the Big Island of Howaii is enough to
convince anuone that this was probablU the biblical
Gorden of Eden, Characterized bu black sandu beaches,

One visit ta the Big Island af Hawaii is enough ta

convince anuone that this was probablu the biblical

When you select one of the alignment or line spacing commands, a
check mark (..J) appears next to it on the menu, If you move the inser·
tion point to a paragraph using a different alignment, the alignment of
the text where the insertion point is positioned is the chosen alignment
and appears checked on the menu, The same is true of line spacing-the
line spacing of the paragraph where the insertion point is positioned is
the chosen line spacing,
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Set Spacing ...
In addition to the three predefined line spacing settings, the Text menu
also includes the Set Spacing command, which lets you specify in points
the exact amount of line spacing you want for a selection.

When you choose Set Spacing, AppleWorks OS displays a dialog box:

Type in the entry box the amount of spacing in points that you want for
the selected paragraph(s), and click OK. (You can enter any number for
line spacing from four to 64 points.) The line spacing for all paragraphs
in the selection is adjusted to the amount you specify.

If you specify a line spacing that's less than the point size of the largest
character on a line, the specified spacing isn't used for that line.
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Font Menu

Choose Font...
Courier

10enevo
Helvetioo
Monooo
Hew York
Shoston
Times
Venioe
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The Font menu lets you choose different fonts, or typefaces, for selected
text or for text to be typed at the insertion point. In addition, the Font
menu includes the Choose Font command (see ClChoose Font" in
chapter 1, "AppleWorks OS Commands"), which provides access ro all
the fonts in the System folder of your startup disk and lets you select the
style and size of a font at the same time that the font is chosen. The
preset font is Geneva.

Below the Choose Font command on the Font menu is a list of fonts.
This list shows the first fifteen fonts in the System folder of your startup
disk; to see others, use the Choose Font command.

When you choose a font, a check mark <'I) appears beside that font on
the Font menu. If you move the insertion point to a different font in
your text, the font where the insertion point is positioned is the chosen
font and appears checked on the Font menu. If selected text is all of one
font, that font is checked on the Font menu; otherwise, no font is
checked.

If you use the mouse or arrow keys to position the insertion point
between text of two different fonts, the chosen font is the font of the
text to the right of the insertion point.

When you cut or copy text, the text retains its font along with its size,
style, and color.
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Size Mellu

8Point
9 Point

10 Point
~12 Point

1q Point
18 Point
20 Point
2q Point
Lorger Q)

Smoller Q(

The Size menu lets you choose point sizes for selected text or for text to
be typed at the insertion point. The minimum point size is 4 points; the
maximum is 48 points. The preset size is 12 points.

If a font for a specific point size is in the System folder of your Apple
Works OS startup disk, that size appears in boldface on the Size menu;
otherwise, that size appears in plain text.

When you change font sizes, AppleWorks OS checks to see if the newly
chosen font size is in the System folder of the startup disk. If it is, there
will be a short pause the first time that font size is loaded into memory. If
AppleWorks OS can't find the point size you specify as a font file, the
specified size is derived from the characteristics of a different size of the
font.

When you choose a font size, a check mark (...J) appears beside that font
size on the Size menu, and selected text or text typed at the insertion
point is changed to the specified point size.

If you move the insertion point to a place in the text with a different
point size, the size where the insertion point is positioned is the chosen
size and is checked on the Size menu. If selected text is all of one size,
that size is checked on the Size menu; otherwise, no size is checked.

If you use the mouse or arrow keys to position the insertion point
between text of two different sizes, the chosen size is the always the size
of the text to the right of the insertion point.

When you cut or copy text, the text retains its size along with its font,
style, and color.
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Larger

The Larger command lets you increase the size of selected text (or for
text to be typed at the insertion point) in I-point increments, up to 48
points.

If the new font size you specify is not one of the sizes on the Size menu,
no check mark appears on the menu.

If you specify a font size for which there is no font file in the System
folder of the startup disk, AppleWorks OS derives the specified size from
the standard font sizes that are available. The appearance of derived font
sizes may be rougher than standard font sizes.

Smaller
The Smaller command decreases the size of selected text (or for text to
be typed at the insertion point) in I-point increments, down to 4 points.

If the new font size you specify is not one of the sizes on the Size menu,
no check mark appears on the menu.

If you specify a font size for which there is no font file in the System
folder of the startup disk, AppleWorks OS derives the specified size from
the stimdard font sizes that are available. The appearance of derived font
sizes may be rougher than standard font sizes.
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Style Menu

IPlain aT
Dald 6D
/toile 6/
Underline aU
Outline
Shadow
Supersoript aH
Subsoript al
UPPERCASE
loweroase
Title

The Style menu lets you choose a style or combination of styles for
selected text or for text to be typed at the insertion point. The preset
style is Plain.

When you choose a style, a check mark (...J) appears beside the style on
the menu. You can mix styles in any combination you wish; as each new
style is chosen, it appears checked on the Style menu. For instance, you
can select Bold and Underline ftom the Style menu, and your text will
appear both boldface and underlined. You can deselect a style by
choosing the selected style again. To remove all styles, choose Plain.

Examples of the different styles offered by AppleWorks GS are shown
below:

Plain removes all text styles

The Bold command changes selected text to boldface

Italic c1Janges a selection to italic text

Use the Underline command to create Underlined text

Outline creates white characters outlined in black

Shadow creates text with three-dimensional shadows

Use Superscript for superscripted symbolsrn such as footnotes'

Use Subscript to create subscripted text-like formulas (H2S04)

UPPERCASE CHANGES A SELECTION TO ALL UPPERCASE

the lowercase command changes selected text to all lowercase

Title Converts The First Letter Of Every Word In A Selection
To Uppercase

A few styles can't be used in certain combinations:

III Plain can't be used in combination with Bold, Italic, Underline,

Outline, or Shadow, since Plain removes those styles ftom text.

II Superscript and Subscript can't be be used in combination since

they're mutually exclusive.

II Uppercase, Lowercase, and Capitalize can't be be used in combination

since they're also mutually exclusive. (Also, unlike the other styles,

these commands can only be used for selected text and not for text to

be typed.)
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If you move the insertion point to a different style in your text, the style
where the insertion point is positioned is the chosen style and is checked
on the Style menu. If selected text is all of one style, that style is checked
on the Style menu; otherwise, nothing appears checked on the menu.

If you use the mouse or arrow keys to position the insertion point be,
tween text of two different styles, the chosen style is always the style of
the text to the right of the insertion point.

When you cut or copy text, the text retains its style along with its font,
size, and color.
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Color Mellu The Color menu lets you choose colors for objects you create with the
drawing tools, for selected text, and for text to be typed at the insertion
point. In addition, the Color menu contains the Edit Colors command,
which lets you choose text and graphics colors from the 4096 colors of
the Apple IIos. The Edit Colors command is common to other Apple
Works OS applications and is therefore covered in detail in "Other
Common AppleWorks OS Commands," in chapter I, "AppleWorks OS
Commands."

Fifteen different colors are available at one timej the preset color is
black. Color text and graphics appear on your screen and will be printed
if you're printing with a color ribbon on an [mageWriter II (or compat
ible printer).

When creating objects with the drawing tools (the line tools, the
rectangle tool, the oval tool, and the rounded rectangle tool), choose a
color for the object from the Color menu before you draw it. To change
the color of an object you've already created, select the object and
choose the color from the menu.

When editing text, if you move the insertion point from text of one
color to another, the color of the text where the insertion point is
positioned is the chosen color and that color appears selected on the
Color menu. If a selection of text contains more than one color, the
color of the first character in the selection is selected.

If you use the mouse or arrow keys to position the insertion point
between text of two different colors, the chosen color is the color of the
text to the right of the insertion point.

When you cut or copy text, it retains its color along with its font, size!
and style.
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The Tool Palette
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The tool palette provides you with the different editing tools you'll use
to layout text and graphics to create page layout documents.

~ Selection Arrow
Use the selection afrow to select, move, and reshape objects.

To select an object, click anywhere on the object with the selection
arrow. Handles appear around the selected object.

To select more than one object at once, hold down the Shift key as you
click each object that you want to select. As long as you hold down
Shift, any unselected object you click will be selected. If you want to
deselect one of the selected objects, Shift-click the object again.

You can also select several objects at once by clicking above or below the
objects you want to select and dragging diagonally across the objects. As
you drag, a dotted box called a selection recrangle appears; any objects
completely surrounded by the selection rectangle are selected when you
release the mouse button.

If you hold down the Shift key as you drag, any selected objects enclosed
by the selection rectangle are deselected and any unselected objects are
selected.

To move an object or group of objects, select the object(s) with the
selection arrow and drag the selection arrow. As you drag, an outline of
the selected object(s) moves with the selection arrow. When you've
moved the selection arrow to the location in the document where you
want to place the object(s), release the mouse button.

To reshape or resize an object, click the object with the selection arrow
to select it. Position the selection arrow on one of the object's handles
and drag until the object assumes the size or shape you want. Then,
release the mouse button.

To crop a graphic (cropping means removing unwanted portions of a
picture), position the selection arrow on one of the graphic's handles.
(Choose the handle nearest the area you want to remove. If you want to
remove part of the top and left sides of a graphic, for example, position
the selection arrow on the upper-left handle.) Hold down the Option
key and drag until the part of the graphic you want to crop is removed.
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IA I Text Tool
Use the text tool to add text to a page layout document. With the text
tool you create text objects, blocks of text that can be edited and also
moved around on a page, resized, and reshaped as objects.

When you choose the text tool, the pointer becomes shaped like an \
beam. Position the I.-beam at the place in a document where you want to
start one comer of a text block and drag the I-beam pointer diagonally to
the place where you want the opposite corner of the text object. As you
drag, the outline of a rectangle appears on the screen, indicating the
dimensions of the text object. When the text object assumes the shape
you want, release the mouse button. The empty text object is placed at
the specified location on the page.

There are three different ways to add text to a text object:

iii Type directly into the text object Click the I-beam in the upper-left

comer of the text object to select the insertion point. Type text in at

the insertion point in the usual way. Text appears in the block as you

type.

III Import text from other applications with the Import File commend.
You can add text from other applications-including the Apple

Works OS word processor, AppleWorks, MultiScribe OS, and ASCII

text documents-to a text object with Import File. First, create a text

object and click inside it to select the insertion point. Then, choose

Import File from the File menu and choose the document you want to

import (see "Import File" in this chapter for more information).

iii Insert text from the AppleWorks GS word processor with Cut, Copy,
and Pasta. Formatted text can be imported from the AppleWorks OS

word processor with the Cut, Copy, and Paste commands on the Edit

menu. First, create the formatted text in the word processor and copy

the text to the Clipboard using Cut or Copy. Next, open the page

layout document and define a text object for the text. Then, click

inside the text object and choose the Paste command to insert the

text from the Clipboard.
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The text in text objects can be linked together in text streams. A text
stream is any amount of text contained in a text object (or in two or
more linked text objects). Text streams are actually independent of text
objects; the text objects are like frames that contain the text in the text
stream.

To create a text stream, you first create a text object and add text to it
using one of the three methods described above. Next, click the link tag
at the bottom of the text object.

''''''"''''''''''''''''''''Il,,,,,,Q''IIII''''''''''''''''''''II'''''lIl
In June, 1579,

Captain Francis Drake
was the first English
explorer to visit the
Redwood Empire, which
stretches over 400

To create a new object in a text stream, -
click the link tag at the bottom of the
current object
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When you click the link tag, the pointer assumes the shape of a small
text document (the same shape it assumes when you import a text
document-see flImport File/' in this chapter). Position the pointer at
the place in the document where you want to continue the text stream,
and click. A new text object appears where you click (or click and drag).

The link tags at the bottom of the first object and on the top of the new
object contain a plus sign ("+"), indicating that a link exists. The link
tags at the top of the first object and on the bottom of the second object
are empty, indicating that no link exists from those points. Because it
represents the beginning of the text stream, the link tag on the top of the
first text object is always hollow. As you add text objects, the link tag on
the bottom of the newest object is always hollow because it represents
the end of the text stream. All other link tags in a text stream contain
plus signs.
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When you delete text in a text stream,
the text in subsequent objects is moved
up. The reverse occurs when you insert
text in a text streem.

In this example, the text in the second
end third text objects is moved up to fill
in the gap left by the text deleted from
the second text object.

You can add a third text object to the stream by clicking the link on the
second object, positioning the pointer, and clicking. In fact, you can add
as many text objects to a stream as you need or want.

You can also insert a new text object between two text objects by
clicking the link tag on the first object, placing the pointer, and clicking;
the new object is the second object in the stream.

If you created the initial text object by importing a text documenr or
pasting text that's larger than the space alloted for it in the text object,
the text continues in the new text object (and in as many subsequent
text objects as necessary). If you created the initial text object by
defining a text object and typing text, you can continue the text stream
by clicking the new text object and continuing to type. In both cases,
the text is linked; if you add or delete text in the one object, the text in
the following object(s) is either moved down or up to accommodate your
changes.

Edil Oplion, Rrrong. Texl Fonl Size Slyle Color Window
Unlill.dl (Pi)

territoryIi claiR to
f"". is Ih. lajestio* redwood, Ih. world',
lall"llr...

Orok. land.d jusl
b.nealh Poinl R.y"

.~il Oplion, R~Text Fonl Size Styl. Color Window
,0 Untilledl (Pi) en
~

iii In Jun',ISli, In". Ascenioland toll"t tr...
~ Captain Francis Drab encOll~ossing nine Orok. land.d just
Iiil was the first Engli,h oount ", the b.neath Paint R.y"-:+ .xplorer to vi,illh. territory', clail to an the .dg. of Horin

--'-, R.dwood Elpire, which t"". i, the lajestic County.
/ ,trelches aver qOO redwood, the world',
--- ----------------------------------------------------------------------

For more information on adding text to page layout documents, see
"Working with Text and Graphics" in chapter 6 of the AppleWorks GS
User's Guide.
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m Page Number Tool

Use the page number tool to specify where on a page you want the page
number placed when the document is printed.

When you choose the page number tool, the pointer changes to a pound
sign (#). Position the pointer at the place on the page where you want
the page number to appear and click. The number of the current page
appears at the place you click. The page number is displayed in the
currently selected font, size, and style of text. Once it's created, you can
still change its font, size, style, and color by selecting it and then
choosing the appropriate options from the Font, Size, Style, and Color
menus.

Because it's an object, the page number can be moved on the page after
it's created. To move the page number, select it with the selection arrow
and drag.

To automatically place the current page number on every page of a
document, use the page number tool to place the page number in the
appropriate location on the master page(s).

I iBIl Date Tool
Use the date tool to specify where on a page you want the current date
placed when the document is printed. The date is displayed in the format
Month Day, Year; for example, January 1, 1988.

When you choose the date tool, the pointer changes to the date symbol,
which resembles two pages of a desk calendar. Position the pointer at the
place on the page where you want the date to appear and click. The
current date is displayed at the place you click in the currently selected
font, size, and style of text. Once the date is created, you can still change
its font, size, style, and color by selecting it and then choosing the appro
priate options from the Font, Size, Style, and Color menus.

Because it's an object, the date can be moved on the page after it's
created. To move the date, select it with the selection arrow and drag.

To automatically place the current date on every page of a document,
use the date tool to place the date in the appropriate location on the
master page(s).
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I+ I HorizontalNertical Line Tool

Use the hotizontal/verticalline tool to draw straight horizontal and
vertical lines (lines parallel to the edges of the document window). You
can draw vertical or hotizontallines with any of the line widths in the
line palette and with any color on the Color menu (see "Color Menu"
and "The Line Palette/' in this chapter for information on choosing
colots and line widths).

When you choose the hotizontal/verticalline tool, the pointer changes
to a crossbar. Choose the line width you want to use from the line
palette and the colot you want from the Color menu. Position the
crossbar at the place in the document where you want to begin the line
and drag. You'll see a line stretch between the starting point and the
horizontal or vertical position of the crossbar as you draw. (Because the
line will be either hotizontal or vettical, the crossbar may be discon.
nected from the actual endpoint of the line as you draw.) Release the
mouse button to complete the line.

I/ I Line Tool
Use the line tool to draw straight lines in a document. The line tool lets
you draw vettical, horizontal, or diagonal lines with any of the line
widths in the line palette and with any of the colors on the Calot menu
(see CfColor Menul! and "Line Palette," in this chapter for information on
choosing colors and line widths).

When you choose the line tool the pointer changes to a crossbar. Choose
the line widths you want to use from the line palette and the color you
want from the Colot menu. Position the crossbar at the place in the
document where you want to start the line. Drag to draw the line. A line
appears between the starting point and the position of the crossbar as
you draw. When you've positioned the crossbar on the spot where you
want the line to end, release the mouse button to complete the object.

You can constrain lines to vettical, hotizontal, and 45.degree lines by
holding down the Shift key as you draw.
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101 Rectangle Tool

Use the rectangle tool to draw filled and hollow rectangles and squares.

When you choose the rectangle tool, the pointer becomes a crosshar.
Choose whether you want the rectangle to be filled or hollow by clicking
either the filled or hollow icon. If you're creating a hollow rectangle,
choose a line width from the line palette to use as the border. Select a
color for the rectangle from the Color menu.

Position the crossbar at the place in the document where you want to
start a comer of the rectangle and drag diagonally to the place where you
want the opposite corner. As you drag, the outline of rectangle appears.
Release the mouse button to complete the rectangle.

To create a square, hold down the Shift key as you draw.

101 Rounded Rectangle Tool

Use the rounded rectangle tool to draw rectangles and squares with
rounded comers.

When you choose the rounded rectangle tool, the pointer becomes a
crossbar. Choose whether you want the rounded rectangle to be filled or
hollow by clicking either the filled or hollow icon. If you're creating a
hollow rounded rectangle, choose a line width from the line palette to
use for the borders of the rounded rectangle. Select a color for the
rounded rectangle from the Color menu.

Position the pointer at the place in the document where you want to
start a comer of the rounded rectangle and drag diagonally to the place
where you want the opposite comer of the rounded rectangle to appear.
As you drag, the rounded rectangle appears. Release the mouse button to
complete the rounded rectangle.

To create a rounded square, hold down the Shift key as you draw.
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10 I Oval Tool
Use the oval tool lets to draw ovals and circles.

When you choose the oval tool, the pointer becomes a crossbar. Choose
whether you want the oval to be filled or hollow by clicking either the
filled or outline icon. If you're creating a hollow rounded rectangle,
choose a line width from the line palette to use for the borders of the
rounded tectangle. Select a color for the oval from the Color menu.

Position the pointer at the place in the document where you want to
start the oval and drag diagonally to the place where you want the
opposite side of the oval. As you drag, the ouline of an oval appears.
Release the mouse button to complete the oval.

To create a circle, hold down the Shift key as you draw.

~ The Filled/Hollow Icons

These two icons control whether the objects you cteate with the shape
drawing tools (tectangles, rounded rectangles, and ovals) are filled or
hollow.

To create hollow shapes, click the hollow icon (on the left). Any new
shapes you draw will be outlined, with line widths determined by the line
width currently selected in the line palette and in the color currently
selected on the Color menu.

To create filled shapes, click the solid icon (on the right). Any new
shapes you draw will be filled with the color currently selected on the
Color menu.

To change an existing object, select the object and then click the filled
or hollow icon.
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The line Palette
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The line palette lets you choose lines from a predefined set of line
widths. These line widths determine the thickness of lines you draw with
the line tools as well as the width of the borders of hollow objects you
draw with the shape drawing tools (rectangles, rounded rectangles, and
ovals).

To choose a line width, click the desired line width in the palette. The
new line width. indicated by an orange check mark on the line palette
(the check mark appears in a distinct pattern on a monochrome moni
tor), replaces the current line width for any currently selected lines and
hollow shapes. To change the line width of an existing object, select the
object and then click the desired line width on the line palette.
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The Page Icons In the lower... left comer of the document window are icons that represent
the pages in the document. Clicking on a page icon selects the icon and
displays that page in the document window.

The page layout application uses two types of page icons:
III Master page icons, for selecting master pages (pages containing items

to be repeated on every page of a document)

III Numbered page icons, fot selecting the actual pages in a document

Master page icon (single page) ----11
L.:...:..I.L..

Numbered page icons -------------/'

Left and Right master page icons ---t.!::..l..!i.L~

/
'------Ciick to scroll pages not displayed
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Place on the master pages any text, graphics, or guides you want to
automatically display on every page of a document. When you first
create a page layout document, a single master page is available, and a
single page icon, labeled M, appears in the lower-left comer of the
document window. All the numbered page icons look like the single
master page icon, dog-eared on the right side. Click this icon to place
master page items on every page in the document.

To use the left and right master pages, choose Left/Right Master Pages
from the Options menu. The left and right page icons, labeled Land R,
appear in the lower-left comer of the document window. The numbered
page icons for left-hand pages look like the L master page icon, dog-eared
on the left side: the numbered page icons for right-hand pages look like
the R master page icon, dog-eared on the right. Use the left master page
icon to place master page items on every left-hand page in the docu
mentj use the right master page icon to place master page items on every
right-hand page.

Note: You can only move or change master page items when the

master page is displayed in the document window. When you don't

want master page items displayed on a particular page, choose the

Ignore Master Page command.
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To display a specific page in a document, click the numbered page icon
representing the page. That page becomes the current page and is
displayed on the screen. You can also display a specific page with the 00
To Page command (see "00 To Page," in this chapter).

If you have five or fewer pages in a document, AppleWorks OS displays
icons for all the pages. When you have more than five pages in a
document, arrows appear on either side of the numbered page icons. If
the icon for the page that you want to display isn't visible, click the left
or right arrow to scroll through the numbered icons until the icon for
that page appears.
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Rulers

Indentation marker for the selec

Tab marker/or the selected text

When you first create a page layout document, rulers are displayed across
the top and down the left side of the documenr window. These rulers can
be hidden and displayed with the Hide Rulers and Show Rulers com
mands. When you want to see more of a document, remove the rulers
from the document window with Hide Rulers. Display the rulers when
you want to accurately position text and graphics on the page.

The increments in the ruler are based on inches. Both rulers start at zero,
at the top and left edges of the page. When you change views in the
document window (see "Fit in Window/Actual Size," in this chapter) the
increments in the rulers' inch scales change to display as much resolution
as is possible given the page view, the page setup options chosen, and the
printer selected.

When you drag the pointer in the document window, dotted lines appear
in the rulers to indicate the exact position of the pointer in the docu~

ment window. You can use these lines to help place text and objects
accurately.

In addition to these pointer,position lines, the rulers provide another,
more powerful tool for precisely aligning text and graphics in the
document window-ruler guides. Ruler guides are explained in detail in
the next section, UPage Layout Guides."

When you're editing text objects, you can use the rulers to change the
indentation of, and add tabs to, selected text (the paragraph containing
the insertion point or all paragraphs in a selection). The tabs and indent
marker for the selected text appear in the ruler.

• fiI. Edil Options Rrrong. Text Font Size Slgl. Color Window
,0 Untill.d! (Pl) I!J,

led text '-...I'"
,

!:~
One visil to tho Big Islond of Howoli is *

enough to convince onyone that this wos
proboblg tho bibliool Gorden of Eden.
Chorootorized bg blook IOndg booch.., live
voloonOOl, ond wild bcugcinvmoo, this
~_opical parodi~e seells aworld all i~~

-- ---------------------------------------------------------------

Page Layout Commands 195



Page Layout Commands
Importantl The insertion point must be selected in a text object for

the tabs and indent market to be displayed. When you move the ,.

beam into the horizontal ruler at the top of the document window,

the pointer changes to an arrow to allow you to drag the indent

marker and tabs.

To change the indentation, drag the indent marker to the place in the
horizontal ruler where you want the selected text indented. The indenta·
tion for the selected paragraph(s) will change to reflect the new location
of the indent marker.

AppleWorks OS supports three types of tabs in the page layout applica.
tion: left tabs, right tabs, and decimal tabs. When you use left tabs,
tabbed text is aligned flush· left at the tab marker. Right tabs cause
tabbed text to line up flush.right at the tab marker. Decimal tabs align
tabbed text at the decimal point; use decimal tabs for lining up columns
of numbers with different decimal places.

Use right tabs to
right-align text at
the tab marker

Use left tabs to
left-align text at
the tab marker

Decimal tabs let you line up
columns of numbers by their
decimal points
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To place a tab in selected text, position the pointer in the tab well and
drag a tab into the inch scale of the horizontal ruler.
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iP1
;o

The tab well is located in the intersec-
tion of the vertical and horizontal rulers : ~~o~

Drag the tab marker into the position on the inch scale where you want
the tab stop. If you're using columns of text, first use the text tool to
select the insertion point in the paragraph(s) in the column you want to
add tabs to. The indentation marker and any tabs for that column appear
in the inch scale of the ruler.

Oplloos Afrong, '''I Fonl SilO yh Color Wind...
Unlllhdi (Pl)

',·.................M········_······j·_·i···········_-·······_··_·······i···i·..·····_······__·..··········;··
'Th' Sold.. SOlO Ih, bridg, i. a Ih, brldg" ,t
Brldg" Son Fron- 1"liJlony lalh, neither ~tate nor
cisco·s tradNork, ..glnmlng .kill. f,doral flnonclng.0. op..,d on Hoy of J",ph Slrauss. could b, oblal..d,
21,1931. Spanning Wh.. Slrouss so In 1930 Son
aDile-wide strait, ag",d 10 d"lgn Francisco and fivt
_________________l_J__________________L_J_________________1

#

iliI
l+

/
°2~ ---- --

If you're tabbing text in columns, select---------------____
the insertion point in the paragraph!s) in
the column you want to add tabs to and
drag the appropriate tabs into the inch
scale

Any tabs in the selected text line up at the tab marker. You can place as
many as ten tabs per paragraph (or selection of paragraphs).
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Page layout Guides The AppleWorks GS page layout application provides three different

types of guides, nonprinting dotted lines that you can use to accurately
position text and graphics in a document. The three types of guides are
margin guides, column guides, and ruler guides.

Margin guides, which you specify with the Set Guides command, provide
a document with left, right, top, and bottom margins. Use margin guides
when you want to create a page size other than the standard page sizes
offered by the Page Setup command. (See "Page Setup," in chapter I,
llApple\Vorks OS Commands/' for more information.)

The Set Guides command also lets you create column guides that you
can use to divide a page into as many as nine text columns. Column
guides are created in pairs separated by column spacing (which can also
be specified with the Set Guides command). Use column guides to shape
text objects into equal columns.

When you want to position text or graphics at a particular place in a
document, use ruler guides. These are vertical and horizontal guides
which you can line up on the tick marks of the top and left rulers for
precise alignment of objects. To create ruler guides, the rulers must be
displayed in the document window. (If they're not visible, choose Show
Rulers from the Options menu.)

To create a horizontal ruler guide, drag from the inch scale of the hori
zontal ruler at the top of the window down into the page area.

• File Edit Option, Rrronge 'ext font Size Stule Color W;:in~do~w~~~
;0 Untitled! (Pl) !!'! E);

Creating a horizontal ruler guide -----l~~~~~~~~~~~~~~~~~~~~~~~:::::::::f~
# "",,,. "" ,=~:c"'::":=="':":2L"",,,,,,,,,·::::::::,,,,,,,,,,,,,,,,,,:,,,,,,,,,:t""".,,,,,,,,,,,,,.

iljl ,edd!iIoo"ii,rt-o'ii'fiiE IiItr..'u'lnT,onk'lln""
! were two of the most colorful pmident' in+ Americon hi,toru. Vet, while the first P",ident

/ R.."vel t, udie-hord Rough Rider, "rode" into
Washington with "sound and furY,1I it woso 2 actuollu fOR who pulled thecountru out ofo deprmion with hIS Hew Oeal.o ----w---------
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A dotted line appears that extends at the far left into the vertical ruler.
Line up the guide against the tick marks of the ruler.

To create a vertical ruler guide, drag from the inch scale of the vertical
ruler on the left side of the document window into the page area. A
dotted line appears that extends at the top of the document window into
the horizontal ruler. Line up the guide against the tick marks of the ruler.

I
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",=-...... !,
H

Edil Oplions Arronae !exI fonl Size
Unli\ledl (Pl)

"" """"""""""""""'''''''''''''''''';>'i'''''''''''''''''''''''''''''''''''''''''''''''''!''""""""""""""

Teddy Roosevell ond his fiTlhcoulfill"nklin •
were two of the most colorful presidents in
Amori"n his lory. Yel, while Ihe firsl Presidenl
Roosevelt, adie-hard Rough Rider. "rode" into
Woshington with "sound and fury," it wos
ocluolly fOR who pulled Ihe coUnlry oUI of
depression wilh his Hew 0,,1. 4i+
·-----·,-·------·'~fU--··-'--"---------

To make aligning text and graphics with a guide even easier, the page
layout application features the Magnetic Guides command, which makes
the column, ruler, and margin guides in a document attract objects.
Whenever you move a text or graphics object within range of a magnetic
guide (closer than four pixels vertically or eight pixels horizontally), the
object is drawn to and aligned with the guide. Objects are also attracted
to magnetic guides when you're first creating them and when you resizef
reshape them.

For more information on guides, see USer Guides," llLock Guides/Unlock
Guides," ClMagnetic GuidesfNormal Guides," and "Rulers" in this
chapter.
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Communications Commands

File Mellll

Hew... 6H
Open... 60
Close 6K
Sove 6S
Sove As...
Delete File ..
Import File ..
ChQQS~ Priot~r...
P(lO~ S~!j;U!l ...

Priot... :'if'
Priot Herq~ ...
Quit 6Q

Edit Mellu

lIodo ·ll
CUt ·lK
CoPU 6C
Poste 6V
Cl~ar

Select All 6A

The standard File menu commands----<:ommon to all the AppleWorks
OS applications-are described in Chapter 1, "AppleWorks OS Com
mands," Because the communications application doesn't support
printing, the Choose Printer, Page Setup, Print, and Print Merge
commands are dimmed on the communications File menu.

The communications application uses the Copy and Paste commands
described in chapter 1, "AppleWorks OS Commands." Other common
Edit menu commands, such as Undo, Cut, and Clear are not supported
in the communications application.
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Transfer Menu

Receive File...
Receive Botch...
Receive Binary II...
Send File...
Send Botch...
Send Binary II...
Capture Text
Send Text...
Cancel ~.

204

The Transfer menu contains commands for sending and receiving files
using a number of different file formats and protocols.

If you're working with a new communications document, teU Apple~

Works OS what type of modem you're using with the Hardware com...
mand on the Settings menu (see "Hardware)" in this chapter) before
using any of the commands on the Transfer menu. These commands are
dimmed unless you've specified your hardware settings and initialized
your modem (or selected No Modem) with the Hardware command.

The first six commands on this menu require that you specify a protocol,
a standard format for sending and receiving files. Protocols provide both
sides in a file exchange with a fixed set of rules that allow files to be
transferred correctly. The protocol you select must match the protocol
used by the other computer.

The communications application commands for receiving files offer three
protocol settings-Xmodem, Xmodem CRC, and Ymodem-while the
commands for sending files offer Xmodem and Ymodem (the remote, re
ceiving computer could specify either Xmodem or Xmodem CRC).

There are four different methods offered for receiving and sending data.
The first, File, sends or receives a single file at once. Use File when you
have only one file to send. The second method is Batch, which sends or
receives one or more files in a single transfer. Use Batch when you want
to send or receive several files at once. The third and preferred mode is
Binary II, which sends or receives one or more files in the Binary II file
format. This format preserves information that's important to the
original application program used to create the file-the file type, its
length, and so on. For example, if you wanted to transfer a graphics or
database file, you'd want to choose Binary II, because the Binary II
format would preserve the file information necessary to load the file in
the application that created it.

Finally, you can send and receive text files using the Capture Text and
Send Text commands. When you choose Capture Text, AppleWorks OS
stores in memory all information subsequently received by your computer
until you tell the program to stop the text capture, at which time you can
save the captured information as a text file on a disk. The Send Text
command lets you send a file as ASCII text. The difference between
these commands and the Send File and Receive File commands is that
you don't have the transmission error checking of the various protocols
offered by Send File and Receive File.
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Receive File...

The Receive File command lets you receive a specified file from a remote
computer system.

When you choose Receive File, a dialog box appears:

cr kt 'fy protocolIC a speci

® /Com.Files.21
694 free of 800 K.

D Find~r.Doto ~
( Disk ) @Xmodem

D GOO\~s .Us \ OXmodem CRC
D lleo<llines I ( Op~n ) OYmodem
D ~et~mlU nfo

)D ~e~! ,PI oce<lum ( Close
D fiuolit ..,Desiofi {I-

Receive File: [ Save »
IStock.Update I( Cancel )Type a name for the file here

Click to save the file

Type a name for the file in the Receive File entry box. Click Disk to
choose the disk you want to save the file on.

When the file has been successfully transmitted and received, it's
automatically saved on the disk with the file name you specified in the
dialog box.
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Receive Batch...

The Receive Batch command lets you receive one or more files from a
remote computer system. The files are named by the sender and received
on a specified disk or folder on a disk.

When you choose Receive File, a dialog box appears:

The directory or di~k you want
to save the files on

® ICom.Files.21
661 free of 800 K.

D n~d~1.noto
D Gomes.list
D Heodlines
D Netl'lOrk. Info
D NCYi.Procedul'~s
D uolit .nesi n

Receive 8otch:

Click to specify protocol

Disk ) @Xmodem
OXmodem CRC

Op~~ ) OVmodem
Close )

Save ]
Cancel )

206

The files will be saved on the disk and in the folder you specify. Click
Disk to choose the disk you want to save the files on.

When the files have been successfully transmitted and received, they're
automatically saved in the folder and on the disk you specified in the
dialog box.
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Receive Binary II ...

The Receive Binary II command lets you receive one or more files with
the Binary II format from a remote computer system. The files are named
by the sender and received on a specified disk or specified folder on a
disk.

When you choose Receive File, a dialog box appears:

The directory or disk you want
to save the files on

® /Com.Files.2/
629 free of 800 K.

Cl r:inuN .Uoto
Cl GGm~f..l.i It
["llleodUnes
['llle\;I!I>fUnf!>
["lllel1.PfGc(!<!\lm
Cl colit .Oesi n

Receive Binoru II:

Click to specify protocol

Disk ) @Xmodem
OXmodem CRC

I)j>N\ ) OVmodem

Clos(! )

Sove ]
Concel )

The files will be saved on the disk and in the folder you specify. Click
Disk to choose the disk you want to save the files on.

When the files have been successfully transmitted and received, they're
automatically saved in the folder and on the disk you specified in the
dialog box.
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Send File...

The Send File command lets you transmit a specified file to a remote
computer system.

When you choose Send File, a dialog box appears:

Click to specify protocol

Send file:
® /Com.Files.2/

D Finder.Dota 11 ( Disk ) @Xmodem
D Gomes.List OVmodem
D Headlines [ Open »
D Hew.Procedures ( Close )
D QualitY.Design
D Quotes
D Resume.Jim.C. ( Cancel )

Click to open the file you want to send

Click the name of the file ------HI
you wantto send

Click the name of the file you want to send in the list box, and then
click Open. If the file you want to send is not on the current disk, click
Disk to choose another disk. If the file is in a different folder, click the
folder to select it and click Open to display the folder's contents in the
list box.
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Send Batch."

The Send Batch command lets you transmit one of mote files to a
remote computer system.

When you choose Send Batch, a dialog box appeats:

Click to specify protocol

Botch files to send:

ICom.Fi les.2/Heodlines
ICom.Fi Ies.2/Hetwork.1 nfo
ICom.FiIes.2/Quo1i tu.Design

Click to select a file to remove from ---H-I/Com.Files.2/Hew.Procedures
the list of files to send ICom.Files.2/Quotes

ICom.FiIes.2/Quo1itu.Design

( Remove) (ConDe1 ) «

@Xmodem
OVmodem

Click to add a file
to the list

Click to remove a file
from the list

Add
To add a file to the list of files to send, click Add. A second dialog box
appears:

Send file:
® ICom.Files.21

D Gomes.list 11 ( Disk )
D Heodlines

Click the name of the file D Hetwork.lnfo [ Open » Click to open the
you want to send D Hew.Procedures

D QuolitU.Oesign
file you want to

( I:los~ ) sendD Quotes
D Resume.Jim.C., . I , ( Conce! )
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Click the name of the file you want to send in the list box and then click
Open. If the file you want to send is not on the current disk, click Disk
to choose another disk. If the file is in a different folder, click the folder
to select it and click Open to display the folder's contents in the list box.

When you click Open, the name of the file is added to the list in the first
dialog box and the second dialog box disappears.

Remove
To remove a file from the list of files to send, click the name of the file
in the list to select the file, and then click Remove. The file is deleted
from the list and won't be transmitted.

When you've specified the files you want to send, click OK. The files are
transmitted in the order that they appear on the list.

Send Binary II."

The Send Binary II command lets you transmit one of more files with
the Binary II format to a remote computer system.

When you choose Send Binary II, a dialog box appears:

Click to specify protocol

Binaru II iiies ta send:

ICam.f i Ies.2/Sa1es.Quarter
ICom.fi1es.2/Qua Iitu.Design
ICam.fiIes.2/Games.List

Click to select a file to remove ----I+-I/Cam.files.2/Hew.Pracedures
from the list of files to send

ICom.fi1es.2/Resume.Jim.C.
ICom.files.2/Headl ines

@Xmadem
OVmadem

Click to remove a file from the list ~===r~========================::!.1
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Add
To add a file to the list of files to send, click Add. A second dialog box
appears:

Send file:
® ICom.Files.21

Cl Gomes.list ( Disk )
Cl Headlines
Cl Hetwork.lnfo « Open ] Click to open
Cl New.Prooedures

Click the name of the file you I , I· . ( Clos~ )
the file you

want to send Cl Quotes want to send

Cl Resume.Jim.C.
Cl Sales. uarter ( Canoe I )

Click the name of the file you want to send in the list box and then click
Open. If the file you want to send is not on the current disk, click Disk
to choose another disk. If the file is in a different folder, click the folder
to select it and click Open to display the folder's contents in the list box.

When you click Open, the name of the file is added to the list in the first
dialog box and the second dialog box disappears.

Remove
To remove a file ftom the list of files to send, click the name of the file
in the list to select the file, and then click Remove. The file is deleted
from the list and won't be transmitted.

When you've specified the files you want to send, click OK. The files are
transmitted in the order that they appear on the list.
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Capture Text/End Text Capture

The Capture Text command lets you capture and save as a text file all
information you subsequently receive from the remote computer system.

When you choose Capture Text, all text you receive while on~line is
saved in your computer's memory. The message ICCapture:" (followed by
the number of characters received) is displayed in the status bar and End
Text Capture replaces Capture Text on the Transfer menu.

The text received from the remote computer will be captured in memory
until you tell AppleWorks OS to stop, or until you run out of memory in
the text capture buffer (limited only by available memory). When you
want to stop capturing text, choose End Text Capture from the Transfer
menu. A dialog box appears to let you save the captured text as a
document on a disk. Type a name for the document and click Save.

( Disk)
( Hew Folder)

® ICoRlJiles.21
free: ~3~k out of SOOk.

D flnuH.DQtQ
D SQlm.list
D lIeQdtines ( Gpen )
D ~et\1oIUnfo :==#;=::=
D ~e\1.?1Qcedum (~----=-C",IQc:.se,---,)
D UQ!it .Desi n .(l. g==;c=='l!.

Sove captured text as: ( Save ]) II
Type a name for the file you want---H111-1 Stock.Updote.~ I{ Conce1 .
to save the captured text .

Click to save the captured
text with the specified file
name
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For more information on saving documents, see "Save As" in chapter 1,
"AppleWorks OS Commands."
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Send Text...

The Send Text command lets you send a specified text file to a remote
computer system.

When you select Send Text, a dialog box appeats:

Click the name of the file
you went to send

Send text:
® ICom.Files.21

Cl Gomes.list 1t ( Disk )
Cl Headlines
Cl Hetwork.lnfo [ Open )- -
Cl Hew.Procedures
Cl QualitU.Design ( CIDse )
Cl Duotes,.

I Cl Soles.Duorter I{I- ( Cancel )

Click to open
the file you
wantto send

Click the name of the text file you want to send in the list box, and then
click Open. If the file you want to send is not on the current disk, click
Disk to choose another disk. If the file is in a different folder, click the
foldet to select it and click Open to display the folder's contents in the
list box.
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Cancel

The Cancel command breaks into a transfer operation and halts the
transfer. When you choose Cancel, any transfer operation in progress is
halted at the earliest opportunity.

\Vhen you begin an operation, that operation is listed next to Cancel on
the Transfer menu, to let you know which operation is currently being
performed and therefore which operation will be canceled. For example,
if you've chosen Send File to transfer a file, the command is displayed as
Cancel Send File on the Transfer menu.

Use Cancel to interrupt the following operations:

.. Dialing

.. Importing files

.. Sending files

.. Receiving files

.. Sending text

l1li Pasting text

Cancel will not interrupt the Capture Text command.
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AI

Settings Menu

Show Contro1
Edit line

{Status Bor
{Loco I

Hardware... 11M
Communioatian... liT

The Settings menu contains commands for specifying new hardware
settings and communications protocols! as well as commands for select~

ing different text display options.

Show Control

The Show Control command displays all control characters-such as
tabs, carriage returns, arrow keys, and so forth-in communications text
displayed on the screen. Control characters are displayed as two chame,
ters-a caret symbol (A) followed by a letter indicating the control
character's place in the ASCII sequence.

Control characters displayed with Show Control

Key

Esc

Tab
-------- ~--~.~_._-.-------

Control and any character

Delete Ai-_...._.._....... -------------

Return

Left Arrow Key

Right Arrow Key

Up Arrow

Down Arrow

Clear

Enter

AM

AH

A)

AK
AX
AM

When you choose Show Control, a check mark (,j) appears to the left of
the command on the Settings menu. To stop displaying control charac
ters, choose the command againj the check mark disappears and control
characters are no longer displayed. When you open a new communica,
tions document, Show Control is checked.
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Edit Line

The Edit Line command lets you entet and edit an entite line of text
before transmitting it. You can use the mouse and keyboard commands
to select text and the insertion point. Selected text can be deleted but
not copied to the Clipboatd.

When you choose Edit Line, an entry box appears at the top of the com
munications document window:

til FiI' Edit Tronstor S,tting, Phone Window
;0 Trou,I.BY.Nod.. (eN)

Edit Line entry box-------~~.".~~o(~[~loi!i1"'~'"~I'~ine~,~Pre~-the<l~ler!:.!!di~M!I'S~~I"':t[OOe!!!...!u.....~..£corns~~ =J
Loom', Gr<ol lOOller ""'t"""t,
H.flflfHtHtflfH+f+fIIIHIIIIIIHHlltIIIHHIHIIIIH+fHllllf

e-t C<rOM "'" the Sir",":
The Sox<j Ibl,[ (SIr<rO; OOI-llI1~-The Grill Pool CfI!J1l'oo»tfri
00j lroo 11:00 to 2: 15 I", itldl "'" lroo 6 to II: 15 (", dlrtl!l'. i
t, ~.. the<lter o(ferl"l' coosisl o( t", corns 11th ,.((ee, in th
, bs Ibt,l (34l1elli"ll., 1m,; 01~3131), I'" "" "'" oft...
WI t" dJi [y (roo 3:00 to 6 I", IIWJJ IS per per«<I. Lig,t dishe
, ... Imi 1001, lroo 10 to IlcI1ig,l (", ofter-the<lter dlnl"l, At t
he Jo-oI"l' 1M, I'" "" "'" the finest ~ 1m"," 0[', 1"'[00
"l beers (roo Brltol", Pod KI"l C<r"! tffler<J. ["."....1" I (Ill.
SI. !\rHn's L",,:
~" Ibte[ I"tltes the (1lI(IJS [ITql Pool, the ",,[d-r«o:<ne<I

When you're ready to send the edited line, you transmit it by pressing
Return. The line appears in the document window below the status bar.
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Status Bar

The Status Bar command displays the status of the program in an area at
the top of the document window. The status bat tells you whether you're
on-line (tenninal mode) or in local mode and whether or not you have
Capture Text on. In addition, the status bar provides information about
the operation in which the communications application is currently cn~

gaged:
l1li If you're dialing, the status bar reflects the number of secOllds of dial

time left

III If you're sending a file, the status bar tells the number of blocks to be

sent, the number of blocks that have been sent, and the number of

errors in the transmission

III If you're receiving a file, the status bar tells the number of blocks to be

received, the number of blocks that have been received, and the

number of errors in the transmission

II The status bar tells you when you're importing files or pasting text
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If you've selected Local from the Settings menu (see "Local," in this
chapter), the status message "Local" is displayed in the status bar (if the
Status Bar command is active), and you're temporarily removed from
communications with the remote computer. Any text entered in Local
mode is not transmitted to the other system,
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If you're not in local mode, the message lIOnline" appears in the status
bar, indicating that you're in terminal mode. In terminal mode Apple.
Works OS is communicating with the remote computer and any text
typed while in this mode is transmitted to the other system.

If you've set text capture on with the Capture Text command, the
message "Capture:" appears in the status bar, followed by the number of
characters captured. If Capture Text isn't selected, the message nCap...
ture: Off' is displayed in the status bar.

When the starus bar is on, a check mark (v) appears on the menu.
Choose Status Bar again to tum the status bar off.

Local

When you choose Local from the Settings menu, a check mark (v)
appears to the left of the command, and the status message f1Local" is
displayed in the status bar (if the Status Bar command is active).
AppleWorks OS is temporarily removed from communications with the
remote computer, and any text entered in local mode is not transmitted
to the remote system.

When you choose the checked Local command, the check mark is
removed from the Local command and the status message ({Online"
appears in the status bar, indicating that youJre in terminal mode. In
terminal mode, AppleWorks OS is communicating with the remote
computer, and text entered in this mode is transmitted to the remote
system.
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Hardware

The Hardware command lets you give information about the specific
communications hardware that you're using.

When you choose Hardware from the Settings menu, a dialog box
appears:

Click to select your modem---~-H-

Click to specify the serial device
used by your modem

Hordwore Poromete

Modem

Click to specify the slot
containing your serial device

Slot

01
@2

06
07

Click to specify the type of modem
you're using

@Externol modem Initiolizotion
o Internol mOdem/ l-nT-EO.,..,V...,.OI--------

o No modem ( Concel) [ OK ]

Type initialization code here----I~======~================!1

If your computer is directly connected by a serial connection to the
second computer, click No Modem. Type any special initialization
sequence required by your modern or by the remote computer system in
the entry box.

When you've selected the appropriate settings, click OK.
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Communication...

The Communication command lets you specify the settings to be used
when information is exchanged between your computer and the remote
computer. Both your computer and the remote computer must use the
same communications setting; if you experience problems communicat..
ing with another computer, check that your system is using the correct
settings.

When you choose Communication from the Settings menu, a dialog box
appears~

Click to specify parity

Click to select baud ra

Communioation Parometers:

Baud Parit~ D Generate line feedso 110 @Hone D XOHlXOFF handshake
o 300 OOdd DEoho

te @ 1200 OEven 181 Tone Diol
02400 Dial time rno
0"'" [Do"""] ["~"'l ]09600 07 @1 [ OK

019200 @S 02
( Conoel )

/' I
/ I
Click to set number
of data bits

Click to specify number
of stop bits

220

Baud
The baud rate, approximately equal to the number of bits per second,
describes the rate at which information is transmitted and received. Most
modems operate at 300, 1200, or 2400 baud. Check the user's manual
that came with your modem to determine the baud rate at which your
modem operates, and click the appropriate setting. The default is 1200
baud.
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Parity
Parity describes the bit added to characters to check the accuracy of data
transmission. The bit is either a one, causing all characters to be odd; a
zero, causing all characters to be evenj or no bit is added. Most commer...
cial services use no parity bit, so the default is None.

Data Bits
Characters used by AppleWorks OS are represented by eight bits; when
you transmit data, however, characters can be transmitted as either
seven or eight bits. Data Bits describes the number of bits used for each
byte when you're transmitting information. The default is eight bits, the
number used by most commercial services.

Stop Bits
Stop Bits describes the number of bits used to separate characters during
transmission. Since most commercial services use one stop bit, the
default is one.

Dial Time
Type in the Dial Time entry box the number of seconds you want Apo
pleWorks OS to keep trying to dial a number (or redial a busy number)
before giving up the dial attempt.

Check boxes are also provided to select other protocols:

III Generate Line Feeds: Check this box to place line feeds after the

carriage return following each line of text. Youlll want to choose this

option if you're communicating with an IBM or compatible computer,

as those systems require a line feed following a carriage return to

signify the end of a line of text, whereas Apple computers don't. The

default is unchecked.

III XON/XOFF Handshake: Check this setting to ensure that successful

transmission is achievedl especially if youlre sending and receiving

files at 2400 baud or greater. XON/XOFF Handshake prevents loss of

information during transmissions by telling the other computer to

stop sending when your computer's memory fills up with the informa

tion it has received during transmission. It also tells the other com~

puter when it's okay to start sending information again. The default is

unchecked.
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III Echo: Check this setting to display on the screen a second copy <an

echo) of all data being transmitted. Older computer systems required

this setting to see a copy of information being transmittedi this is

generally not required on current systems, so the default is unchecked.

II Tone Dial: This setting tells your modem whether to use tone-dialing

or pulse-dialing. This setting defaults to checked.

When you've selected the settings you want, click OK.
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Phone Menu

Autodio I
Dial... aD
Hang Up aH
Answer Phone

The Phone menu contains commands for dialing phone numbers,
answering incoming transmissions, and disconnecting from a remote
system.

Autodial
The Autodial command tells AppleWorks OS to automatically redial
any telephone number that's busy.

When you choose Autodial, a check mark (...J) appears to the left of the
command on the menu, and any busy number is automatically redialed.
To turn off Autodial, choose the command when it's checked. The
check mark disappears from the menu, and AppleWorks OS only
attempts to dial a phone number once.

Dial ...
The Dial command lets you create and maintain an alphabetized
directory of frequently used names and telephone numbers. This com
mand also lets you automatically dial phone numbers from the directory.
If you're working with a new communications document, tell Apple'
Works OS what type of modem you're using with the Hardware com
mand first. The Dial command won't let you dial a number until you've
specified your Hardware settings and initialized your modem.

When you choose the Dial command, a dialog box appears. The Name
entry box contains the name HUntitled," which is highlighted, so you
can replace it quickly and easily by typing a new name. Press the Tab key
to move the insertion poiot to the Fast Dial eotry box, where you can
type in a character key to be used in combination with the Option key to
quickly dial the entry's phone number. Press Tab again to move the in
sertion point to the Number entry box, where you type in the phone
number you want to dial.
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(Settings)

( Add)

( Remove)

(Reploce)

¢ BioI )
Type name here--------+t[ Home IWoll Street-Wise IEJ

( Concel )

Type phone number here------t[LH:u;m;be~r~21~2;/9~9~1-~0~80~8;;;;;;;;;;~~;;~~(=~OK;;~)~

The communications parameters~ "
for the selected name and number Phone List: "

"'O....,pt"""io-n-·A--.A-pp'le'U's-er-s--';2'"40"O'-8"-H"-'1--'-''''
Click to select a name in the phone OPtion-B Bulletin Boord 2400-B-H-1
directory Option-C Compu-Quote 1200-B-H-1

Option-G Gomes Online 2400-8-H-1
Option-! InterFoce 1200-8-H-1
Option-M Shop by Modem 1200-8-H-1
Option-S Sport Hews 300-8-H-1
I, ,

Type a fast dial number
here, if you like

Click to dial a
selected number

Add
To add a name and number to the directory, type the name and phone
number in the Name and Number entry boxes. AppleWorks OS also lets
you include a fast-dial character with each name you put in the direc
tory. (A fast-dial character is a keyboard character that you press in
conjunction with the Option key to dial a number without having to
choose the Dial command.) To enter a fast-dial character, type the
character in the Fast Dial entry box.

When you've typed the name and number (and optional fast-dial
character) you want in the entry boxes, click Add to place them in the
directory. The name, fast,dial character, and communications settings
for the number appear in the directory list.

If you need to add a phone number to the directory that requires the use
of different settings from the current settings, click Settings and select
the appropriate settings for the telephone number from the Communica
tion command dialog box that appears.

Remove
To remove a telephone number from the directory, click the number in
the scroll list to select it and then click Remove. The entire entry
name, number, and optional fast-dial character-is removed from the di
rectory.
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Replace
To replace an old name or number in the directory, click the name in the
directory. The name appears in the Name entry box, the number in the
Number entry box, and the fast-dial character in the Fast Dial entry box.
Type the new name, number, or fast~dialletter,and click Replace.

SeUings
You can assign different communications settings to individual phone
numbers by clicking rhe phone number in the list and then clicking
Settings. The Communication dialog box appears, allowing you to
change the communications settings for the selected phone number.
(AppleWorks OS displays the last settings you specified wirh rhe
Communication command.) For more information on the options
offered by this dialog box, see uCommunication/' in this chapter.

Dial
To automatically dial a number, click the number in the directory and
then click Dial, or double-click the number. Your modem dials the
number, and AppleWorks OS returns you to the document window.

To save the numbers you've entered in the directory and return to the
communications document window without dialing a number, click OK.
If you click Cancel, none of the information you entered will be saved.

To dial a number without entering it in the list, enter it in the number
entry box without typing in a name and click Dial.

Hangup

The Hangup command disconnects your modem from the remote
computer, ending the communications session.

Answer Phone

The Answer Phone command lets you set up your Apple lIos as a
remote computer for other computers to call. \Vhen you choose Answer
Phone fwm the Phone menu, a check mark <'I) appears beside the
command on the menu. Your computer is left connected to the tele~

phone system, waiting for other computers to call. AppleWorks OS
answers all incoming calls on the first ring. To stop answering incoming
calls, choose the checked Answer Phone command. The check mark is
removed.
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Special Installation Information

About the Apple IIGS
System Folder

The Apple lIos operating system, OS/OS, uses a special folder to
maintain information used by the system software and by different
applications (such as AppleWorks OS) that run under it. This folder is
called the System folder, and it's located on the AppleWorks OS System
disk that came with your copy of AppleWorks OS.

The System folder contains a number of important files and folders.
Some of the files contain the actual operating system programs; some of
the folders contain other important software that your application
programs use for things like creating menus and windows. You'll probably
find that you need to know about three of the folders included in the
System folder, so they're discussed in detail below.

The Desk,Accs Folder

The Desk.Aces folder contains all the desk accessory programs on your
system. A desk accessory is a mini-application, like a calculator or
phone-dialer, that you can use while running a full application program
(like AppleWorks OS) without leaving the main application.

There are two types of desk accessories-dassic desk accessories (CDA's)
and new desk accessories (NDA's). CDA's are text-based and menu
driven; you can access them by holding down the cJ and Control keys
and pressing Esc. This displays the Desk Accessories menu, which lets
you choose the classic desk accessories you want to use. If you haven't
put any desk accessories on your system, the Control Panel and Alter
nate Display Mode will be the only items on the Desk Accessories menu
besides Quit.

New desk accessories are graphic-based and appear on the pull-down
menu when you run Apple lIOS-specific software. These desk accessories
closely resemble desk accessories on the Macintosh computer.

You can install any desk accessories you want to use on your system by
dragging the desk accessory files into the Desk.Accs folder. The next
time you start up your system, the system will recognize both the classic
and new desk accessories and display them on their respective menus.
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The Fonts Folder

The Fonts menu contains all the font files used by Apple lIOS-specific
applications. It's these font files that let you choose different typefaces,
like Geneva, New York, and London. Actually, each typeface can have a
number of different font files (different sizes of the font) associated with
it-all the font files of a certain type are collectively called a font family.
For example, the following font files all represent different point sizes of
the Geneva font:

III Geneva. 10 (10 point Geneva)

III Geneva.12 (12 point Geneva)

III Geneva.14 (14 point Geneva)

III Geneva.18 (18 point Geneva)

III Geneva.24 (24 point Geneva)

You can use any fonts you want with your system by placing the appro~

priate font files in the Fonts folder. The next time you start up your
Apple lIos, the system will recognize the fonts and display the name of
each font on the Font menu of the application program you're using. The
names of the fonts will also appear in the list box of the Choose Font
command (see ilChoose Font/' in chapter 1). The different sizes for each
font will be offered on the Size menu of the application, with those sizes
for which there is an actual font file in the Fonts folder displayed in
boldface.

Importantl There are two fonts that must be in the Fonts folder of
your System folder or you won't be able to run AppleWorks GS.
These are Geneva.12, which is the default font for the word processor
and page layout application; and Monaco.9, which is the font used by
the communications application. Shaston.8, the font used by the
database and spreadsheet applications and the default font for the
graphics application, is built into the ROM of your Apple IIOS.

In addition to the two fonts needed by your system to run AppleWorks
GS, the About AppleWorks GS command uses three other fonts to
display information in its dialog box-New.York.12, New.York.24, and
Geneva.9. Removing these fonts causes the information to be displayed
in a less legible font.

fl

230 Appendix A



Abollt the Apple 11m;
Control Panel

The Drivers Folder

The Drivers folder contains the files used by your system to print
documents with different printers and different printer interfaces. These
files are called printer drivers. When you have a certain printer driver or
printer interface file in your Drivers folder, that printer or interface
appears in the dialog box displayed by the Choose Printer command.

The Control Panel is a special program built into the Apple lIos that
lets you control the speed of your computer's microprocessor, the color of
the text and background on your monitor, the speed of your mouse, and
the volume of the speaker. You use the Control Panel to change the way
your slots and ports arc configured for printers and modems, and to
activate AppleTalk if you're on an AppleTalk network.

The instructions below explain how to enter, and choose options in, the
Control Panel.

Entering the Control Panel

Ifyou've already started up your Apple IIos, you can get to the Control
Panel by holding down the 0 and Control keys and pressing the Esc key.
The Apple lIos Desk Accessories menu appears.

Press the Up Arrow key until Control Panel is highlighted and press
Return to enter the Control Panel.

If you haven't started up your Apple lIos, hold down the Option key
while you turn on the power switch. A menu appears. Press 1 to enter
the Control Panel.

Choosing Control Panel Options

The Control Panel menu displays all the hardware system features of the
Apple IIos that you can adjust. To choose an option on the menu:

1. Press the Up or Down Arrow key to highlighllhe option you want.

2. Press Return to choose the option.

When you press Return, you'll see a new menu appear for the option you
chose.

Special Imtallarion Information 231



Special Installation Information
As with the Control Panel menu, you can highlight options with the Up
and Down Arrow keys.

To change one of the settings:

1. Press the Up or Down Arrow key to highlight the option you want.

2. Press the Right or Left Arrow key until the option setting you want is
displayed.

3. Press Return to confirm the setting and return to the Control Panel
menu.

To leave the Control Panel:

1. Press the Up or Down Arrow key to highlight Quit.

or

Press the Esc key to highlight Quit.

2. Press Return.

If you entered the Control Panel by pressing Command-Control-Esc
from an application, you'll return to the application. If yOll entered the
Control Panel by pressing Option-Control-Reset, your Apple IIos will
start up the application in your startup drive.

Note: Some changes to Control Panel settings require that you tum
your Apple IIos completely off and then on again before the changes
take effect.

For more information on the Control Panel, see appendix A, "The
Control Patlel Program," in the Apple lIos Oume,.', Guide.
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Using AppleTlilk with
AppleWorks GS

If you're working in an environment where a lot of people are using
Apple IIGS computers or a combination of Macintosh and Apple IIGS
computers (such as a school or officeL your group may be interested in
using an AppleTalk network--or you may already be using AppleTalk.
An AppleTalk network is a system that lets a group of Apple computer
users link their computers together so that they C<1I1 exchange documents
and share peripheral devices such as printers.

If you plan ro use AppleTalk with your Apple IIGS, you'll want to make
sure that your computer is properly connected to the AppleTalk network
and that your computer's Control Panel is configured to use AppleTalk.

To connect your computer to the AppleTalk network, plug the Apple
Talk cahle into the printer port in the back of your Apple IIGS. For more
information, consult your Apple IIGS OHmer's Guide.

To set up your Control Panel for use with AppleTalk, follow these
instructions:

1. Enter the Control Panel program.

See "About the Apple IIGS Control Panel," in this appendix for
more information on using the Control Panel.

2. Press the Up or Down Arrow key to highlight Slots. and press Return.

The Slots menu appears.

3. If your AppleTalk cable is connected to the printer port. press the
Down Arrow key until Slot 1 is highlighted; if your AppleTalk cable is
connected to the modem port. press the Down Arrow key until Slot 2
is highlighted. Then. press the Right Arrow key until Your Card ap
pears.

4. Press the Down Arrow key until Slot 7 is highlighted. and then press
the Right Arrow key until the Built-in AppleTalk setting appears.

5. Press Return to save the settings and return to the Control Panel.

6. Press the Down Arrow key until Quit is highlighted (or press Esc) and
press Return to exit the Control Panel.

Special Installation Infon)]ation 233



Special Installation Information
7. Turn your Apple IIGS completely off for about 30 seconds, then turn it

on again.

This changes the way the slots in your Apple lIes work to corrrespond
with your changes to the Control Panel settings.

Using AppleWorks GS
with a laserWriter

234

If you're planning to lise a LaserWriter printer with your Apple Hos, use
the following instructions to properly configure your system.

First, make sure your Apple lIes is configured to support AppleTalk. (To
use a LaserWriter, you'll have to be set up on an AppleTalk network.)
Make sure you've connected an AppleTalk cable to your printer port and
connected the cable to the LaserWriter.

Next, you'll want to use the Control Panel program to configure your
slors to support a printer port and AppleTalk.

1. Enter the Control Panel program.

See "About the Apple lIes Control Panel," in this appendix for more
information on using the Control Panel.

2. Press the Up or Down Arrow key to highlight Slots, and press Return.

The Slots menu appears.

3. If your AppleTalk cable is connected to the printer port, press the
Down Arrow key until Slot 1 is highlighted; if your AppleTalk cable is
connected to the modem port, press the Down Arrow key until Slot 2
is highlighted. Then, press the Right Arrow key until Vour Card ap'
pears.

4. Press the Down Arrow key until Slot 7 is highlighted. Press the Right
or left Arrow key until Built·in AppleTalk appears.

5. Press Return to save the setting and return to the Control Panel menu.

6. Press the Down Arrow key until Quit is highlighted and press Return
to exit the Control Panel.

7. Turn your Apple IIGS completely off for about 30 seconds, then turn it
on again.
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This changes the way the slots in your Apple lIos work to corrrespond
with your changes to the Control Panel settings.

When you're finished configuring your Control Panel and restarting your
Apple lIos, turn on the LaserWriter. When you need to print from Ap
pleWorks OS, usc the Choose Printer command on the File Menu of any
of the applications to choose LaserWriter as your printer driver and
AppleTalk as the printer port. For more information, see lfChoose
Printee' in chapter 1, UApple\Vorks OS Commands,"

Special Installation [n[onnation 235



Special Installation Information
Setting lip II Modem for
Use with ApplllWorks GS
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The AppleWorks OS communications application works with a numbet
of different modems, including Apple and Hayes-compatible modems.
To set up your modem for use with AppleWorks OS, first follow the
instructions in the user's manual that came with your modem to physi~

cally install the modem, connecting it to your computer. Next, make
sure that you've configured the Control Panel to support the modem.
The following instructions assume that you've installed your modem to
the Apple Hos modem port. If your modem requires that you install it
internally or to another port, consult the user's manual that came with
your modem.

1. Enter the Control Panel program. (See "Aboutthe Apple llGS Control
Panel," in this appendix for more information on using the Control
Panel.)

2. Press the Up or Down Arrow key to highlight Slots, and prass Return.

The Slots menu appears.

3. Press the Down Arrow key until Slot 2 is highlighted. Press the Right
Arrow key until Modem Port appears.

4. Press Return to return to the Control Panel.

You've now configured your modem port. Next, you'll want to set up the
modem port to support your modem's communications parameters:

1. Press the Up or Down Arrow key until Modem Port is highlighted, and
press Return.

2. The Madam Port menu appears.

Use this menu to configure your modem according to the parameters
listed in the user's manual that came with your modem.

3. Press Return to return to the Control Panel.

4. Press the Up or Down Arrow key until Quit is highlighted (or pross
Esc), and pross Return to exit the Control Panel.

When you create a communications application, be sure to use the Hard..
ware command on the Settings menu to select the appropriate hardware
parameters for use with your modem.
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Functions and Formulas

The AppleWorks OS database and spreadsheet applications both let you
use functions and formulas in database fields and spreadsheet cells.

A caleulated field in a database contains a field formula, which calcu
lates the value of the field based on other values. For example, a caleu
lated field in a database might contain the formula "[fieldl] + [fieldZ]".
In this case, the caleulated field will display the sum of the values in
fieldI and fieldZ.

A spreadsheet cell can contain a cell formula, which caleulates a value
for the cell based on other values. For example, a spreadsheet cell might
contain the formula u=Al +A2". In this case, the spreadsheet cell will
display the sum of the values in cells AI and AZ.

A field formula or a cell formula contains one or more elements, includ,
ing constant values, references to other cells or fields, and functions.
These elements can be combined using a variety of operators, resulting
in a value that is displayed in the database field or spreadsheet cell.

One of the elements of a formula can be a function. The AppleWorks
OS database and spreadsheet applications provide a variety of built-in
functions, which are like empty formulas that you complete with
different values (called arguments) to perform complex caleulations on
those values.
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Furwtiolls ill the Data
base and Spreadsheet
Applications

AppleWorks OS supports 73 functions for the spreadsheet application
and 69 functions for the database application. These functions are listed
in the section flFunctions by Categoryll and explained in detail in the
"Alphabetical Directory of Functions" in this chapter. The following
sections describe the elements and operations of a function.

Parts of a Function

Each AppleWorks OS function consists of a function name, followed by
one or more arguments surrounded by parentheses. An argument is a
data value used by the function in its calculations to produce a new
value. For example, the Sum function takes a list of number values as its
arguments and produces the sum of those values.

Function name ..).••••••••• / ••••Z..Z.
1~.~.~!J)(~.~::~~J.~,lQ.Q)... ~
ParenthesJs. . -.------- -/

"-,, Arguments
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In both the database and spreadsheet applications, arguments can be
either variables or constants. A variable value is a value that may change
depending on other values. In AppleWorks OS, variables can be
references to fields (in the database application) or cells (in the spread
sheet application), because both fields and cells can contain values that
vary depending on other conditions and values.

A constant value is a value that doesn't vary. Constants may be either
numeric or string constants. A numeric constant is any number value. A
string constant is any series of characters surrounded by quotation marks.
You can use either double or single quotation marks to denote a string
constant.
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Arguments for Functions

Arguments arc the values that you provide to a function so that it can
perform its calculations. Different AppleWorks OS functions require
different types of arguments. These arguments fall into several categories:
expression, number, llUincric list, range (of spreadsheet values), string,
string list, logical valuc, logical list, date, and financial values.

Expression
An expression can be any value---the contents of a cell or field, a
calculated value, even the value returned by another function. The word
expression is used in this section to refer to a value that is calculated, or
to a numeric or string value.

Number
Some functions require one or more numeric values as arguments. Each
numeric value may be provided as a single value or as a numeric expres~

sion (including another function or group of functions) which evaluates
to a numeric value. Numeric constants are expressed as numbersi
numeric variables can be either spreadsheet cells or database fields
formatted to contain numeric values. For example, the Sin function
requires a numeric value as an argument. You could ask for Sin(2),
Sin(lO/5), or Sin(AI-2)-where cell Al contains the value 4 - and the
same resulting value will be produced.

Numeric Lis!
Some functions require a list of numeric values as arguments. Each
numeric value may be provided as a single value or as an expression that
evaluates to a number. For example, the Sum function takes a list of
numeric values and returns the sum of the values.

Range
Some functions require a range of spreadsheet values. These values are
specified by listing the reference of the first cell in the range, followed by
two dots (.. ), followed by the reference of the last cell in the range. For
example, the range Al..AlO includes the cells between cell Al and cell
AlO, inclusive.
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String
Some functions require a string argument, which is a group of alpha~
numeric characters. For example, the Len function returns the length
(number of characters) of a string. If you supply a string constant as an
argument, the string should be surrounded by quotation marks. (The
quotation marks are not considered part of the string.)

String List
Some functions require a list of one or more strings. For example, the
Concar function takes one or more strings as an argument, and returns a
single string which is constructed by concatenating (joining together)
the strings provided as arguments.

Logical Value
A logical value is an expression that evaluates to True or False. (Apple'
\'\Iarks OS encodes the value True as the numeric value 1, and the value
False as the numeric value O. Any non,zero value is considered True.)
Some functions require one or more logical values as arguments, and
return the value True or False. For example, the Not function requires a
logical value as an argument and returns the opposite value as a result.

Logical List
Some functions require a list of one or more logical values. For example,
the Or function requires a list of logical values and returns the value
True if any of the values in the list is True.

Date
Some functions require a date as an argument and return a value based
on that date. For example, the Month function takes a date as an
argument, and returns a string that represents the month part of the
date. A date is expressed as a stringj examples of date strings are
"7/21/88" and "July 22,1988".

financial Arguments
AppleWorks OS financial functions return values based on current or
projected financial values. For example, the Prnt function calculates the
periodic payment necessary to amortize a loan aCross a fixed number of
periods. The Pmt function requires three arguments: the principal
amount of the loan, the interest rate of the loan, and the number of
periods that make up the term of the loan.
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Spreadsheet Cells or Database Fields

You can provide the argumenrs ro AppleWorks OS functions by typing
in constant values or by referring to spreadsheet cells or database fields.
When you refer to spreadsheet cells or database fields, be careful that the
cell or field contains data of the appropriate type.

For example, if the AppleWorks OS function requires a numeric value,
be sure to provide as an argument a spreadsheet cell that contains a
numeric value or a database field that is a numeric type. If you provide
arguments that contain data of an incorrect type, an error message may
be returned. Whenever possible, however, AppleWorks OS attempts to
evaluate the expression, even if the arguments are the wrong type. For
example, if a number is expected by a function and a string is provided,
the string is treated as the integer O. If a string is expected and a number
is provided, the number is considered a null string elll

).
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Functions by Catllgory
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The following is a list of the AppleWorks OS functions by category.

Arithmetic Functions

Abs(number)

Returns the absolute value of number.

Exp(number)

Returns the value c raised to the power of number.

Frac(number)

Returns the fractional part of number.

In!

Returns the value infinity,

Int(number)

Returns the integer part of number.

Ln(number)

Returns the natural logarithm of number, which must be a positive value.

Log(number)

Returns the base 10 logarithm of number.

Mod(numberl, number2)

Returns m'mberI modulo "umber2 (the remainder of numberl divided by
number2).

Product(numeric list)

Returns the product of all the numbers in "umeric list.

Round(numberl, number2)

Returns the number1 rounded to the number of decimal places specified
by number2.
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Sgn(number)

Returns the sign of number. If number is positive, returns 1. If number is 0,
returns O. If number is negative, returns -1.

Sqrt(number)

Returns the positive square root of number. Ifnumber is negative, the
function returns ERROR.

Trigonometric Functions

Acos(number)

Returns in radians the arccosine of number.

Asin(number)

Returns in radians the arcsine of number.

Atan(number)

Returns in radians the arctangent of number.

Cos(number)

Returns the cosine of number. The function expects number to be
expressed in radians.

Degrees(number)

Returns the number of degrees equal to number radians. The argument
number should be entered in radians.

Pi

Returns an approximation of the mathematical constant j( (pi).

Radians(number)

Returns the number of radians equivalent to number degrees. The
function expects number to be expressed in degrees.
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Sin(number)

Returns the sine of number. The function expects number to be expressed
in radians.

Tan(number)

Returns the tangent of number. The function expects number to be
expressed in radians.

Statistical Functions

Avg(numeric list)

Returns the average of numeric list.

Count(list)

Returns the number of items in list.

Max(numeric list)

Returns the maximum value in numeric list.

Min(numeric list)

Returns the minimum value in numeric list.

Random(number)

Returns a random number between 0 and the specified argument
(number). If the argument is 0 or 1, then RandOlll retunls a random value
grearer rhan or equal to 0 and less than 1.

Stdv(numeric list)

Returns the standard deviation of the values in numeric list.

Sum(numeric list)

Returns the sum of the values in numeric list.

Var(numeric list)

Returns the variance of the numbers in the arguments in numeric list.
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Financial Functions

FV(payment, rate, term)

Calculates the future value of an investment.

IRR(guess, numeric range)

Calculates the internal rate of return on a series of irregular periodic cash
flows (numeric range).

NPV(rate, numeric range)

Returns the net present value of future payments (numeric range).

Pmt(pv, rate, term)

Calculates the periodic payment necessary to amortize a loan across a
fixed number of periods.

PV(payment, rate, term)

Calculates the present value of a series of equal periodic payments or of a
single investment.

Rate(Iv, pv, term)

Calculates the interest rate of return on an investment involving
constant, equal periodic payments or a single [ump,sum payment.

Term(payment, rate, Iv)

Returns the number of periods required to amortize a loan involving
constant periodic payments.
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String Functions

Concat(string list)

Returns a single string produced by concatenating string list.

Len(string)

Returns a number representing the length of string.

Lower(string)

Returns string with all characters in lowercase.

Null

Returns a null string ('01).

Position(string. string)

Returns a number corresponding to the position where the first string
argument first occurs in the second string argument.

Proper(string)

Returns a string with the first character displayed in uppercase and all
other characters displayed in lowercase.

SubStr(string. start, length)

Returns a substring specified by the two numeric arguments.

Upper(string)

Returns string with all characters in uppercase.
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Conversion Functions

Asc(string)

Returns the ASCII value of first character in string.

Chr(number)

Returns the string value corresponding to the ASCII value specified by
number.

Slring(number)

Returns a string equivalent of number.

Val(slring)

Returns the numeric equivalent of string.

Date Functions

Dale(number)

Returns the string date equivalent of number.

Day(slring)

Returns a number representing the day part of the date expressed in
string.

Monlh(slring)

Returns a string representing the month part of the date expressed in
string.

NumDale(slring)

Returns an integer value representing the date expressed in string.

Today

Returns a string representing taday's date.

Weekday(string)

Returns a string representing the weekday of the date expressed in string.
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Vear(string}

Returns a number representing the year of the date expressed in string.

Logical Functions

And(logicallist)

Returns numeric value 1 (true) if all values on logical list are true (or
evaluate to numeric value 1).

False

Returns numeric value O. False takes no arguments.

l!(Iogical expression, expression1, expression2)

If logical expression is true (or evaluates to numeric value of 1 or any other
non,zero value), this function returns the first expression valuej other~

wise, it returns the second expression value.

IsBlank(expression}

Returns numeric value 1 (true) if expression is a null string.

IsEmpty(expression)

Returns numeric value 1 (true) if expression is empty.

IsError(expression)

If expression evaluates to ERROR, this function returns the value 1
(true).

IsNA(expression}

Returns the value 1 (true) if the expression contains the value NA.

IsNumber(expression)

Returns numeric value 1 (true) if expression is a number.

IsString(expression}

Returns numeric value 1 (true) if expression is a string.
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Not(expression}

Returns numeric value 1 (true) if expression is false (or evaluates to zero
value).

Or(logicallist)

Returns numeric value 1 (true) if any of the values in logical list are true
(or evaluate to numeric value I).

True

Returns the numeric value 1 (true). True takes no arguments.

Special-Purpose Functions

Alert(String)

Returns an alert box with string displayed in the box.

Choose(number, list)

Returns the numeric value in list that is in the position specified by
number.

Error

Returns the value ERROR.

HLookup(value, range, offset)

Looks up value in a table contained in the spreadsheet range. Finds
largest value in first row of range that is less than or equal to value, and
then returns the value found offset rows below. (Assumes that the first
row of range is sorted in increasing order.)

NA

Returns the value N{A.

VLookup(value, range, offset)

Looks up value in a table contained in the spreadsheet range. Finds
largest value in first column of range that is less than or equal to value.
and then returns the value found offset columns to the right. (Assumes
that the first column of range is sorted in increasing order.)
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Alphabetical Directory
of functions
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The following is an alphabetized directory of the AppleWorks OS
functions. This directory includes an explanation and examples of each
of the functions supported by the AppleWorks OS spreadsheet and
database applications.

Abs(number)

Returns the absolute value of n1~mber.

Examples:
Abs(-I) returns 1.

Abs( I) returns 1.

Abs(O) returns O.

Abs(AI) returns the absolute value of the number in spreadsheet cell
AI.

Abs([fieldname]) returns the absolute value of the number in database
field specified.

Acos(number)

Returns in radians the arccosine of number.

Examples:
Acos(-O.S) returns 2.094 (2IT13 radians).

Acos(AI) returns the arccosine of the value in spreadsheet cell AI.

Acos([fieldname]) returns the arccosine of the value in database field
specified.

Alert(Slring)

Returns an alert box with string displayed in box.

Examples:
The formula

If(IsError(AI), Alert("ERROR IN CELL AI"), NULL)

returns an alert box with the message "ERROR IN CELL AI" if an error
is found in spreadsheet cell AI.
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And(logicallist)

Returns true if all values in logical list are true.

Examples:

And( I+I =2, 2+ 2=4) returns true.

And(Al =Bl, Cl =01) rerurns true if the value in cell Al equals the
value in cell Bl and the value in cell Cl equals the value in cell 01.

Asc(string)

Returns the ASCll value of the first character in string.

Examples:
Asc("A") returns 65, the ASCll value of the character "A".

AscCtalphabet") returns 97, the ASCII value of the character lIa",

Asc(A1) returns the ASCll code of the first ch~racter in spreadsheet cell
AI.

Asc([fieldname]} returns the ASCll code of the first character of the
value in database field specified.

Asin(number)

Returns in radians the arcsine of number.

Examples:

Asin(-0.5) retums -0.524 (-rr/6 radians).

Asin(Al) returns the arcsine of the value in spreadsheet cell AI.

Asin([fieldname]} returns the arcsine of the value in database field
specified.
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Atan(number)

Returns in radians the arctangent of number.

Examples:
Atan(l) returns 0.785 (1(/4 radians).

Atan(AI) returns the arctangent of the value in spreadsheet cell AI.

Atan([fieldnameJ) returns the arctangent of the value in specified
database field.

Avg(numeric list)

Returns the average of numeric list.

Examples:
Avg(l, 3. 5) returns 3.

Avg(AI..AIO) returns the average of values in cells Al through AIO
(ignores empty cells in a range).

Avg([fieldl]. [field2], ...) returns the average of the values in database
fields specified.

Choose(number. numeric/string list)

Returns the numeric value in numeric/string list that is in the position
specified by the first argument.

Examples:
Choose(2. 5. 6. 8.) returns the value 6 (the second value on the list).

Choose(3. AI..AIO) returns the third value in the list of spreadsheet
cells from Al through AIO (ignores empty cells in ranges).

Choose(3. [field I], [field2J.... ) returns the third value of the list of values
found in the specified database fields.
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Chr(number)

Returns the stting value corresponding to the ASCII value specified by
number.

Examples:
Cht(65) returns "A", the character represented by ASCII value 65.

Chr(97) returns "a", the character represented by ASCII value 97.

Chr(Al) returns the character represented by the ASCII code of the
value in spreadsheet cell AI.

Chr([fieldname]) returns the character represented by the ASCII code in
the database field specified.

Concat(string list)

Returns a single string produced by concatenating string list.

Examples:
Concat(C1see'\ II theil, II cat"} returns the single string usee the cat ll

,

(Whereas ConcatC'see'\ Uthe'\ Heat") returns the single string IIseethe..
cat",}

Concat(flhello", 1I world"} returns the single string Ilhello world".

Concat(AI, A2, A3) returns a single string by combining the values in
spreadsheet cell AI, A2, and A3.

Concat([fieldI], [field2], [field3]) returns a single string by combining the
values in the database fields specified.

Cos(number)

Returns the cosine of number. The function expects number to be
expressed in radians.

Examples:
Cos(I.047) returns 0.5.

CostAl) returns the cosine of the value in spreadsheet cell AI.

Cos([fieldname]) returns the cosine of the value in database field
specified.
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Count(list of cells or fields)

Returns the number of cells or fields containing values.

Examples:
Count(Al..AI0) returns the number of spreadsheet cells in the range
Al through AID that contain values.

Count([fieldl], [field2], ... ) returns the number of database fields that
contain values among the fields listed.

Date(number)

Returns the string date equivalent of Humber. The value 1 returns the
date uJan. 1, 1900", the value 2 returns IIJan. 2, 1900", and so fonh.

Examples:
Date(10894) returns the date "Oct. 29, 1929".

Date(32873) returns the date "Jan. 1, 1990".

Date(Al) returns the date equivalent of the numeric value in spread
sheet cell AI.

Date([fieldnameJ) returns the date equivalent of the numeric value in
the database field specified.

Day(string)

Returns a number representing the day portion of the date represented
by string.

Examples:
Day("Jan. 24, 1988") returns 24.

Day("Jan I, 1989") returns 1.

Day(Al) returns the day part of the date in spreadsheet cell AI.

Day([fieldnameJ) returns the day part of the date value in the database
field specified.
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Degrees(number)

Returns the value of number in degrees. The argument number should be
entered in radians.

Example:

Degrees(Pi) returns the value 180, the number of degrees equivalent to

pi radians.

Degrees(3.14) returns the value 179.9087476, the number of degrees
equivalent to 3.14 radians.

Error

Returns the value ERROR in red.

Example:

Error returns value ERROR.

Exp(number)

Returns the value c raised to the power of number. The symbol e fepre,
sents the mathematical constant 2.7182818... , the base of the natural
logarithm. The EXP function is the inverse of the natural logarithm
function LN.

Examples:

Exp(-1) returns .368.

Exp(0) returns 1.

Exp (1) returns 2.718.

Exp(A1) returns value of e, raised to the numeric value found in spread.
sheet cell A 1.

Exp([ficld]) returns value of e, raised to the numeric value found in the
specified database field.
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False

Returns the value O. False takes no arguments.

Example:
False returns value False (0).

Frac{number)

Returns the fractional part of number.

Examples:
Frac(3.5) returns 0.5.

Frac(2.75) returns 0.75.

Frac(Al) returns the fractional part of the value in spreadsheet cell AI.

Frac([fieldname)) returns the fractional part of the value in the database
field specified.

FV{payment, rate, term)

Calculates the future value of an investment. Payment is the payment,
the amount of the periodic investment; the payment should be entered
as a positive value, and a leading dollar sign is optional. Rare is the
interest rate; the rate may be entered as a percent value (such as 10%) or
a decimal value (such as 0.10). Term is the number of periods making up
the term of the investment.

Example:

FV(5000, 8%, 20) returns the future value of an investment of $5000 at
an annual rate of 8% after 20 years.
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Hlookup(value. range. offset)

Looks up val"e in a table contained in the spreadsheet range. Finds the
largest value in the first row of the range which is less than or equal to
val"e, and then returns the value found offset rows below. (Assumes that
the first row of the range is sorted in increasing order.)

Example:
HLookup(2, A1..04, 3) returns the value found using this method:

iii finds largest value in row Al to 01 which is less than or equal to 2

.. finds cell 3 rows down from top of range (the offset value), and

returns the value in that cell.

II(logical expression. expression1. expression2)

If logical expression is true, this function returns expressionl i otherwise, it
returns expression2.

Examples: ..
If(A1<90, "B", "A") returns the value "B" if the value in cell Al is less
than 90j othenviseJ it returns the value CIA."

If(Al =BI, 10.5, 12.75) returns the value 10.5 if the value in cell Al is
equal to the value in cell B1; otherwise, it returns the value 12.75.

Inl

Returns the value of infinity.

Int(number)

Returns the integer part of n"mber.

Examples:
Int(3.5) returns 3.

Int(2.75) returns 2.

Int(Al) returns the integer part of the value in spreadsheet cell Ai.

Int([fieldname]} returns the integer part of the value in the database field
specified.
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IRR(guess, numeric range)

Calculates the internal rate of return on a series of irregular periodic cash
flows (numeric range). The internal rate of return is the rate that causes
the net present value of the cash inflows from an investment to equal the
cost of the investment. The guess parameter is your best guess of the
approximate rate of returo; the IRR function uses this guess as the
starting point for its calculations. You can enter the guess parameter as a
decimal value or as a percentagej the values 10% or 0.10 would be
treated as the same value. Use IRR to compare the attractiveness of
investment opportunities.

Examples:

IRR(O.IO, AI"AIO) returns the internal rate of return on an investment
that pays the periodic values stored in spreadsheet cells Al through AIO.
The guess is .1, meaning that you think the rate is approximately 10%.

IsBlank(expression)

Returns numeric value 1 (true) if expression is a null string.

Example:

IsBlank(AI) returns value I if cell Al contains no value.

IsEmpty(expression}

Rerurns true if the specified cell, field, or expression is empty.

Examples:

IsEmpty(AI) returns true if the cell Al contains no value.

IsEmpty([Fieldl]) returns true if Field I contains no value.

IsError{expression)

Returns the value I (true) if expression evaluates to ERROR.

Example:
IsError(SQRT(AI) returns I (true) if the value in cell Al is less than 0,
since attempting to evaluate the square root of a negative value produces
an error.
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IsNA(expression)

Returns the value I (tcue) if the parameter value is the special N/A
value.

Example:
IsNA{A3) returns I if the cell A3 contains the special value N/A.

IsNumber(expression)

Returns true if expression (a cell, field, or expression) is a number.

Examples:
IsNumber{AI) returns tcue if the cell Al contains a number value.

IsNumber{[Fieldl]) returns tcue if the field named Fieldl contains a
number.

IsString(expression)

Returns true if expression (a cell, field, or expression) is a string.

Examples:
IsString{AI) returns tcue if the cell Al contains a string value.

IsString([Fieldl]) returns tcue if the field named Fieldl contains a string.

Len(string)

Returns a number representing the length of string.

Examples:
Len(IlCat'J) returns 3.

Len("Hello") returns 5.

Len{AI) returns the length of the string value in spreadsheet cell AI.

Len{[fieldname]) returns the length of the string value in database field
specified.
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Ln(number)

Returns the natumllogarithm of number (which must be a positive
value). The Ln function is the inverse of rhe Exp function.

Examples:
Ln(l) returns numeric value O.

Ln(lOO) returns numeric value 4.605.

Ln(O) returns INF.

Ln(A I) returns natumllog of numeric value found in spreadsheet cell
A!.

Ln([fieldJ) returns natural log of numeric value found in database field.

Log(number)

Returns the base 10 logarithm of number.

Examples:
Log( I) returns numeric value O.

Log(IOO) returns numeric value 2.

Log(O) returns INF.

Log(AI) returns common log of numeric value found in spreadsheet cell
A!.

Log([fieldJ) retums common log of numeric value found in database
field.

Lower(string)

Returns string with all characters in lowercase.

Examples:
Lower(flCAT") returns string Ileat",

Lower(AI) returns string in spreadsheet cell AI, with all characters
converted to lowercase.

Lower([fieldJ) returns string in database field, with all chamcters con
verted to lowercase.
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Max(numeric list)

Returns the maximum value in numeric list. The elements in the numeric
list can include spreadsheet cell ranges.

Examples:
Max(2, 10,4,6) returns 10.

Max(Al..AIO) returns the maximum value found in the range of
spreadsheet cells from Al through A1O, ignoring empty cells and cells
containing strings.

Max(2, 3, Al..AS, 89) returns the maximum value found on the list.

Max([fieidIJ, [field2], ... ) returns the maximum value in the database
fields specified.

Min(numeric list)

Returns the minimum value in numeric list. The elements of the numeric
list can include spreadsheet cell ranges.

Examples:
Min(2, 10,4,6) returns 2.

Min(Al..AIO) returns the minimum value found in the range of
spreadsheet cells from AI· through A1O, ignoring empty cells and cells
containing strings.

Min(2, 3, Al..AS, 89) returns the minimum value found on the list.

Min([fieldI], [field2], ...) returns the minimum value in the database
fields specified.
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Mod(numherl, numher2)

Returns number1 modulo n",nber2 (the remainder of number1 divided by
n",,,ber2).

Examples:
Mod(10, 3) rerurns numeric value 1.

ModO, 0) returns value ERROR.

Mod(Al, A2) returns remainder when the numeric value found in
spreadsheet cell Al is divided by value in spreadsheet cell A2.

Mod([fieldl], [fieid2]) returns remainder when numeric value found in
database fieldl is divided by value found in database field2.

Month(string)

Returns a string for the month portion of the date represented by string.
The string may be expressed in any of these forms: mm/dd/yy; mm/dd/
yyyy; Mon. dd, yyyy; Month dd, yyyy. .

Examples:
Month("Jan. 24, 1988") returns "Jan."

Month("2/1/89") returns "Feb."

Month(Al) returns the month portion of the date in spreadsheet cell
AI.

Month([fieidname]) returns the month portion of the date value in the
database field specified.

NA

Returns the value N/A.
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Nol(expression)

Returns 1 (true) if expression is false (returns a zero value).

Examples:
Not(O) returns value 1.

Not(l) returns value O.

Not(lO) returns value O.

Not(Al) returns value I if value in spreadsheet cell Al evaluates to 0;
otherwise returns value O.

Not([field]) returns value I if value in database field evaluates to 0;
othenvise returns value O.

NPV(rale, numeric range)

Returns the net present value of future payments. Rate represents a
discount ratCj you can entcr the rate as a percent value (such as 10%) or
a decimal value (such as 0.10). The numeric range represents the amount
of the investment and is a list of future credits and debits. Income is
represented by positive values in the list, and payments are represented
by negative values in the list. The future payments are assumed to occur
at equal time intervals, and the first payment is assumed to occur at the
end of the first time interval.

Example:
NPV(l2%, A1..AIO) describes the net present value of three future
payments of the numeric values contained in spreadsheet cells Al
through AlO, invested at a constant interest rate of 12%.

Null

Returns a null string (UIl).

Example:
Null returns the null string em.
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NumDate(string)

Returns an integer value for the date represented by string. jan. 1, 1900
is assigned the numeric value 1, jan. 2,1900 is assign'ed the value 2, and
so forth. The string may be expressed in any of these forms: mm/dd/yy;
mm/dd/yyyy; Mon. dd, yyyy; Month dd, yyyy.

Examples:
NumOate("jan. 1, 1900") returns the value 1.

NumOate("jan. 1, 1989") returns the value 32508.

NumOate(Al) returns the numeric equivalent of the date string value in
spreadsheet cell A1.

NumOate([fieldnameJ) returns the numeric equivalent of the date string
value in database field specified.

Or(logicallist)

Returns true if any of the values in logical list are true.

Examples:
OrO +1=2, 2+ 254) returns true, since the first argument is true.

Or(AI =Bl, Cl =01) returns true if the value in cell Al equals the value
in cell Bl or the value in cell Cl equals the value in cell 01.

Pi

Returns an approximation of the mathematical constant 1t (pi). Returns
3.14159... to the number of decimal places specified in the application.
The Pi function takes no argument.

Example:
Pi returns 3.14159..., with the number of decimals determined by the
format of the cell or field displaying the value.
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Pmt(pv, rate, term)

Calculates the periodic payment necessary to amortize a loan across a
fixed number of periods. Pv is the present value or principal amount of
the loan; enter pv as a positive value with an optional leading dollar sign.
Rate is the interest rate of the loanj you can enter rate as a percent value
(such as 10%) or a decimal value (such as 0.10). Ten" is the number of
periods that make up the term of the loan.

Example:
Pmt{10000, 10.5%, 240) returns the monthly payment on a loan of
$10,000 at an interest rate of 10.5% for 240 months.

Position(string, string)

Returns a number correspondi,ng to the position whife the first argument
string first occurs in the second argument string.

Examples:
Position{ lid''» lIabcde") returns the value 4, the position where the first
argument first occurs in the second string.

Position('\vorld", "Hello world") returns the value 7.

Position(" ap'\ Ilapples and applications") returns the value 1.

Position{A1, A2) returns the location of cell AI's string value within
cell A2's string value.

Position{[field1], [field2]) returns the location of field1's string value
within field2's string value.

Product(numeric list)

Returns the product of all the numbers on numeric list.

Examples:
Product{2, 3, 4) retums 24.

Product{A1..A10) returns the product of the values found in the
spreadsheet range from Al through AIO (ignores empty cells in ranges or
cells containing strings).

Product{[fieldl], [field2], ... ) returns the product of the values found in
the specified database fields. 1£·
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Proper(string)

Returns a string with the first character in the string converted to
uppercase and all other characters in lowercase.

Examples:
Proper("robert") returns llRobert".

Proper(A1) returns the string found in cell AI, with the first character
converted to uppercase, and all other characters converted to lowercase.

Proper([field]) returns the string found in the database field, with the
first character converted to uppercase, and all other characters converted
to lowercase.

PV(payment, rate, term)

Calculates the present value of a series of equal periodic payments or of a
single investment. Payment is the amount of the investment or periodic
paymentj enter payment as a positive valuc, with an optional leading
dollar sign. Rate is the discount ratc; you can enter rate as a percent value
(such as 10%) or a decimal value (such as 0.10). Term is the number of
periods that make up the term of the investment.

Example:
PV(lOOOO, 8%,10) returns the present value (the value today) of a
payment of $10000 invested at an annual rate of 8% for 10 years.

Radians(number)

Retunls the number of radians equivalent to number degrees. The
function expects the number to be expressed in degrees.

Example:
Radians(180) returns the value 3.14 ( an approximation of pi), which
expresses the number of radians equivalent to 180 degrees.

Random(number)

Returns a random number between 0 and (number - 1). If the argument
is 0 or 1, then Random returns a random value greater than or equal to 0
and less than 1.
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Examples:

Random(50) returns a random number between 0 and 49, inclusive.

Random(O) or Random(l) returns a random number greater than 0 and
less than 1.

Random(AI) returns a random number between 0 and the value in
spreadsheet cell Al minus 1.

Random([fieldname]) returns a random number between 0 and the value
in the database field specified minus I.

Rate(fv. pv. term)

Calculates the interest ratc of return on an investment involving
constant, equal periodic payments or a single lump~sum payment. Fv is
the future value of the loanj enter fv as a positive value with an optional
leading dollar sign. Pv is the present value of the investmenti enter pv as
a positive value, with an optional leading dollar sign. Term is the number
of periods that make up the term of the investment.

Example:

Rate(lOOOO, 2000, 5) returns the rate of return of an investment whose
present value is $2000 and future value is $10000 over 5 periods.

Round(number. number)

Returns the first argument, rounded up to the number of decimal places
specified by the second argument.

Examples:

Round(3.14, I) returns 3.1.

Round(2.789, 2) returns 2.79.

Round(1.5, 0) returns 2.

Round( I, A I) returns the value in spreadsheet cell AI, rounded to 1
decimal place.

Round([fieldname]) returns the value in the database field specified,
rounded to one decimal place.
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Sgn(number)

Returns 1, 0, or -1, depending on the sign of number.

Examples:
Sgn(2) returns 1.

Sgn(-2) returns-I.

Sgn(O) returns O.

Sgn(A 1) returns the sign of the value in spreadsheet cell AI.

Sgn([fieldname]) returns the sign of the value in the specified database
field.

Sin(number)

Returns the sine of number. The function expects the number to be
expressed in radians.

Examples:
Sin(O) returns 0 (sine of 0 radians).

Sin(Pi) returns 1 (sine of 1t radians).

Sin(A1) returns the sine of the value in spreadsheet cell AI.

Sin([fieldname]) returns the sille of the value in the database field speci.
fied.

Sqrt(number)

Returns the positive square root of number. If the number is negative, the
function returns ERROR.

Examples:
Sqrt(l6) returns 4.

Sqrt(O) returns O.

Sqrt(-1) returns ERROR.

Sqrt(Al) returns the square root of the value in spreadsheet cell AI.

Sqrt([fieldname]) returns the square root of the value in database field
specified.
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Stdv(numeric list)

Returns the standard deviation of the numeric values in numeric list.

Examples:
Stdv(2, 7, 9, 10,27) returns 9,46.

Stdv(AI..AIO) returns the standard deviation of the values found in
spreadsheet cells Al through AIO (ignoring empty cells in ranges).

Stdv([fieldl], [field2],...) returns the standard deviation of the values
found in the specified database fields.

String(number)

Returns a string equivalent of the numeric argument. Use this function
to convert a number into a string, so that other string functions can
operate on it.

Examples:
String(43) returns the string "43".

String(999) returns the string "999".

String(AI) returns the string equivalent of the numeric value in spread
sheet cell AI.

String([fieldnameJ) returns the string equivalent of the numeric value in
the database field specified.
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SubStr(string, start, length)

Returns a substring specified by the two numeric arguments, start and
length. The first argument is a string, from which a substring is extracted.
The argument start specifies the starting position of the substring and the
length argument specifies the length of the substring.

Examples:
SubStrC'Hello worlclJJ

, 7} 5) returns llworld".

SubStr(llabcdefg'\ 3, 2) returns ucdlJ
•

SubStr(AI, 3, 5) returns the substring found beginning at position 3 and
extending for 5 characters within cell Ai's string value.

SubStr([fieldname], 3, 5) returns the substring found beginning at
position 3 and extending for 5 characters within the field's string.

Sum(numeric list)

Returns the sum of the numbers in numeric list.

Examples:
SumO, 3, 5) returns 9.

Sum(Al..AIO) returns the sum of the values found in spreadsheet cells
Al through AlO (ignoring empty cells).

Sum([fieldIJ, [field2], ... ) returns the sum of the values found in the
specified database fields.

Tan(number)

Returns the tangent of the number. The function expects the number to
be expressed in radians.

Examples:
Tan(Pi/4) returns 1 (tangent of n/4 radians).

Tan(AI) returns the tangent of the value in spreadsheet cell AI.

Tan([fieldname]) returns the tangent of the value in the database field
specified.
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Term(payment, rate,lv)

Returns the number otperiods required to amortize a loan involving
constant periodic payments. Rate is the interest rate of the loani you can
enter rate as a percent value (such as 10%) or a decimal value (such as
0.10). Payment is the periodic payment; enter payment as a positive value,
with an optional leading dollar sign. Fv is the future value of the loan;
enter fv as a positive value, with an optional leading dollar sign.

Example:

Term(lOOO, 8%, 50000) returns the number of periods required to
amortize a loan of $50000 at 8% with payments of $1000 per period.

Today
Returns a string representing today's date. (The date is taken from the
internal clock on your Apple llGs. If the date is incorrect, use the Apple
llGS Control Panel to reset the date.)

Example:

Today returns uJan. 1, 1989'\ or a similar string that corresponds to the
current date.

True

Returns the value 1. True takes no arguments.

Example:

True returns numeric value 1.

Upper(string)

Returns string with all characters in uppercase.

Examples:

Upper{"robert") returns "ROBERT".

Upper(AI) returns the string found in cell AI, with all characters
converted to uppercase.

Upper([fieldJ) returns the string found in the database field, with all
characters converted to uppercase.
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Val(string)

Returns the numeric equivalent of the string argument. Use this function
to convert a number currently expressed as a string into its numeric
equivalent, so that other numeric functions can operate on it.

Examples:
Val("43") returns the numeric value 43.

Val("999") returns the numeric value 999.

Val(Al) returns the numeric equivalent of the string value in spread
sheet cell Ai.

Val([fieldname]) returns the numeric equivalent of the string value in
the database field specified.

Var(numeric list)

Returns the variance of the numbers in the arguments in numeric list. Vat
assumes that the numbers in numeric list are sample numbers and not the
total population, and provides the best estimate of the population
variance. If numeric list represents the entire population rather than a
sample, you can calculate the variance for the entire population by
including the average of the sample in numeric list.

Example:
Var(Al..A20) returns the variance of the values in spreadsheet cells Ai
to A20.

VLookup(value, range, offset)

Looks up value in a table contained in the spreadsheet range. Finds
largest value in first column of the range which is less than or equal to
value, and then returns the value found offset columns to the right. (This
assumes that the nrst column of the range is sorted in increasing order.)

Example:
VLookup(2, Ai "A4, 3) returns value found using this search method:

III finds largest value in column Ai to A4 less than or equal to 2, and

then

III finds cell 3 columns to the right in the range (the offset value), and

returns the value in that cell.
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Weekday(string)

Returns a string representing the weekday for a given date (represented
by string).

Examples:
Weekday("]an. 24, 1988") returns "Monday".

Weekday("]une 21, 1988") returns "Tuesday".

Weekday(Al) returns the weekday of the date in spreadsheet cell AI.

Weekday([fieldname]) returns the weekday of the date value in the
database field specified.

Year(string}

Returns a number representing the year portion of the date represented
by string.

Examples:
Year("]an. 24, 1988") returns 1988.

Year("]an. 1, 1989") returns 1989.

Year(Al) returns the year of the date in spreadsheet cell AI.

Year([fieldname]) returns year of the date value in the database field
specified.
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formulas in the Database
and Spreadsheet
Applications

274

You can place a formula in any spreadsheet cell or in a database field. A
formula lets you calculate a new value for a cell or field based on other
existing values.

A formula in a spreadsheet cell can calculate a new value based on
constant values, references to other cells, and values provided by
calculated expressions. You can also use any of the AppleWorks OS
functions as elements of a spreadsheet formula.

The database application lets you place a field formula in a calculated
database field. A database field formula calculates a value based on
information provided by references to other fields, by constant values,
and by calculated expressions. You can also use any of the AppleWorks
OS functions as elements of a field formula. (You can't use functions that
require a range of spreadsheet values, including NPY, lRR, HLookup,
and YLookup.)

Because a calculated field can derive information from other fields in a
record, the value of the calculated field can change from record to
record.

Elements of a Formula

Formulas in both the spreadsheet and database applications can contain
a number of different elements. The elements can include constant
values, operators, references to spreadsheet cells or database fields,
AppleWorks OS functions, and expressions created by combinations of
these elements.

Each formula in a spreadsheet must begin with an equal sign (=). When
you create a spreadsheet formula, type an equal sign as the first element
of the formula.

Many different elements may follow, including constants, expressions,
and functions. In the spreadsheet, a formula in a cell may also contain a
reference to the contents of other spreadsheet cells. In the database, the
field formula may contain references to the contents of other database
fields.
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Constants

A constant is a value in an expression that doesn't change. A constant
can he a number or a string. Some strings, such as street addresses, might
begin with a numherj if you include a string constant in a formula, the
string must begin and end with quotation marks.

Example
Numeric constants: 25, 100,98.6, 1.024e6, $100, 10%.

String constants: uRobere', IISusan", u5250 Gulfran".

References to Spreadsheet Cells

A spreadsheet formula may include references to values found in other
spreadsheet cells. These references can be either absolute references or
relative references. When you create a formula in a spreadsheet cell, both
absolute and relative references produce the same results in that original
celL However, if you copy the formula into a new cell, the formula is
interpreted differently in the new cell, depending upon whether the
references arc absolute or relative.

Absolute References
An absolute reference always refers to the same location, even if the
formula is copied from its original location to a different location. For
example l if a formula in cell Bl refers to cell Al as an absolute reference,
the formula will always refer to cell AI, even if the formula is copied to
other cells later.

Relative References
A formula can contain a reference to a cell as a relative reference. A
formula with a relative reference refers to different locations, depending
upon the current location of the formula.

In its original celt a formula with a relative reference refers to one
particular cell. (For example, it might refer to a cell in the same row and
two columns to the left.)

When this formula is copied to a new location, the formula now refers
to a different cell. (For instance, it might refer to the cell in the same
row and two columns to the left of the new celL)
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For example, if you type the formula u=Alu into cell Bl, the formula
places the value of cell Al into cell Bl, and the formula refers to cell Al
as a relative reference. (The relative reference refers to the cell in the
same [Ow and one column to the left of the Current cell, which is AI's
location relative to B1.)

If you copy this formula containing this relative reference into a new
cell, the formula no longer refers to cell AI; rather, it refers to the cell
which is located in the same row and one column to the left of the new
cell.

Creating Relative and Absolute References
Most of the cell references that you use will be relative references. If you
want to refer to a cell in a formula by relative reference, you should type
in the column letter and [Ow number of the cell.

For example, if you type the formula u=Al" into cell B1, the reference to
cell Ai is a relative reference. The formula refers to the cell in the same
[Ow as cell Bl and located one column to the left.

If you copy this formula into a different cell, it no longer refers to cell
Alj rather, it refers to the cell in the same row as the new cell and
located one column to the left.

When you refer to a cell by absolute reference, the reference does not
change when the formula is copied to a new ceiL To create an absolute
reference, place the $ character before the element of the reference that
you want to remain unchanged when you copy the formula to another
location. For example, if you type the formula u=$A$I U into cell Bl, the
formula always refers to cell AC even if you copy the formula into a new
location.

If you place the $ character before both the column reference and the
row reference, the formula refers to the cell in the same row and same
column, regardless of the location of the new cell. When this reference is
copied to another cell, the reference always refers to the original cell.
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Mixing Relative and Absolute References

A reference can contain a mixture of both absolute and relative refer..
ences. Interpreting these mixed references can be a little tricky.

A reference can contain the $ character before only the column refer..
ence. An example of this type of mixed reference might be $Al.

When a mixed reference of this type is copied to a new location, a copy
of the reference refers to the cell that is:
.. in the same column as the original reference, and

II in the row that is in the same relative location as the original formula

cell and original referenced cell.

A reference could also contain the $ character placed before only the
row reference. An example of this type of mixed reference might be A$l.

\Vhen a mixed reference of this type is copied to a new location, a copy
of the reference refers to the cell that is:
III in the same row as the original reference, and

II in the column that is in the same relative location as the original

formula cell and original referenced cell.

In summary, a reference to a cell can be a relative reference, an absolute
reference, or a mixed reference. To illustrate each type of reference}
suppose that you type one of the following formulas into cell B1. When
you copy the formula to a different cell, different results are seen.

Absolute and Relative References

Formula: Result when copied to a new cell:

=AI Refers to cell in same row as the new cell, one
column to the left of the new cell

=$A$I Refers to cell AI, regardless of the location of
the new cell

"$A1 Refers to the cell in column A, in the same row
as the new cell

=A$I Refers to the cell in row I, one column to the
left of the new cell
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References to Database Fields

When you creare a formula in the database to calculate a value for a
database field, the formula is similar to a spreadsheet formula. The
formula must begin with an equal sign and contain any combination of
constants, expressions, and functions.

In addition, the formula can contain references to the values in other
database fields. To include the value in another database field, you can
click the name of the desired field in the Field Formula dialog box.

When you click the name of a field, that field is automatically inserted
into the formula at the insertion point.

You can also type the name of a field into a formula at the insertion
point. When you type a field name into a formula, the name of the field
must begin with an opening square bracket ([), and must end with a
closing square bracket (]). An example of a formula containing field
names would be:

~[fieldl] + [field2]

Expressions

An expression is any element that can be evaluated to produce a value.
An expression can be as simple as a number, or as complicated as the
most complex arithmetical formula. Examples of formulas which
contains expressions might be:

II 43
II 43+24
II (43+24)/(879.43*34.9)
The parts of an expression can be combined with arithmetic operators,
comparison operators, or logical operators.

Arithmetic Operators

The numeric elements of an expression can be combined using arithme,
tic operators. An operator performs some operation on one or more
values, called operands. For example, the addition operator (+) adds one
operand (the value to the left of the plus sign) to a second operand (the
value to the right of the plus sign).
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The arithmetic operators available in AppleWorks OS are summarized in
the following table.

AppleWorks GS Arithmetic Operators

Symbol: Name: Use: Oparation:

unary minus -operand Reverses the sign of the operand

+ unary plus +operand Retains the sign of the operand

A exponentiation opIAop2 Raises op1 to power of operand2
. -

• multiplication opl*op2 Multiplies operandI by operand2

/ division opI/op2 Divides operandI by operand2

+ addition opI+op2 Adds operandI to operand2

subt, action opI-op2 Subtracts op2 ftom opi

The operators are listed in order of precedence} decreasing from top to
bottom. You can use parentheses to group elements of an expression to
override the order of precedence, if necessary.

Comparison Operators

Logical expressions can also contain comparison operators and logical
operators. For example} the If function uses a logical expression to decide
which of two actions to take, and the logical expression often contains a
comparison operator.

Here are two examples of logical expressions containing comparison
operators:

Example: Result:
---------~---

If (AI ~A2, A3, A4) Tests if value in cell Al is equal to value in
cell A2. If values are equal, returns value in
cell A3. If values are not equal, returns value
in cell A4.

If ([fieldll~[field21,1,0) Tests if value in database fieldi is equal to
value in database field2. If values are equal,
returns value 1. If values are not equal,
returns value O.

----
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The comparison operators are described in the table below.

Symbol: Name: Example: Operation:

Equals If (opI ~op2 ... Tests if value of operandI is
equal to value of operand2

<> Not equals If (opI <>op2 ... Tests if value of operandI is
not equal to value of
operand2

> Greater than If (opI > op2... Tests if value of operandI is
greater than value of
operand2

>~ Greater than If (opI >~op2... Tests if value of operand! is
or equal to greater than or equal to

value of operand2

< Less than If (opI < op2.. Tests if value of operand! is
less than value of operand2

<- Less than If (opI <=op2... Tests if value of operandI is
less than or equal to value of
operand2

You can substitute the symbol ~< for the symbol <=, and you can
substitute the symbol ~> for the symbol >~. You can also substitute the
symbol x for the symbol <>.

All of the comparison operators in this table have lower precedence than
any of the numeric operators.
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Logical Operators

Logical expressions can also contain logical operators. A logical operator
performs an operation on operands that have values of true or false.

Here are two examples of logical expressions containing logical opera...
tors:

Example: Result:

If (AI&A2, A3, A4) Tests if the logical values in cells AI and A2
are both true (non-zero). If values are both
truc, returns value in cell A3. If values arc
not both true, returns value in cell A4.

If ([fieldI]&[field2], 1,0) Tests if values in database field I and field2
arc both true (non-zero). If values are both
true, returns value 1. If values arc not equal,
returns value O.

The logical operators are described in the table below.

Symbol: Name: Example: Operation:

& Logical And If (opI&op2... Tests if value of both oper-
andI and operand2 are
true. Returns true if both
are truej otherwise returns
false.

Logical Or If (opI lopz... Tests if value of either oper-
andI or operand2 is true.
Returns true if either is truej
returns false if both are false.

Not - operand... Reverses the logical value of
operand.
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Summary of Order of Precedence

The order of precedence of operators defines the order in which opera
tions acc performed when an expression is evaluated. For example, in
AppleWorks OS the multiplication operator (*) is ranked higher in
precedence than the binary addition operator (+). This means that
multiplication operations are performed before any addition operations
arc performed. Think about an expression like this:

4 + 5 * 3

There are two possible values for this expression. If the addition operator
had higher precedence than the multiplication operator, you would
perform addition first, so the expression would evaluate to 9*3, or a
value of Z7. However, in AppleWorks OS, the multiplication operator
has a higher precedence than the addition operator, so the expression
evaluates to 4 + IS, or a value of 19.

The order of precedence of the AppleWorks OS operators is summarized
in the following table, with the highest precedence first and decreasing
in precedence:

Order of Precedence for AppleWorks GS Operators
---------

+ (unary operators, used before a single operand)
---- --'-------

1\

* I
+ - (binary operators, used between two operands)

----

<. > <= >=
---_._------------------

<>

&
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Functions in Expressions

In addition to constants, cell values, and field valucs l an expression can
contain any of the AppleWorks OS functions described above. Some
examples of expressions that contain functions are given below:

II ~ 43/Log(4.3)

II ~ 43 * Sin(6.7)

II ~ Al *Cos(AZ)

II = [fieldl] + sqrt([fieldZj)
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Sort Order for Text

AppleWorks os uses a specific ordering system when it sorts text fields
in the database application and labels in the spreadsheet application.
This ordering system is based on a special application of. the ASCII se
quence.

ASCII, an acronym for American Standard Code for Information Inter
change, is a uniform code used by almost all microcomputers to represent
characters. A group of special characters is sorted with the highest
precedence, followed by the numbers 0-9, followed by another group of
special characters, followed by uppercase and lowercase letters, followed
by a final group of special characters.

I

There is one major difference between the ASCII sort order used by
AppleWorks OS and the normal ASCII sequence. The ASCII sequence
gives all uppercase letters precedence over all lowercase letters. Apple
Works OS gives uppercase letters precedence over lowercase letters only
when two different cases of the same letter are involved. For example, if
you're sorting "Allen" and {jalleo'" the two names will be sorted this way:

Allen
allen

If you're sorting flallen" and "Zelda," on the other hand, the two names
will be sorted like this:

allen
Zelda
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Here is rhe order in which AppleWorks OS sorts text. (Read down one
column and then go to the top of the next.)

Space ( 0...9 @
,

! ) : Aa...u. {

" * ; [ I

# + < \ I

$ , ~ 1 -
% > 1\

,
/ ? -

If you're sorting text that combines numbers and letters-names and
addresses, for example-you'll find that numbers come before letters and
that some special characters come before both. You'll want to be
especially careful with spaces-they're at the very top of the sort order,
and it's very easy to insert a blank space in front of a group of characters.

If you try to sort numbers alphabetically (as text characters rather than
as numeric values), you'll get results that may not seem to make sense to
you. For example, if you sort the numbers 9888 and 99 alphabetically,
the number 9888 will fall before 99, because the numbers are sorted in
alphabetical and not numeric order.
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Cast of Characters
+ (addition) 278, 279
<> (angle brackets) 34,38
A (caret symbol) 215
/ (division) 279
$ (dollar sign) 276,277
~ (Equals) 280
~ (equal sign) 274
A (exponentiation) 279
> (Oreater than) 280
>= (Greater than or equal

to) 280
< (Less than) 280
<~ (Less than or equal to) 280
& (Logical And) 281
I (Logical Or) 281
* (multiplication)279

, ~ (Not) 281
<> (Not equals) 280
+ (plus sign) 186
# (pound sign) 68, 188
[] (square brackets) 71, 278
- (subtraction) 279
- (unary minus) 279
+ (unary plus) 279

A
About AppleWorks OS command

(Apple menu) 3
Abs 242,250
absolute references 275-277
Acos 243, 250
Actual Size command (Options

menu) 164
Add (Dial command) 224
Add (List Functions command)

110
Add (Send Batch command)

209

Add (Send Binary II command)
211

addition (+) 278, 279
Add Merge Field command (Edit

menu) 38
Add To Dictionary (Check

Spelling command) 43
Add Word (Edit Dictionary

command) 45
A4 Letter (Page Setup com

mand) 15,16
Alert 249,250
Align (Field Format command)

65,69,70
Align Center command (Format

menu) 102, 107
Align Left command (Format

menu) 101,107
Align Right command (Format

menu) 102, 107
All AppleWorks OS Files

icon 5,6
American Standard Code for

Information Interchange. See
ASCll

And 248,251
angle brackets «» 34,38
Answer Phone command (Phone

menu) 225
APF 6, 10, 13, 125, 159, 160
Applemenu 3

About AppleWorks OS
command 3
Configure command 3

Apple Preferred Format. See APF
AppleTalk network 14,233-234
Apple I/os Owner's Ouide 52,

232, 233
Apple lIos System Disk User's

Guide 10
AppleWorks 5,6, 12, 13, 159,

160

Index

AppleWorks GS System disk 229
AppleWorks OS User's Guide 15,

98, 187
AppleWorks OS Utilities disk 42,

43
application-type codes 4-5
arc tool 151
arguments (for functions) 238,

239-240
arithmetic functions 242-243
arithmetic operators 278-279
Arrange menu (graphics)

128-132
Bring to Front cOlnm.and 128
Flip Horizontal command 130
Flip Vertical command 131
Group comrnand 129
Nudge Down command 132
Nudge Left command 132
Nudge Right command 132
Nudge Up command 132
Rotate Left command 131
Rotate Right command 131
Semi to Back command 128
Shuffle Down command 129
Shuffle Up command 129
Ungroup command 130

Arrange menu (page layout)
172-174
Bring to Front command 172
Flip Horizontal command 173
Flip Vertical command 174
Rotate Left command 174
Rotate Right command 174
Send to Back command 173

As ASCll Text (Save As com-
mand) 33,63

Asc 247,251
Ascending (Sort command) 117
ascending order, defined 80
ASCll 5,6, 10, 12, 13,33,63,

95, 159, 160,204

287



Index
sort order 285-286

Asin 243,251
Aran 243, 252
Auto Calculation command

(Options menu) 108
Autodial command (Phone

menu) 223
Auto Fill (Field Format com

mand) 66,69, 70
Auto-Stamp (Field Format

command) 69, 70
Average (Format command) 90
Avg 244,252

B
Bar Chart icon 118
Batch mode. See Receive Batch

commandi Send Batch com~

mand
Baud (Communication com...

mand) 220
Begin New Paint Object com

mand (Edit menu) 127
B5 Letter (Page Setup com

mand) 16
Binary II mode. See Receive

Binary II command; Send
Binary II command

blue scroll bar (Edit Colors
command) 23, 26

Bold (Choose Font command)
29

Bold (Field Format command)
65

Bold command (Format menu)
101,107

Bold command (Style menu)
page layout 181
word processing 57

Border (Field Format com
mand) 65,69,70

288

brackets. See angle brackets;
square brackets

Bring to Front command (Arrange
menu)
graphics 128
page layout 172

brush shape palette 135, 154
B scroll bar (Edit Colors com

mand) 23,26

c
calculated fields 71, 237
"Capture:" 212,218
Capture Text/End Text Capture

command (Transfer menu)
212

caret symbol (A) 215
carriage returns, findingJreplac ...

ing 39
Case Sensitive (Find com

mand) 73
Case Sensitive (Replace com

mand) 75
CDA's 229
cells, spreadsheet 237,241,

275-276
Center command (Text menu)

175
Change (Modify Chart com

mand) 121
Change Default Width command

(Options menu) 110-111
Chart Name (New Chart com

mand) 119
Check Spelling command (Search

menu) 42--43
Choose 249,252
Choose Font command (Font

menu) 28-29
Choose Font command (Options

lnenu) 28-29, 133

Index

Choose Font command (Template
menu) 28-29,86

Choose Printer command (File
menu) 13-14

Chr 247,253
classic desk accessories 229
Clear command (Edit menu) 20
Clip (Field Format command)

68
Clipboard 19-21,22,36
Close (List Functions com-

mand) 110
Close (Open command) 7
Close command (File menu) 7-8
Collapse command (Edit menu)

127
Color (Field Format command)

65,69,70
Color Editor (Edit Colors com

mand) 23-27
Color menu (page layout) 183
Color menu (word processing)

59
column guides 198
Column Heading (Format

command) 89
Columns (Set Guides com

mand) 167
Columns (Set Titles command)

III
Column Spacing (Set Guides

command) 167
commands. See also specific

command
AppleWorks GS 3-29
communications 203-225
database 63-91
graphics 125-155
page layout 159-199
spreadsheet 95-121
word processing 33-59



Commas command (Format
menu) 104, 107

Communication command
(Settings menu) 220-222

communications com..
mands 203-225

Communications icon 6
comparison operators 279-283
Concat 246, 253
Condition (Match Records

command) 76
Configure command (Apple

menu) 3
Confirm Changes (Replace

command) 75
constants 238, 275
control characters 215
Control Panel 14,231-232

AppleTalk and 233-234
choosing options 231-232
entering 231
LaserWriter and 234-235
modem and 236

conversion functions 247-248
Copy command (Edit menu) 20
Copy Ruler command (Edit

menu) 36
Cos 243,253
Count 244, 254
Count (Format command) 90
Create Report command (Report

menu) 91
Cut command (Edit menu) 19

D
database application

formulas in 274-283
functions in 238-241

database fields 237,241,278
Database icon 6

Data Bits (Communication
command) 221

Data menu 114-121
GoTocommand 114
Modify Chart com-
mand 120-121
New Chart com-
mand 118-119
Protect command 117
Sort command 114-117

Date 247,254
date (argument) 240
Date (Field Definition com

mand) 64
date fields, formatting. See Field

Format command
dates, range for 69
date tool 188
Day 247,254
decimal tabs 196-197
Degrees 243, 255
Delete (Modify Chart com

mand) 121
Delete command (Edit

menu) 97
Delete File command (File

menu) 11
Delete Pages command (Edit

menu) 163
Deluxe Paint II 5,159
Descending (Sort com-

mand) 117
descending order, defined 80
desk accessories 229
Desk.Accs folder 229
Dial (Dial command) 225
Dial command (Phone

menu) 223-225
Dial Time (Communication

command) 221
dictionary 145

Index

Display (Field Format com
mand) 65

Display Marked Fields command
(Organize menu) 78

Display Preferences command
(Template menu) 85

Dithered (Edit Colors com
mand) 24,25

division (/) 279
Document menu 46-53

Insert Date command 51-52
Insert Page Break com-
mand 50
Insert Page # command 51
Insert Time command 52
Normal View command 46
Pages command 50
Show Ruler/Hide Ruler com
mand 49
Statistics command 53
View Footer command 48-49
View Header command 46-47

Dollar (Field Format com
mand) 67,68

Dollars command (Format
menu) 103, 107

dollar sign ($) 276,277
Done (FindfReplace com

mand) 40
Double Space command (Text

menu) 175
Down (Fill command) 99
drawing tools 135, 147-152
drivers (printer) 231
Drivers folder 231
Duplicate command (Edit menu)

graphics 126
page layout 161
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Index

E
lie" 103
Echo (Communication com~

mand) 222
Edit Colors command (Color

menu) 23-27
Edit Colors command (Edit

menu) 23-27
Edit Dictionary command (Search

menu) 45
editing tools 135,136-142
Edit Line command (Settings

menu) 216
Edit menu 19-21

Clear command 20
Copy command 20
Cut command 19
Paste command 20
Select All command 21
Undo command 19

Edit menu (communications)
203

Edit menu (database) 64-72
Field Definition command
64-65
Field Format command 65-70
Field Formula command
71-72
Insert Record command 72

Edit menu (graphics) 126-127
Begin New Paint Object
command 127
Collapse command 127
Duplicate command 126
Shadow command 126

Edit menu (page layout)
161-163
Delete Pages command 163
Duplicate command 161
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Insert Pages command 162
Select All command 161

Edit menu (spreadsheet) 96-100
Delete command 97
Fill command 99
Insert command 96
Move command 98
Paste Format Only command
96
Paste Value Only command
96
Transpose command 100

Edit menu (word processing)
36-38
Add Merge Field command 38
Copy Ruler command 36
Paste Ruler command 36
Select Merge Database com
mand 37
Select Paragraph command 36
Select Sentence command 37

End Text Capture command
(Transfer menu) 212

Epson LX/FX printer/printer
driver 14

Equals (=) 280
equal sign (=) 274
eraser 142
IIError" 114
Error 249,255
Exp 242, 255
exponentiation (1\) 279
expression (argument) 239
expressions 278,283

F
False 248, 256
Fast Dial (Dial command)

223-225

Index

Field Definition command (Edit
menu) 64-65

Field Format command (Edit
menu) 65-70
date fields and 69
numeric fields and 67-68
picture fields and 68
static text fields and 69-70
text fields and 66
time fields and 70

field formula 237
Field Formula command (Edit

menu) 71-72
fields

calculated 71,237
database 237,241,278

Fields (Field Formula com
mand) 71

Fields (Match Records com
mand) 76

Fields (Sort command) 79
file formats 5-6,10,12-13,33,

63,95,125,159-160,204
File menu 4-18

New command 4-5
Open command 5-7
Close command 7-8
Save command 8
Save As command 9-10
Delete File command 11
Import File command 12-13
Choose Printer com~
mand 13-14
Page Setup command 15-17
Print command 17-18
Print Merge command 18
Quit command 18

File menu (communications)
203

File menu (database) 63
Save As command 63



File menu (graphics) 125
Save As command 125

File menu (page layour) 159-160
Imporr File command
159-160

File menu (spreadsheer) 95
Save As command 95

File menu (word processing)
33-35
Prinr Merge command 34-35
Save As command 33

File mode. See Receive File
command; Send File command

Fill command (Edir menu) 99
filled/hollow icons 191
financial arguments 240
financial functions 245
Find (Find command) 73
Find Again command (Search

menu) 40
Find command (Organize

menu) 73
Find Next (FindjReplace com

mand) 40
Find Next command (Organize

menu) 74
FindjReplace command (Search

menu) 39-40
Fit in Window/Actual Size

command (Options menu)
164

Fixed (Field Format command)
67,68

Fixed command (Format menu)
102, 107

Flip Horizontal command (Ar
range menu)
graphics 130
page layout 173

Flip Vertical command (Arrange
menu)
graphics 131

page layout 174
folders

Desk.Accs 229
Drivers 231
Fonts 230
System 229-231

Fom (Choose Font command)
28

font files 230
Font menu (page layout) 178
Font menu (word processing) 54
Fonts folder 230
Font Substitution (Page Setup

command) 17
Footer command (Report

menu) 88
Format command (Report

menu) 88-90
Format menu 101-107

Align Cemer command 102,
107
Align Left command 101, 107
Align Right command 102,
107
Bold command 101,107
Commas command 104, 107
Dollars command 103, 107
Fixed command 102, 107
General command 102, 107
Parenthesize Neg #'5 com..
mand 105, 107
Percentage command 103,
107
Red Negative #'5 command
105,107
Scientific Notation command
103, 107
Set Decimal Places com
mand 104, 107
Set Default Format command
106-107
Underline command 101, 107

Index

formats, file 5-6,10,12-13,33,
63,95, 125, 159-160, 204

formatting fields. See Field Format
command

Formula (Field Formula com
mand) 71

formulas 237-283
cell 237
in database application
274-283
elements of 274
field 237
in spreadsheet application
274-283

Frac 242, 256
Full command (Text menu) 175
functions 237-283. See also

specific function
alphabetical directory
250-273
arguments for 239-240
arithmetic 242-243
by category 242-249
conversion 247-248
in database application
238-241
in expressions 283
financial 245
logical 248-249
parts of 238
special-purpose 249
in spreadsheet application
238-241
statistical 244
string 246
trigonometric 243-244

Functions (Field Formula com
mand) 71

Functions (Format command)
90

Functions (Match Records
command) 76
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Index
FV 245,256

G
General (Field Format com

mand) 67
Genetal command (Format

menu) 102, 107
Generate Line Feeds (Communi

cation command) 221
Go To Beginning (FindfReplace

command) 40
Go To Beginning command

(Seatch menu) 41
Go To command (Data menu)

114
Go To End command (Seatch

menu) 41
Go To Insettion command

(Search menu) 40
Go To Page command (Options

menu) 168
Go To Page command (Search

menu) 41
grabber 142
GraphiCard printer port 14
graphics, importing 160
graphics commands 125-155
Graphics icon 6
Grappler printer port 14
Greater than (» 280
Greater than or equal to

(>=) 280
green scroll bar (Edit Colors

command) 23, 26
Grid command (Options menu)

134
Grid command (Template

menu) 84
Grid Size command (Template

menu) 84-85
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Group command (Arrange
menu) 129

G scroll bar (Edit Colors com
mand) 23,26

guides (page layout) 198-199

H
1/2" (Grid Size command) 85
handles, defined 136
Hangup command (Phone

menu) 225
Hardware command (Settings

menu) 219
Header command (Report

menu) 87
Hide cell lines in list mode

(Display Preferences com
mand) 85

Hide Cell Lines/Show Cell Lines
command (Options
menu) 113

Hide Clipboard command
(Window menu) 22

Hide Guides/Show Guides
command (Options
menu) 165

Hide Ruler command (Document
menu) 49

Hide Rulers/Show Rulers com
mand (Options menu) 165

Hide Selected Records command
(Organize menu) 77

Hide Toals/Show Tools command
(Options menu) 164

Hide Unselected Records com-
mand (Organize menu) 77

HIS model, defined 26
HLookup 249,257
hollow icons 191
Horizontal (Grid Size com-

mand) 85

Index

horizontal ruler guides 198-199
horizontal/vertical line tool

graphics 148
page layout 189

H scroll bar (Edit Colors com
mand) 23,26

I, J
icons 4, 5-6. See also specific icon
If 248, 257
Ignore (Check Spelling com

mand) 42
Ignore Case (FindfReplace

command) 39
Ignore Master Page/Use Master

Page command (Options
menu) 169

ImageWriter printer/printer
driver 13,15,17-18

Import Filecommand (File menu)
AppleWorks GS 12-13
page layout 159-160

importing graphics/text 160
indentation marker 195
Inf 242,257
Insert command (Edit menu) 96
Insert Date command (Document

menu) 51-52
Insert Page Break command

(Document menu) 50
Insert Page # command (Docu

ment menu) 51
Insert Pages command (Edit

menu) 162
Insert Record command (Edit

menu) 72
Insert Time command (Document

menu) 52
installation information

229-236
Int 242, 257



intensity scroll bar (Edit Colors
command) 23,27

International Fanfold (Page Setup
command) 15

IRR 245,258
IsBlank 248, 258
I scroll bar (Edit Colors com-

mand) 23,27
IsEmpty 248,258
IsError 248, 258
IsNA 248, 259
IsNumber 248, 259
IsString 248, 259
Italic (Field Format command)

65
Italic command (Style menu)

page layout 181
word processing 57

K
Key (Sorr command) 115
key cell, defined 115

L
Label (Field Definition com

mand) 64
Larger command (Size menu)

page layout 180
word processing 56

LaserWriter printer/printer
driver 14, 18, 234-235

lasso 141
layout guides 198-199
Left command (Text menu) 175
Left/Right Margins (Set Guides

command) 166
Left/Right master page

icons 170,171, 193

Left/Right Master Pages/Single
Master Page command (Options
menu) 170--171

left tabs 196-197
Left Titles (Set Titles com-

mand) 111,113
Len 246,259
Less than «) 280
Less than or equal to «=) 280
Line Chart icon 118
line palette (graphics) 135,153
line palette (page layout) 192
line tool

graphics 148
page layout 189

List Functions command (Options
menu) 109-110

Ln 242,260
"Local" 217,218
Local command (Settings

menu) 218
local mode 217-218
Lock Guides/Unlock Guides

command (Options
menu) 167

Log 242,260
Logical And (&) 281
logical functions 248-249
logical list (argument) 240
logical operators 281
Logical Or (I) 281
logical value (argument) 240
Lower 246, 260
Lowercase command (Style menu)

page layout 181
word processing 57

M
Magnetic Guides command

(Options menu) 168

Index

magnifying glass 140
Manual Calculation/Auto

Calculation command (Options
menu) 108

margin guides 198
Mark Fields command (Organize

menu) 78
marquee 137-139
master page icon 170, 193
Match Records command (Organ-

ize menu) 76--77
Max 244,261
Maximum (Format command)

90
Maximum (New Chart com

mand) 119
menus/menu commands. See

specific menu/menu command
Min 244,261
Minimum (Format command)

90
Minimum (New Chart com-

mand) 119
mixed references 277
Mod 242,262
modem 236
Modify Chart command (Data

menu) 120-121
Month 247, 262
Move command (Edit menu) 98
moving objects 137
Multiple records per form page

(Display Preferences com
mand) 85

multiplication (*) 279
MultiScribe GS 5,6, 12, 13,

159, 160

N
NA 249,262
Name (Dial command) 223-225
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Index
NDA's 229
network (AppleTalk) 14,

233-234
New (Open command) 7
New Chart command (Data

menu) 118-119
New command (File menu) 4-5
new desk accessories 229
New Folder (Save As com-

mand) 10
Next Meaning (Synonyms

command) 44
No Modem (Hardware com

mand) 219
Normal (Page Setup command)

15, 16
Normal View command (Docu-

ment menu) 46
Not 249,263
NotH 281
Not equals « » 280
NPV 245,263
Nudge Down command (Arrange

menu) 132
Nudge Left command (Arrange

menu) 132
Nudge Right command (Arrange

menu) 132
Nudge Up command (Arrange

menu) 132
Null 246, 263
number (argument) 239
Number (Dial command)

223-225
numbered page icons 193,194
NumDate 247, 264
Numeric (Field Definition

command) 64
numeric constants, defined 238
numeric fields, formatting. See

Field Format command
numeric list (argument) 239

294

o
objects 136-137
I" (Grid Size command) 85
1-1/2 Space command (Text

menu) 175
ClOnline" 218
Open command (File menu) 5-7
Open Template command

(Template menu) 83
Operations (Field Formula

command) 71
Operations (Match Records

command) 76
operators

arithmetic 278-279
comparison 279-283
logical 281
order of precedence 282

Options menu (graph-
ics) 133-134
Choose Font com-
mand 28-29, 133
Grid command 134
Patterns command 134
Tools command 133-134

Options menu (page layout)
164-171
Fit in Window/Actual Size
command 164
Go To Page command 168
Hide Guides/Show Guides
command 165
Hide Rulers/Show Rulers
command 165
Hide Tools/Show Tools
command 164
Ignore Master Page/Use Master
Page command 169
Left/Right Master Pages/Single
Master Page command
170-171

Index

Lock Guides/Unlock Guides
command 167
Magnetic Guides command
168
Set First Page command 169
Set Guides command
166-167

Options menu (spread
sheet) 108-113
Change Default Width com
mand 110-111
Hide Cell Lines/Show Cell
Lines command 113
List Functions command
109-110
Manual Calculation/Auto
Calculation command 108
Recalculate command
108-109
Restore Width to Default
command 111
Set Titles command 111-113
View FormulasfView Data
command 109

Or 249,264
order

ascending/descending 80
of precedence 282
of sort 285-286

Organize menu 73-80
Display Marked Fields com
mand 78
Find command 73
Find Next command 74
Hide Selected Records com
mand 77
Hide Unselected Records
command 77
Mark Fields command 78
Match Records command
76-77
Replace command 74-75



Show All Records command
77
Son command 79-80
Unmark Fields command 78

Other Size (Choose Font com
mand) 29

Outline command (Style menu)
page layout 181
word processing 57

oval tool
graphics 150
page layout 191

p
page icons 170,193-194
page layout commands 159-199
page layout guides 198-199
Page Layout icon 6
page number tool 188
Pages command (Document

menu) 50
Page Setup command (File

menu) 15-17
Paint. See PNT
paintbrush 135,143-144
paint bucket 145-146
paint tools 135, 143-146
PaintWorks Gold 5, 159
PaintWorks Plus 5, 159
palettes

brush shape 135, 154
line 135,153,192
pattern 155
tool 135-152, 184-191

Parenthesize Neg Its command
(Format menu) 105, 107

Parity (Communication com~

mand) 221
Paste command (Edit menu) 20
Paste Format Only command (Edit

menu) 96

Paste Ruler command (Edit
menu) 36

Paste Value Only command (Edit
menu) 96

pattern palette 155
Patterns command (Options

menu) 134
pencil 144-145
Percent (Field Format com

mand) 67,68
Percentage command (Format

menu) 103,107
Phone menu 223-225

Answer Phone command 225
Autodial command 223
Dial command 223-225
Hangup command 225

Pi 243,264
PICT 6, 13, 159, 160
{(Picture..." (Show List com~

mand) 83
picture fields, formatting. See Field

Format command
Pie Chan icon 118
Plain (Choose Font command)

29
Plain command (Style menu)

page layout 181
word processing 57

plussign (+) 186
Pmt 245,265
PNT 6, 13, 159, 160
points 177
polygon tool 152
Position 246, 265
pound sign (#) 68,188
precedence, order of 282
Prevo Meaning (Synonyms

command) 44
Print command (File menu)

17-18
printer drivers 231

Index

Printer port 13
Print line separating records on

form (Display Preferences com
mand) 85

Print Merge command (File
menu)
AppleWorks GS 18
word processing 34-35

Product 242,265
Proper 246, 266
Protect command (Data menu)

117
protocols 204
Pure (Edit Colors command)

24-25
PV 245,266

Q
Quit command (File menu) 18

R
Radians 243, 266
Random 244, 266-267
range (argument) 239
Rate 245, 267
Recalculate (Modify Chart

command) 120
Recalculate command (Options

menu) 108-109
Receive Batch command (Trans

fer menu) 206
Receive Binary II command

(Transfer menu) 207
Receive File (Receive File

command) 205
Receive File command (Transfer

menu) 205
rectangle tool

graphics 149
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Index
page layout 190

Red Negative #'s command
(Format menu) 105, 107

red scroll bar (Edit Colors com
mand) 23,26

references
absolute 275-277
mixed 277
relative 275-277

relative references 275-277
Remove (Dial command) 224
Remove (Send Batch com-

mand) 210
Remove (Send Binary II com

mand) 211
Remove Word (Edit Dictionary

command) 45
Replace (Check Spelling com

mand) 42,43
Replace (Dial command) 225
Replace (FindjReplace com

mand) 40
Replace (Synonyms com

mand) 44
Replace All (FindjReplace

command) 40
Replace command (Organize

menu) 74-75
Replace command (Search

menu) 39-40
Replace, Then Find (FindjReplace

command) 40
Replace With (FindjReplace

command) 39
Report menu 87-91

Create Report command 91
Footer command 88
Format command 88-90
Header command 87
Summary Only command 90

reshaping/resizing objects 137

296

Restore Width ro Default com
mand (Options menu) 111

Return Key Preferences command
(Template menu) 86

returns, finding/replacing 39
RGB model, defined 26
Right (Fill command) 99
Right command (Text menu)

175
Right Margins (Set Guides

command) 166
Right Master Page command

(Options menu) 170-171
Right master page icon 170, 171,

193
right tabs 196-197
Rotate Left command (Arrange

menu)
graphics 131
page layout 174

Rotate Right command (Arrange
menu)
graphics 131
page layout 174

Round 242, 267
rounded rectangle tool

graphics 149-150
page layout 190

Rows (Set Titles command) III
R scroll bar (Edit Colors com

mand) 23,26
ruler guides 198-199
rulers 195-197

s
saturation scroll bar (Edit Colors

command) 23,27
Save (Capture Text/End Text

Capture command) 212
Save (Save As command) 10

Index

Save (Save Template com
mand) 83

Save As command (File menu)
AppleWorks GS 9-10
database 63
graphics 125
spreadsheet 95
word processing 33

Save command (File menu) 8
Save Template command (Tem

plate menu) 83
Scale (Field Format command)

68
Scatter Chart icon 118
Scientific (Field Format com

mand) 67,68
scientific notation 67
SCientific Notation command

(Format menu) 103, 107
Screen 6, 13, 160
scroll arrows 135
Search For (FindjReplace com

mand) 39
Search menu 39-45

Check Spelling com
mand 42-43
Edit Dictionary command 45
Find Again command 40
FindjReplace command 39-40
Go To Beginning command
41
Go To End command 41
Go To Insertion command 40
Go To Page command 41
Synonyms command 43-44

Select All command (Edit menu)
AppleWorks GS 21
page layout 161

Select box (Show List com
mand) 82

selecting objects 136-137



selection arrow
graphics 136-137
page layout 184

selection box (Show Form
command) 82

selection rectangle, defined 136,
184

Select Merge Database command
(Edit menu) 37

Select Paragraph command (Edit
menu) 36

Select Sentence command (Edit
menu) 37

Send Batch command (Transfer
menu) 209-210

Send Binary II command (Trans
fer menu) 210-211

Send File command (Transfer
menu) 208

Send Text command (Transfer
menu) 213

Send to Back command (Arrange
menu)
graphics 128
page layout 173

sentence, defined 37
Set Decimal Places command

(Format menu) 104, 107
Set Default Format command

(Format menu) 106-107
Set First Page command (Options

menu) 169
Set Guides command (Options

menu) 166-167
Set Spacing command (Text

menu) 177
Settings (Dial command) 224,

225
Settings menu 215-222

Communication com~

mand 220-222
Edit Line command 216

Hardware command 219
Local command 218
Show Control command 215
Status Bar command 217-218

Set Titles command (Options
menu) 111-113

Sgn 243,268
Shadow command (Edit

menu) 126
Shadow command (Style menu)

page layout 181
word processing 57

Show All Records command
(Organize menu) 77

Show Cell Lines command
(Options menu) 113

Show Clipboard command
(Window menu) 22

Show Control command (Settings
menu) 215

Show Definition command
(Template menu) 81

Show Form command (Template
menu) 82

Show Guides command (Options
menu) 165

Show List command (Template
menu) 82-83

Show Ruler/Hide Ruler command
(Document menu) 49

Show Rulers command (Options
menu) 165

Show Tools command (Options
menu) 164

Show Weekday (Field Format
command) 69

Shuffle Down command (Arrange
menu) 129

Shuffle Up command (Arrange
menu) 129

Sin 244,268

Index

Single Master Page command
(Options menu) 170-171

Single Space command (Text
menu) 175

Size (Choose Font command) 29
Size menu (page layout)

179-180
Larger command 180
Smaller command 180

Size menu (word processing)
55-56
Larger command 56
Smaller command 56

Smaller command (Size menu)
page layout 180
word processing 56

Smoothing (Page Setup com
mand) 17

Sott (Sort command) 80
Sort command (Data menu)

114-117
Sort command (Organize

menu) 79-80
Sort On (Sort command) 79
sort order 285-286
space bar 137
Spaced Bars (New Chart com

mand) 118
special installation information

229-236
special-purpose functions 249
spelling checker 42-43
spray can 146
spreadsheet application

formulas in 274-283
functions in 238-241

spreadsheet cells 237,241,
275-276

spreadsheet commands 95-121
Spreadsheet icon 6
Sqrt 243,268
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Index

square brackets ([ J) 71,278
S scroll bar (Edit Colors com

mand) 23,27
static text fields, formatting. See

Field Format command
statistical functions 244
Statistics command (Document

menu) 53
Status Bar command (Settings

menu) 217-218
Std. Dev. (Format command) 90
Stdv 244, 269
Stop Bits (Communication

command) 221
String 247, 269
string (argument) 240
string constants, defined 238
string functions 246
string list (argument) 240
Style (Choose Font command)

29
Style (Field Format command)

65,69,70
Style menu (page layout)

181-182
Style menu (word processing)

57-58
Subscript command (Style menu)

page layout 181
word processing 57

SubStr 246,270
Subtotal Break After (Format

command) 89
subtraction (-) 279
Suggest (Check Spelling com-

mand) 42
Sum 244,270
Sum (Format command) 90
Summary Only command (Report

menu) 90
Superscript command (Style

menu)
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page layout 181
word processing 57

Synonyms command (Search
menu) 43-44

System folder 229-231

T
tab markers 195-197
tabs, finding/replacing 39
tab well 196-197
Tan 244,270
Template menu 81-86

Choose Font command
28-29,86
Display Preferences command
85
Grid command 84
Grid Size command 84-85
Open Template command 83
Return Key Preferences com,
mand 86
Save Template command 83
Show Definition command 81
Show Form command 82
Show List command 82-83

templates, defined 81
Term 245,271
terminal mode 217-218
text

importing 160
sort order for 285-286

ClText.,,1l (Show List com,
mand) 83

text fields, formatting. See Field
Format command

Text menu 175-177
Center command 175
Double Space command 175
Full command 175
Left command 175
1-1/2 Space command 175

Index

Right command 175
Set Spacing command 177
Single Space command 175

text streams, defined 186
text tool

graphics 147
page layout 185-187

thesaurus 43-44
3-Dimensional Bar Chart

icon 118
Time (Field Definition com

mand) 64
time fields, formatting. See Field

Format command
Title command (Style menu)

page layout 181
word processing 57

Today 247,271
Tone Dial (Communication

command) 222
tool palette (graphics) 135-152
tool palette (page layout)

184-191
tools. See also specific tool

drawing 135,147-152
editing 135,136-142
paint 135,143-146

Tools command (Options
menu) 133-134

Top/Bottom Margins (Set Guides
command) 166

TopDraw 5
Top Titles (Set Titles com

mand) 111, 113
Transfer menu 204-214

Cancel command 214
Capture Text/End Text Capture
command 212
Receive Batch command 206
Receive Binary II command
207
Receive File command 205



Send Batch command
209-210
Send Binary II command
210--211
Send File command 208
Send Text command 213

Transpose command (Edit
menu) 100

trigonometric functions 243-244
True 249,271
24 Hour Time (Field Format

command) 70

u
unary minus (-) 279
unary plus (+) 279
Underline (Choose Font com-

mand) 29
Underline (Field Format com

mand) 65
Underline command (Format

menu) 101, 107
Underline command (Style menu)

page layout 181
wotd processing 57

Undo command (Edit menu) 19
Ungroup command (Arrange

menu) 130
Unlock Guides

command (Options menu)
167

Unmark Fields command (Otgan
ize menu) 78

Upper 246,271
Uppercase command (Style menu)

page layout 181
word processing 57

Use Master Page command
(Options menu) 169

user dictionary 45

US Legal (Page Setup com
mand) 15, 16

US Letter (Page Setup com
mand) 15,16

v
Val 247,272
Var 244,272
variables, defined 238
Vertical (Grid Size command)

85
vertical line tool 148,189
vertical ruler guides 199
Vertical Sizing (Page Setup

command) 15, 16
View Data command (Options

menu) 109
View Footer command (Docu

ment menu) 48-49
View FormulasNiew Data

command (Options
menu) 109

View Header command (Docu
ment menu) 46--47

VLookup 249,272

w
VVeekday 247, 273
Whole Word (Find command)

73
VVhole VVord(s) (FindfReplace

command) 40
VVindow menu 22

Show Clipboard/Hide Clip
board command 22

word, defined 40
word processing commands

33-59
VVord Processing icon 6

Index

x
Xmodem 204
Xmodem CRC 204
XON/XOFF Handshake (Commu

nication command) 221

Y,Z
Year 248,273
Ymodem 204

299
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